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Safety information
Connect the power cord directly to an appropriately rated and properly grounded electrical outlet that is near the
product and easily accessible.
CAUTION—POTENTIAL INJURY: Do not use this product with extension cords, multioutlet power strips,
multioutlet extenders, or other types of surge or UPS devices. The power rating capacity of these types of
accessories can be easily overloaded by a laser printer and may result in poor printer performance, property
damage, or potential fire.
Do not place or use this product near water or wet locations.
CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning
storm.
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.
Refer service or repairs, other than those described in the user documentation, to a service representative.
This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.
CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.
CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.
This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.
CAUTION—POTENTIAL INJURY: The lithium battery in this product is not intended to be replaced. There is a
danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or incinerate a
lithium battery. Discard used lithium batteries according to the manufacturer's instructions and local
regulations.
Use only the telecommunications (RJ‑11) cord provided with this product or a 26 AWG or larger replacement when
connecting this product to the public switched telephone network.
CAUTION—POTENTIAL INJURY: Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.
CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before proceeding.
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a
multifunction printer (MFP) that scans, copies, and faxes, then you may need additional furniture. For more
information, see www.lexmark.com/multifunctionprinters.
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CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.
• Disconnect all cords and cables from the printer before moving it.
• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the latch on the
right side of the tray toward the front of the tray until it clicks into place.

• Use the handholds located on both sides of the printer to lift it.
• Make sure your fingers are not under the printer when you set it down.
• Before setting up the printer, make sure there is adequate clearance around it.
Use only the power cord provided with this product or the manufacturer's authorized replacement.
SAVE THESE INSTRUCTIONS.
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Learning about the printer
Finding information about the printer
What are you looking for?

Find it here

Initial setup instructions:

Setup documentation—The setup documentation came
with the printer and is also available at
http://support.lexmark.com.

• Connecting the printer
• Installing the printer software
Additional setup and instructions for using the printer:

•
•
•
•
•
•
•
•

Selecting and storing paper and specialty media
Loading paper
Configuring printer settings

User's Guide and Quick Reference Guide—The guides are
available at http://support.lexmark.com.
Note: These guides are also available in other
languages.

Viewing and printing documents and photos
Setting up and using the printer software
Configuring the printer on a network
Caring for and maintaining the printer
Troubleshooting and solving problems

Information on setting up and configuring the accessibility
features of your printer

Lexmark Accessibility Guide—This guide is available at
http://support.lexmark.com.

Help using the printer software

Windows or Mac Help—Open a printer software program
or application, and then click Help.
Click

?

to view context‑sensitive information.

Notes:

• Help is automatically installed with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.
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What are you looking for?

Find it here

The latest supplemental information, updates, and customer
support:

Lexmark support Web site—
http://support.lexmark.com

•
•
•
•
•

Documentation

Note: Select your country or region, and then select
your product to view the appropriate support site.

Driver downloads

Support telephone numbers and hours of operation for
your country or region can be found on the support Web
site or on the printed warranty that came with your
printer.

Live chat support
E‑mail support
Voice support

Record the following information (located on the store
receipt and at the back of the printer), and have it ready
when you contact customer support so that they may
serve you faster:

•
•
•
•
Warranty information

Machine Type number
Serial number
Date purchased
Store where purchased

Warranty information varies by country or region:

• In the U.S.—See the Statement of Limited Warranty
included with this printer, or go to
http://support.lexmark.com.

• In other countries and regions—See the printed
warranty that came with this printer.

Selecting a location for the printer
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.
When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
options, then leave enough room for them also. It is important to:

• Set up the printer near a properly grounded and easily accessible electrical outlet.
• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard or the CEN Technical Committee
156 standard.

• Provide a flat, sturdy, and stable surface.
• Keep the printer:
– Clean, dry, and free of dust.
– Away from stray staples and paper clips.
– Away from the direct airflow of air conditioners, heaters, or ventilators.
– Free from direct sunlight and humidity extremes.
• Observe the recommended temperatures and avoid fluctuations:
Ambient temperature 15.6 to 32.2°C (60 to 90°F)
Storage temperature

‑40 to 60°C (-40 to 140°F)

• Allow the following recommended amount of space around the printer for proper ventilation:
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5

4
1

3

1

Right side 300 mm (12 in.)

2

Front

510 mm (20 in.)

3

Left side

200 mm (8 in.)

4

Rear

200 mm (8 in.)

5

Top

540 mm (21 in.)

1

2

Printer configurations
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a
multifunction printer (MFP) that scans, copies, and faxes, then you may need additional furniture. For more
information, see www.lexmark.com/multifunctionprinters.
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.
You can configure your printer by adding an optional 250‑ or 550‑sheet tray. For instructions on installing the optional
tray, see “Installing optional trays” on page 19.
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5

8

7

6

1

Printer control panel

2

Automatic document feeder (ADF)

3

ADF tray

4

ADF bin

5

Front door release button

6

Standard 250‑sheet tray

7

Optional 250‑ or 550‑sheet tray

8

100‑sheet multipurpose feeder

9

Paper stop

10

Standard bin

Understanding the basic functions of the scanner
•
•
•
•
•

Make quick copies or set the printer to perform specific copy jobs.
Send a fax using the printer control panel.
Send a fax to multiple fax destinations at the same time.
Scan documents and send them to your computer, an e-mail address, or an FTP destination.
Scan documents and send them to another printer (PDF through an FTP).
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Using the ADF and scanner glass
Automatic document feeder (ADF)

Scanner glass

Use the ADF for multiple‑page documents.
Note: The ADF scans only one side of the page.
Use the scanner glass for single‑page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

Using the ADF
•
•
•
•
•

Load the document into the ADF tray faceup, short edge first.
Load up to 50 sheets of plain paper into the ADF tray.
Scan sizes from 105 x 148 mm (4.1 x 5.8 inches) wide to 216 x 368 mm (8.5 x 14.5 inches) long.
Scan media weights from 52 to 120 g/m2 (14–32 lb).
Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings)
into the ADF tray. Place these items on the scanner glass.

Using the scanner glass
When using the scanner glass:

• Place the document facedown on the scanner glass in the corner with the green arrow.
• Scan or copy documents up to 216 x 296.9 mm (8.5 x 11.69 inches).
• Copy books up to 12.7 mm (0.5 inch) thick.

Using the printer control panel
1

13

2

12

3 4 5

11

6 7

10

9

8

Learning about the printer

Use the

13

To

1

Display

2

Arrow buttons

3

Select button

4

Address book button View all the stored addresses.

5

Redial button

View the last number dialed.

6

Keypad

Enter numbers, letters, or symbols.

7

Sleep button

Enable Sleep mode or Hibernate mode.

• View the printer status and messages.
• Set up and operate the printer.
Scroll up and down or left and right.

• Select menu options.
• Save settings.

Do the following to wake the printer from Sleep mode:

•
•
•
•

Press any hard button.
Open a door or cover.
Send a print job from the computer.
Perform a power‑on reset using the main power switch.

8

Cancel button

Cancel all printer activity.

9

Start button

Start a job, depending on which mode is selected.

10

Fax button

Send faxes.

11

Back button

Return to the previous screen.

12

Home button

Go to the home screen.

13

Indicator light

Check the status of the printer.

Understanding the colors of the Sleep button and indicator
lights
The colors of the Sleep button and indicator lights on the control panel signify a printer status or condition.
Indicator light

Printer status

Off

The printer is off or in Hibernate mode.

Blinking green

The printer is warming up, processing data, or printing.

Solid green

The printer is on, but idle.

Blinking red

The printer requires user intervention.

Sleep button light

Printer status

Off

The printer is off, idle, or in Ready state.

Solid amber

The printer is in Sleep mode.

Blinking amber

The printer is entering or waking from Hibernate mode.
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Sleep button light

Printer status

Blinking amber for 0.1 second, then goes
completely off for 1.9 seconds in a slow,
pulsing pattern

The printer is in Hibernate mode.

Additional printer setup

Additional printer setup
Installing internal options
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electircal outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.
Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

Available internal options
Memory cards
• Flash memory
• Fonts

Accessing the controller board
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Open the controller board access door.

15
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2 Open the controller board shield using the green handle.

1

2

3 Use the following illustration to locate the option card connector.
Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any controller board electronic components or
connectors.

4 Close the shield, and then the access door.

1

2

Additional printer setup

Installing an optional card
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.
Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

1 Access the controller board.
For more information, see “Accessing the controller board” on page 15.

2 Unpack the optional card.
Warning—Potential Damage: Avoid touching the connection points along the edge of the card. Doing so may
cause damage.

3 Holding the card by its sides, align the plastic pins (1) on the card with the holes (2) on the controller board.

17
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4 Push the card firmly into place.

Warning—Potential Damage: Improper installation of the card may cause damage to the card and the
controller board.
Note: The entire length of the connector on the card must touch and be flush with the controller board.

Installing hardware options
Order of installation
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a
multifunction printer (MFP) that scans, copies, and faxes, then you may need additional furniture. For more
information, see www.lexmark.com/multifunctionprinters.
Install the printer and any hardware options you have purchased in the following order:

• Printer stand
• Optional 250‑ or 550‑sheet tray
• Printer

Additional printer setup
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For more information on installing a printer stand, optional 250‑ or 550‑sheet tray, or spacer, see the setup sheet that
came with the option.

Installing optional trays
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a
multifunction printer (MFP) that scans, copies, and faxes, then you may need additional furniture. For more
information, see www.lexmark.com/multifunctionprinters.

1 Turn off the printer using the power switch, and then unplug the power cord from the electrical outlet.

1

2

2 Unpack the tray, and then remove all packing material.

Additional printer setup

3 Pull out the tray from the base.

4 Remove any packing material from inside the tray.
5 Insert the tray into the base.
6 Place the tray near the printer.
7 Align the printer with the tray, and then slowly lower the printer into place.
Note: Optional trays lock together when stacked.

20
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8 Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on the printer.

2

1

Notes:

• When the printer software and any hardware options are installed, you may need to manually add the
options in the printer driver to make them available for print jobs. For more information, see “Adding
available options in the print driver” on page 23.

• To uninstall the optional trays, slide the latch on the right side of the printer toward the front of the printer
until it clicks into place, and then remove stacked trays one at a time from the top to the bottom.

Additional printer setup
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Attaching cables
CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning
storm.
Connect the printer to the computer using a USB cable or to the network using an Ethernet cable.
Make sure to match the following:

• The USB symbol on the cable with the USB symbol on the printer
• The appropriate Ethernet cable with the Ethernet port
Warning—Potential Damage: Do not touch the USB cable, any network adapter, or the printer in the area shown
while actively printing or scanning. Loss of data or a malfunction can occur.

Use the

To

1

Printer power cord
socket

Connect the printer to a properly grounded electrical outlet.

2

Power switch

Turn the printer on or off.

3

Ethernet port

Connect the printer to an Ethernet network.

4

EXT port

Connect additional devices (telephone or answering machine) to the printer and the
telephone line. Use this port if you do not have a dedicated fax line for the printer and if this
connection method is supported in your country or region.
Note: Remove the adapter plug to access the port.
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Use the

To

5

LINE port

Connect the printer to an active telephone line through a standard wall jack (RJ‑11), DSL filter,
or VoIP adapter, or any other adapter that allows you to access the telephone line to send
and receive faxes.

6

USB printer port

Connect the printer to a computer.

7

Security slot

Attach a lock that will secure the printer in place.

Setting up the printer software
Installing the printer
1 Obtain a copy of the software installer package.
2 Run the installer, and then follow the instructions on the computer screen.
3 For Macintosh users, add the printer.
Note: Obtain the printer IP address from the TCP/IP section in the Network/Ports menu.

Adding available options in the print driver
For Windows users
1 Open the printers folder.
In Windows 8
From the Search charm, type run, and then navigate to:
Run > type control printers > OK
In Windows 7 or earlier

a Click
, or click Start and then click Run.
b Type control printers.
c Press Enter, or click OK.
2 Select the printer you want to update, and then do either of the following:
• For Windows 7 or later, select Printer properties.
• For earlier versions, select Properties.
3 Navigate to the Configuration tab, and then select Update Now ‑ Ask Printer.
4 Apply the changes.

For Macintosh users
1 From System Preferences in the Apple menu, navigate to your printer, and then select Options & Supplies.
2 Navigate to the list of hardware options, and then add any installed options.
3 Apply the changes.

Additional printer setup
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Networking
Notes:

• Purchase a MarkNetTM N8352 wireless network adapter first before setting up the printer on a wireless network.
For information on installing the wireless network adapter, see the setup sheet that came with the adapter.

• A Service Set Identifier (SSID) is a name assigned to a wireless network. Wired Equivalent Privacy (WEP), Wi-Fi
Protected Access (WPA), and WPA2 are types of security used on a network.

Preparing to set up the printer on an Ethernet network
To configure your printer to connect to an Ethernet network, organize the following information before you begin:
Note: If your network automatically assigns IP addresses to computers and printers, continue on to installing the
printer.

•
•
•
•

A valid, unique IP address for the printer to use on the network
The network gateway
The network mask
A nickname for the printer (optional)
Note: A printer nickname can make it easier for you to identify your printer on the network. You can choose to
use the default printer nickname, or assign a name that is easier for you to remember.

You will need an Ethernet cable to connect the printer to the network and an available port where the printer can
physically connect to the network. Use a new network cable when possible to avoid potential problems caused by a
damaged cable.

Preparing to set up the printer on a wireless network
Notes:

• Make sure your wireless network adapter is installed in your printer and working properly. For more
information, see the instruction sheet that came with the wireless network adapter.

• Make sure your access point (wireless router) is turned on and is working properly.
Make sure you have the following information before setting up the printer on a wireless network:

• SSID—The SSID is also referred to as the network name.
• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.
• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.
Some ad hoc networks will also require the automatic setting. Check with your system support person if you are
not sure which channel to select.

Additional printer setup
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• Security Method—There are four basic options for Security Method:
– WEP key
If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the key
currently in use on the network by selecting the default WEP transmit key.

– WPA or WPA2 preshared key or passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

– 802.1X–RADIUS
If you are installing the printer on an 802.1X network, then you may need the following:

•
•
•
•

Authentication type
Inner authentication type
802.1X user name and password
Certificates

– No security
If your wireless network does not use any type of security, then you will not have any security information.
Note: We do not recommend using an unsecured wireless network.
Notes:

– If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter, and then look for the network name. If you cannot find the SSID or the
security information for your network, then see the documentation that came with the access point, or contact
your system support person.

– To find the WPA/WPA2 preshared key or passphrase for the wireless network, see the documentation that
came with the access point, see the Embedded Web Server associated with the access point, or consult your
system support person.

Connecting the printer using the Wireless Setup Wizard
Before you begin, make sure that:

• A wireless network adapter is installed in the printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

• An Ethernet cable is disconnected from the printer.
• Active NIC is set to Auto. To set this to Auto, navigate to:
> Settings >

> Network/Ports >

> Active NIC >

> Auto >

Note: Make sure to turn off the printer, then wait for at least five seconds, and then turn the printer back on.

1 From the printer control panel, navigate to:
> Settings >

> Network/Ports >

Wireless Connection Setup >

2 Select a wireless connection setup.

> Network [x] >

> Network [x] Setup >

> Wireless >

>

Additional printer setup
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Use

To

Search for networks

Show available wireless connections.
Note: This menu item shows all broadcast secured or unsecured SSIDs.

Enter a network name Manually type the SSID.
Note: Make sure to type the correct SSID.
Wi‑Fi Protected Setup Connect the printer to a wireless network using Wi‑Fi Protected Setup.

3 Press

, and then follow the instructions on the printer display.

Connecting the printer to a wireless network using Wi-Fi Protected Setup
Before you begin, make sure that:

• The access point (wireless router) is Wi‑Fi Protected Setup (WPS) certified or WPS‑compatible. For more
information, see the documentation that came with your access point.

• A wireless network adapter is installed in the printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

Using the Push Button Configuration (PBC) method
1 From the printer control panel, navigate to:
> Settings >

>Network/Ports >

Wireless Connection Setup >

> Network [x] >

> Wi‑Fi Protected Setup >

> Network [x] Setup >

> Wireless >

>

> Start Push Button Method >

2 Follow the instructions on the printer display.
Using the Personal Identification Number (PIN) method
1 From the printer control panel, navigate to:
> Settings >

>Network/Ports >

Wireless Connection Setup >

> Network [x] >

> Wi‑Fi Protected Setup >

> Network [x] Setup >

> Wireless >

> Start PIN Method >

2 Copy the eight‑digit WPS PIN.
3 Open a Web browser, and then type the IP address of your access point in the address bar.
Notes:

• The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.
• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
4 Access the WPS settings. For more information, see the documentation that came with your access point.
5 Enter the eight‑digit PIN, and then save the setting.

>
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Connecting the printer to a wireless network using the Embedded Web Server
Before you begin, make sure that:

• Your printer is connected temporarily to an Ethernet network.
• A wireless network adapter is installed in your printer and working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Network/Ports > Wireless.
3 Modify the settings to match the settings of your access point (wireless router).
Note: Make sure to enter the correct SSID, security method, preshared key or passphrase, network mode, and
channel.

4 Click Submit.
5 Turn off the printer, and then disconnect the Ethernet cable. Then wait for at least five seconds, and then turn the
printer back on.

6 To verify if your printer is connected to the network, print a network setup page. Then in the Network Card [x]
section, see if the status is Connected.

Verifying printer setup
Printing a menu settings page
Print a menu settings page to review the current menu settings and to verify if the printer options are installed correctly.
Note: If you have not changed any menu settings, then the menu settings page lists all the factory default settings.
When you select and save other settings from the menus, they replace the factory default settings as user default
settings. A user default setting remains in effect until you access the menu again, choose another value, and save it.
From the printer control panel, navigate to:
> Settings >

>Reports >

> Menu Settings Page >
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Printing a network setup page
If the printer is attached to a network, then print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 From the printer control panel, navigate to:
> Settings >

> Reports >

> Network Setup Page >

2 Check the first section of the network setup page, and then confirm that the status is Connected.
If the status is Not Connected, then the LAN drop may not be active, or the network cable may be malfunctioning.
Consult your system support person for a solution, and then print another network setup page.
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Loading paper and specialty media
The selection and handling of paper and specialty media can affect how reliably documents print. For more information,
see “Avoiding jams” on page 165 and “Storing paper” on page 46.

Setting the paper size and type
1 From the printer control panel, navigate to:
> Settings >

> Paper Menu >

> Paper Size/Type >

2 Press the up or down arrow button to select the tray or feeder size, and then press
3 Press the up or down arrow button to select the paper size, and then press

.

.

4 Press the up or down arrow button to select the tray or feeder type, and then press
5 Press the up or down arrow button to select the paper type, and then press

.

.

Configuring Universal paper settings
The Universal paper size is a user‑defined setting that lets you print on paper sizes that are not preset in the printer
menus.
Notes:

• The smallest supported Universal paper size is 76.2 x 76.2 mm (3 x 3 inches), and is supported only from the
multipurpose feeder.

• The largest supported Universal paper size is 215.9 x 359.92 mm (8.5 x 14.17 inches), and is supported from all
paper sources.

1 From the printer control panel, navigate to:
> Settings >

> Paper Menu >

> Universal Setup >

> Units of Measure >

> select a unit of

measure >

2 Select Portrait Width or Portrait Height, and then press

.

3 Press the left or right arrow button to change the setting, and then press

.

Loading trays
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

1 Pull out the tray completely.
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Note: Do not remove trays while a job prints or while Busy appears on the printer display. Doing so may cause
a jam.

2 Squeeze and then slide the width guide tab to the correct position for the size of the paper you are loading.

1

2
A5

A4

EXEC

B5

LTR
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3 Squeeze and then slide the length guide tab to the correct position for the size of the paper you are loading.

1

A4

LTR
EX

EC

B5

2

A5

Notes:

• For some paper sizes like letter, legal, and A4, squeeze and slide the length guide tab backward to
accommodate their length.

• When loading legal‑size paper, the length guide extends beyond the base leaving the paper exposed to dust.
To protect the paper from dust, you can purchase a dust cover separately. For more information, contact
customer support.

• If you are loading A6-size paper in the standard tray, then squeeze and then slide the length guide tab
toward the center of the tray to the A6‑size position.

• Make sure the width and length guides are aligned with the paper size indicators on the bottom of the tray.
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A4

EXE

LTR
C

B5

A5

4 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.

5 Load the paper stack.

Notes:

• Load with the printable side facedown when using recycled or preprinted paper.
• Load prepunched paper with the holes on the top edge toward the front of the tray.
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• Load letterhead facedown, with the top edge of the sheet toward the front of the tray. For two‑sided
printing, load letterhead faceup with the bottom edge of the sheet toward the front of the tray.

• Make sure the paper is below the maximum paper fill indicator located on the side of the width guide.

6 Insert the tray.

7 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper loaded in
the tray.
Note: Set the correct paper size and type to avoid paper jams and print quality problems.
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Loading the multipurpose feeder
Use the multipurpose feeder when printing on different paper sizes and types or specialty media, such as card stock,
transparencies, paper labels, and envelopes. You can also use it for single‑page print jobs on letterhead.

1 Open the multipurpose feeder.

a Pull the multipurpose feeder extender.
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b Pull the extender gently so that the multipurpose feeder is fully extended and open.

2 Squeeze the tab on the left width guide, and then move the guides for the paper you are loading.

1

2

3 Prepare the paper or specialty media for loading.
• Flex sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

• Hold transparencies by the edges. Flex the stack of transparencies back and forth to loosen them, and then fan
them. Straighten the edges on a level surface.
Note: Avoid touching the printable side of the transparencies. Be careful not to scratch them.
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• Flex the stack of envelopes back and forth to loosen them, and then fan them. Straighten the edges on a level
surface.

4 Load the paper or specialty media.
Notes:

• Do not force paper or specialty media into the multipurpose feeder.
• Make sure the paper or specialty media is below the maximum paper fill indicator located on the paper
guides. Overfilling may cause paper jams.

• Load paper, transparencies, and card stock with the recommended printable side faceup and the top edge
entering the printer first. For more information on loading transparencies, see the packaging that the
transparencies came in.

Loading paper and specialty media

Note: When loading A6‑size paper, make sure the multipurpose feeder extender rests lightly against the
edge of the paper so that the last few sheets of paper remain in place.

• Load letterhead faceup with the top edge entering the printer first. For two‑sided (duplex) printing, load
letterhead facedown with the bottom edge entering the printer first.

37
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• Load envelopes with the flap on the left side facedown.

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated linings, or
self‑stick adhesives. These envelopes may severely damage the printer.

5 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper or specialty
media loaded in the multipurpose feeder.

Linking and unlinking trays
The printer links trays when the specified paper size and type are the same. When a linked tray becomes empty, paper
feeds from the next linked tray. To prevent trays from linking, assign a unique custom paper type name.

Linking and unlinking trays
Note: This feature applies only in network printers.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Paper Menu.
3 Change the tray settings to specify the paper size and type for the tray.
• To link trays, make sure the paper size and type for the tray match with that of the other tray.
• To unlink trays, make sure the paper size or type for the tray does not match with that of the other tray.
4 Click Submit.
Warning—Potential Damage: Paper loaded in the tray should match the paper type name assigned in the printer.
The temperature of the fuser varies according to the specified paper type. Printing issues may occur if settings are
not properly configured.
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Creating a custom name for a paper type
Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Paper Menu > Custom Names.
3 Select a custom name, and then type a new custom paper type name.
4 Click Submit.
5 Click Custom Types, and then verify if the new custom paper type name has replaced the custom name.
Using the printer control panel
1 From the printer control panel, navigate to:
> Settings >

> Paper Menu >

> Custom Names

2 Select a custom name, and then type a new custom paper type name.
3 Press

.

4 Press Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Assigning a custom paper type
Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Paper Menu > Custom Types.
3 Select a custom paper type name, and then select a paper type.
Note: Paper is the factory default paper type for all user‑defined custom names.

4 Click Submit.
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Using the printer control panel
1 From the printer control panel, navigate to:
> Settings >

> Paper Menu >

> Custom Types

2 Select a custom paper type name, and then select a paper type.
Note: Paper is the factory default paper type for all user‑defined custom names.

3 Press

.
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Paper and specialty media guide
Notes:

•
•
•
•

Make sure that the paper size, type, and weight are set correctly on the computer or control panel.
Flex, fan, and straighten specialty media before loading them.
The printer may print at a reduced speed to prevent damage to the fuser.
For more information on card stock and labels, see the Card Stock & Label Guide on the Lexmark support Web
site at http://support.lexmark.com.

Using specialty media
Tips on using letterhead
•
•
•
•

Use letterhead designed specifically for laser printers.
Print samples on the letterhead being considered for use before buying large quantities.
Before loading letterhead, flex, fan, and straighten the stack to prevent sheets from sticking together.
Page orientation is important when printing on letterhead. For information on how to load letterhead, see:

– “Loading trays” on page 29
– “Loading the multipurpose feeder” on page 34

Tips on using transparencies
• Print a test page on the transparencies being considered for use before buying large quantities.
• Feed transparencies from the standard tray, or the multipurpose feeder.
• Use transparencies designed specifically for laser printers. Transparencies must be able to withstand temperatures
up to 185°C (365°F) without melting, discoloring, offsetting, or releasing hazardous emissions.
Note: If the transparency weight is set to Heavy and the transparency texture is set to Rough in the Paper menu,
then transparencies can be printed at a temperature up to 195°C (383°F).

• Avoid getting fingerprints on the transparencies to prevent print quality problems.
• Before loading transparencies, flex, fan, and straighten the stack to prevent sheets from sticking together.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure that the
envelopes can withstand temperatures up to 230°C (446°F) without sealing, wrinkling, curling excessively, or
releasing hazardous emissions.

• For best performance, use envelopes made from 90‑g/m2 (24‑lb bond) paper or 25% cotton. All‑cotton envelopes
must not exceed 75‑g/m2 (20‑lb bond) weight.

• Use only new envelopes from undamaged packages.
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• To optimize performance and minimize jams, do not use envelopes that:
– Have excessive curl or twist
– Are stuck together or damaged in any way
– Have windows, holes, perforations, cutouts, or embossing
– Have metal clasps, string ties, or folding bars
– Have an interlocking design
– Have postage stamps attached
– Have any exposed adhesive when the flap is in the sealed or closed position
– Have bent corners
– Have rough, cockle, or laid finishes
• Adjust the width guides to fit the width of the envelopes.
Note: A combination of high humidity (over 60%) and high printing temperature may wrinkle or seal envelopes.

Tips on using labels
Print samples on the labels being considered for use before buying large quantities.
Note: Use only paper label sheets. Vinyl, pharmacy, and two‑sided labels are not supported.
For more information on label printing, characteristics, and design, see the Card Stock & Label Guide available at
http://support.lexmark.com.
When printing on labels:

• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:
– The labels can withstand temperatures up to 240°C (464°F) without sealing, excessive curling, wrinkling, or
releasing hazardous emissions.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 172‑kPa (25‑psi) pressure without
delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.
• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and toner cartridge
warranties.

• Do not use labels with exposed adhesive.
• Do not print within 1 mm (0.04 inch) of the edge of the label, of the perforations, or between die‑cuts of the label.
• Make sure the adhesive backing does not reach to the edge of the sheet. Zone coating of the adhesive should be
at least 1 mm (0.04 inch) away from edges. Adhesive material contaminates the printer and could void the warranty.

• If zone coating of the adhesive is not possible, then remove a 2‑mm (0.08‑inch) strip on the leading and driver edge,
and then use a non‑oozing adhesive.

• Portrait orientation is recommended, especially when printing bar codes.
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Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly affect print quality.

• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the card
stock loaded in the tray.

• Print samples on the card stock being considered for use before buying large quantities.
• Specify the paper texture and weight from the tray settings to match the paper loaded in the tray.
• Preprinting, perforation, and creasing may significantly affect the print quality and cause jams or other paper feed
problems.

• Before loading the card stock on the tray, flex and fan the card stock to loosen them. Straighten the edges on a
level surface.

Paper guidelines
Selecting the correct paper or specialty media reduces printing problems. For the best print quality, try a sample of the
paper or specialty media before buying large quantities.

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.

Weight
The printer trays can automatically feed paper weights up to 120‑g/m2 (32‑lb) bond grain long paper. The multipurpose
feeder can automatically feed paper weights up to 163‑g/m2 (43‑lb) bond grain long paper. Paper lighter than
60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 75‑g/m2 (20‑lb)
bond grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 inches), we recommended to use 90 g/m2
(24 lb) or heavier paper.
Note: Two‑sided printing is supported only for 60–90‑g/m2 (16–24‑lb) bond paper.

Curl
Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness
Paper smoothness directly affects print quality. If paper is too rough, then toner cannot fuse to it properly. If paper is
too smooth, then it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield
points; however, smoothness between 150 and 250 Sheffield points produces the best print quality.
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Moisture content
The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.
Store paper in its original wrapper in the same environment as the printer for 24 to 48 hours before printing. Extend
the time to several days if the storage or transportation environment is very different from the printer environment.
Thick paper may also require a longer conditioning period.

Grain direction
Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.
For 60–90‑g/m2 (16–24‑lb) bond paper, grain long paper is recommended.

Fiber content
Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton can negatively affect paper handling.

Selecting paper
Using the appropriate paper prevents jams and helps ensure trouble‑free printing.
To help avoid paper jams and poor print quality:

• Always use new, undamaged paper.
• Before loading paper, know the recommended printable side of the paper. This information is usually indicated on
the paper package.

• Do not use paper that has been cut or trimmed by hand.
• Do not mix paper sizes, types, or weights in the same tray; mixing results in jams.
• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60 to 90 g/m2 (16 to 24 lb) weight paper.
• Use only forms and letterhead printed using an offset lithographic or engraved printing process.
• Avoid papers with rough or heavily textured surfaces.
Use papers printed with heat‑resistant inks designed for use in xerographic copiers. The ink must be able to withstand
temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that are not affected by
the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these requirements; latex inks might not.
When in doubt, contact the paper supplier.
Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without melting or
releasing hazardous emissions.
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Using recycled paper and other office papers
As an environmentally conscientious company, Lexmark supports the use of recycled paper produced specifically for
use in laser (electrophotographic) printers.
While no blanket statement can be made that all recycled paper will feed well, Lexmark consistently tests papers that
represent recycled cut size copier papers available on the global market. This scientific testing is conducted with rigor
and discipline. Many factors are taken into consideration both separately and as a whole, including the following:

•
•
•
•
•
•
•
•

Amount of post-consumer waste (Lexmark tests up to 100% post-consumer waste content.)
Temperature and humidity conditions (Testing chambers simulate climates from all over the world.)
Moisture content (Business papers should have low moisture: 4–5%.)
Bending resistance and proper stiffness means optimum feeding through the printer.
Thickness (impacts how much can be loaded into a tray)
Surface roughness (measured in Sheffield units, impacts print clarity and how well toner fuses to the paper)
Surface friction (determines how easily sheets can be separated)
Grain and formation (impacts curling, which also influences the mechanics of how the paper behaves as it moves
through the printer)

• Brightness and texture (look and feel)
Recycled papers are better than ever; however, the amount of recycled content in a paper affects the degree of control
over foreign matter. And while recycled papers are one good path to printing in an environmentally responsible manner,
they are not perfect. The energy required to de-ink and deal with additives such as colorants and “glue” often generates
more carbon emissions than does normal paper production. However, using recycled papers enables better resource
management overall.
Lexmark concerns itself with the responsible use of paper in general based on life cycle assessments of its products. To
gain a better understanding of the impact of printers on the environment, the company commissioned a number of
life cycle assessments and found that paper was identified as the primary contributor (up to 80%) of carbon emissions
caused throughout the entire life of a device (from design to end-of-life). This is due to the energy-intensive
manufacturing processes required to make paper.
Thus, Lexmark seeks to educate customers and partners on minimizing the impact of paper. Using recycled paper is
one way. Eliminating excessive and unnecessary paper consumption is another. Lexmark is well-equipped to help
customers minimize printing and copying waste. In addition, the company encourages purchasing paper from suppliers
who demonstrate their commitment to sustainable forestry practices.
Lexmark does not endorse specific suppliers, although a converter’s product list for special applications is maintained.
However, the following paper choice guidelines will help alleviate the environmental impact of printing:

1 Minimize paper consumption.
2 Be selective about the origin of wood fiber. Buy from suppliers who carry certifications such as the Forestry
Stewardship Council (FSC) or the Program for the Endorsement of Forest Certification (PEFC). These certifications
guarantee that the paper manufacturer uses wood pulp from forestry operators that employ environmentally and
socially responsible forest management and restoration practices.

3 Choose the most appropriate paper for printing needs: normal 75 or 80 g/m2 certified paper, lower weight paper,
or recycled paper.
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Unacceptable paper examples
Test results indicate that the following paper types are at risk for use with laser printers:

•
•
•
•

Chemically treated papers used to make copies without carbon paper, also known as carbonless papers

•
•
•
•
•

Coated papers (erasable bond), synthetic papers, thermal papers

Preprinted papers with chemicals that may contaminate the printer
Preprinted papers that can be affected by the temperature in the printer fuser
Preprinted papers that require a registration (the precise location on the page) greater than ± 2.3 mm (± 0.9 in.),
such as optical character recognition (OCR) forms. In some cases, registration can be adjusted with a software
application to successfully print on these forms.)
Rough-edged, rough or heavily textured surface papers or curled papers
Recycled papers that fail EN12281:2002 (European testing)
Paper weighing less than 60 g/m2 (16 lb)
Multiple part forms or documents

For more information about Lexmark, visit www.lexmark.com. General sustainability-related information can be found
at the Environmental Sustainability link.

Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40 percent. Most
label manufacturers recommend printing in a temperature range of 18–24°C (65–75°F) with relative humidity
between 40 and 60 percent.

•
•
•
•

Store paper in cartons, on a pallet or shelf, rather than on the floor.
Store individual packages on a flat surface.
Do not store anything on top of individual paper packages.
Take paper out of the carton or wrapper only when you are ready to load it in the printer. The carton and wrapper
help keep the paper clean, dry, and flat.
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Supported paper sizes, types, and weights
The following tables provide information on standard and optional paper sources and the sizes, types, and weights of
paper they support.
Note: For an unlisted paper size, select the closest larger listed size.

Supported paper sizes
Paper size and dimension Standard
250‑sheet tray

Optional 250‑ or Multipurpose
550‑sheet tray
feeder

Business card

X

X

3 x 5 in.

X

X

4 x 6 in.

X

X

ADF

Scanner
glass

Duplex
printing

X

X

1

X

X

1

X

X

X

A4
210 x 297 mm
(8.27 x 11.7 in.)
A5

X

148 x 210 mm
(5.83 x 8.27 in.)
A6

X

X

105 x 148 mm
(4.13 x 5.83 in.)
X

JIS B5
182 x 257 mm
(7.17 x 10.1 in.)
Letter
215.9 x 279.4 mm
(8.5 x 11 in.)
Legal

X

215.9 x 355.6 mm
(8.5 x 14 in.)
Executive

X

184.2 x 266.7 mm
(7.25 x 10.5 in.)
Oficio (México)
215.9 x 340.4 mm
(8.5 x 13.4 in.)
1

X

Paper is supported only if the paper size setting is set to Universal.

2

Paper is supported in two‑sided (duplex) printing only if the width is at least 210 mm (8.27 in.) and the length is at least
279.4 mm (11 in.). The smallest supported Universal paper size is supported only in the multipurpose feeder.
3

Paper is supported only if the width is at least 215.9 mm (8.5 in.) and the length is at least 296.9 mm (11.7 in.).

4

Paper is supported only if the length is at least 296.9 mm (11.7 in.).
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Paper size and dimension Standard
250‑sheet tray

Optional 250‑ or Multipurpose
550‑sheet tray
feeder

ADF

Folio

Scanner
glass

Duplex
printing

X

215.9 x 330.2 mm
(8.5 x 13 in.)
Statement
139.7 x 215.9 mm
(5.5 x 8.5 in.)

X

Universal2

3

76.2 x 127 mm (3 x 5 in.) to
215.9 x 359.92 mm
(8.5 x 14.17 in.)
7 3/4 Envelope (Monarch)

X

X

X

X

X

X

X

X

X

X

X

X

DL Envelope
110 x 220 mm
(4.33 x 8.66 in.)

X

X

X

X

C5 Envelope

X

X

X

X

X

X

X

X

X

X

X

98.4 x 190.5 mm
(3.875 x 7.5 in.)
9 Envelope
98.4 x 226.1 mm
(3.875 x 8.9 in.)
10 Envelope
104.8 x 241.3 mm
(4.12 x 9.5 in.)

162 x 229 mm
(6.38 x 9.01 in.)
B5 Envelope
176 x 250 mm
(6.93 x 9.84 in.)
Other Envelope

4

X

85.7 x 165 mm to
215.9 x 355.6 mm
(3.375 x 6.50 in. to
8.5 x 14 in.)
1

Paper is supported only if the paper size setting is set to Universal.

2

Paper is supported in two‑sided (duplex) printing only if the width is at least 210 mm (8.27 in.) and the length is at least
279.4 mm (11 in.). The smallest supported Universal paper size is supported only in the multipurpose feeder.
3

Paper is supported only if the width is at least 215.9 mm (8.5 in.) and the length is at least 296.9 mm (11.7 in.).

4

Paper is supported only if the length is at least 296.9 mm (11.7 in.).
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Supported paper types and weights
The standard tray supports 60–90‑g/m2 (16–24‑lb) paper weights. The optional tray supports 60–120‑g/m2 (16–32‑lb)
paper weights. The multipurpose feeder supports 60–163‑g/m2 (16–43‑lb) paper weights.
Paper type

250‑ or
550‑sheet tray

Multipurpose feeder

Duplex mode

ADF

Scanner glass

Plain paper
Card stock

X

Transparencies

X
X

Recycled
X

Paper labels1
Bond
Envelope2

X

X

X

Rough envelope

X

X

X

Letterhead
Preprinted
Colored paper
Light paper
Heavy paper
Rough/Cotton

X

Custom Type [x]
1

One‑sided paper labels designed for laser printers are supported for occasional use. We recommend printing only up to
20 pages of paper labels per month. Vinyl, pharmacy, and two‑sided labels are not supported.

2

Use envelopes that lie flat when individually placed on a table facedown.
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Printing
Printing a document
Printing a document
1 From the Paper menu on the printer control panel, set the paper type and size to match the paper loaded.
2 Send the print job:
For Windows users
a With a document open, click File > Print.
b Click Properties, Preferences, Options, or Setup.
c Adjust the settings, if necessary.
d Click OK > Print.
For Macintosh users
a Customize the settings in the Page Setup dialog if necessary:
1 With a document open, choose File > Page Setup.
2 Choose a paper size or create a custom size to match the paper loaded.
3 Click OK.
b Customize the settings in the Page Setup dialog if necessary:
1 With a document open, choose File > Print.
If necessary, click the disclosure triangle to see more options.
2 From the Print dialog and pop‑up menus adjust the settings if necessary.
Note: To print on a specific paper type, adjust the paper type setting to match the paper loaded, or
select the appropriate tray or feeder.
3 Click Print.

Adjusting toner darkness
Using the Embedded Web Server
1 Open a Web browser, and then type the IP address of the printer in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Print Settings > Quality Menu > Toner Darkness.
3 Adjust the toner darkness, and then click Submit.
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Using the printer control panel
1 From the printer control panel, navigate to:
> Settings >

> Settings >

> Print Settings >

2 Adjust the toner darkness, and then press

> Quality Menu >

> Toner Darkness

.

Printing from a mobile device
To download a compatible mobile printing application, visit www.lexmark.com/mobile.
Note: Mobile printing applications may also be available from your mobile device manufacturer.

Printing confidential and other held jobs
Storing print jobs in the printer
1 From the printer control panel, navigate to:
> Settings >

> Security >

> Confidential Print > select the print job type

Print job type

Description

Max Invalid PIN

Limits the number of times an invalid PIN can be entered.
Note: When the limit is reached, the print jobs for that user name and PIN are
deleted.

Confidential Job Expiration

Lets you hold print jobs in the computer until you enter the PIN from the printer
control panel.
Note: The PIN is set from the computer. It must be four digits, using the
numbers 0–9.

Repeat Job Expiration

Lets you print and store print jobs in the printer memory for reprinting.

Verify Job Expiration

Lets you print one copy of a print job while the printer holds the remaining
copies. It allows you to examine if the first copy is satisfactory. The print job is
automatically deleted from the printer memory once all copies are printed.

Reserve Job Expiration

Lets you store print jobs for printing at a later time. The print jobs are held until
deleted from the Held Jobs menu.

Notes:

• Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.

• You can set the printer to store print jobs in the printer memory until you start the print job from the printer
control panel.

• All print jobs that can be initiated by the user at the printer are called held jobs.

2 Press

.
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Printing confidential and other held jobs
Note: Confidential and Verify print jobs are automatically deleted from memory after printing. Repeat and Reserve
jobs are held in the printer until you choose to delete them.

For Windows users
1 With a document open, click File > Print.
2 Click Properties, Preferences, Options, or Setup.
3 Click Print and Hold.
4 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

5 Click OK or Print.
6 From the printer control panel, release the print job.
• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > select the print job > specify the number
of copies > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print

For Macintosh users
1 With a document open, choose File > Print.
If necessary, click the disclosure triangle to see more options.

2 From the print options or Copies & Pages pop‑up menu, choose Job Routing.
3 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

4 Click OK or Print.
5 From the printer control panel, release the print job:
• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > select the print job > specify the number
of copies > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print

Modifying confidential print settings
Note: This feature is available only in network printers or printers connected to print servers.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
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• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings tab > Security > Confidential Print Setup.
3 Modify the settings:
• Set a maximum number of PIN entry attempts. When a user exceeds a specific number of PIN entry attempts,
all of the jobs for that user are deleted.

• Set an expiration time for confidential print jobs. When a user has not printed the jobs within the specified time,
all of the jobs for that user are deleted.

4 Save the modified settings.

Printing information pages
Printing a font sample list
1 From the printer control panel, navigate to:
> Settings >

> Reports >

> Print Fonts

2 Press the up or down arrow button to select the font setting.
3 Press

.

Note: The PPDS fonts appear only when the PPDS data stream is activated.

Canceling a print job
Canceling a print job from the printer control panel
1 From the printer control panel, press

.

2 When a list of print jobs appears, select the job to cancel, and then press
3 Press

.

to go back to the home screen.

Canceling a print job from the computer
For Windows users
1 Open the printers folder, and then select your printer.
2 From the print queue, select the print job you want to cancel, and then delete it.

Printing

For Macintosh users
1 From System Preferences in the Apple menu, navigate to your printer.
2 From the print queue, select the print job you want to cancel, and then delete it.
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Copying
Automatic document feeder (ADF)

Scanner glass

Use the ADF for multiple‑page documents.
Note: The ADF scans only one side of the sheet.
Use the scanner glass for single-page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

Making copies
Making a quick copy
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
Note: To avoid a cropped image, make sure the size of the original document and the size of the copy paper are
the same.

3 From the printer control panel, press

.

Copying using the ADF
1 Load an original document faceup, short edge first into the ADF tray.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.
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• The ADF indicator light comes on when the paper is loaded properly.
2 Adjust the paper guides.
3 From the printer control panel, use the keypad to enter the number of copies, and then press

.

Copying using the scanner glass
1 Place an original document facedown on the scanner glass in the upper left corner.
2 From the printer control panel, use the keypad to enter the number of copies, and then press

.

Note: If you want to scan another document, then place the next document on the scanner glass, press the left
or right arrow button to scroll to Scan the Next Page, and then press

.

3 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Copying photos
1 Place a photo facedown on the scanner glass in the upper left corner.
2 From the printer control panel, navigate to:
> Copy >

> Content Type > Photo

3 From the Content Source menu, choose a setting that best describes the original photo your are copying, and then
press

.

Note: If you want to copy another photo, then place it on the scanner glass, press the left or right arrow button
to scroll to Scan the Next Page, and then press

.

4 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Copying on specialty media
Copying on transparencies
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
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3 From the printer control panel, navigate to:
> Copy >

> Copy from > select the size of the original document

4 Navigate to:
Copy to >

> select the tray containing the transparencies >

> select the number of copies or enter a

number on the keypad >

5 If there are no trays that contain transparencies, then do the following:
a Navigate to:
Copy to >

> Manual Feeder >

> select the size of the transparencies >

b Load transparencies into the multipurpose feeder, and then press

> Transparency >

.

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
.

button to scroll to Scan the Next Page, and then press

6 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Copying on letterhead
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Copy from > select the size of the original document

4 Navigate to:
Copy to >

> select the tray containing the letterhead >

> select the number of copies or enter a number

on the keypad >

5 If there are no trays that contain letterhead, then do the following:
a Navigate to:
Copy to >

> Manual Feeder >

> select the size of the letterhead > Letterhead

b Place the letterhead faceup, top edge first into the multipurpose feeder, and then press

.
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Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

6 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Customizing copy settings
Copying to a different size
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Copy from > select the size of the original document

4 Navigate to:
Copy to >

> select a new size for the copy > select the number of copies or enter a number on the keypad >

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

5 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Making copies using paper from a selected tray
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Copy from > select the size of the original document
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4 Navigate to:
Copy to >

> select the tray containing the paper size and type you want to use >

> select the number of

copies or enter a number on the keypad >

5 If there are no trays that contain the paper size and type you want to use, then do the following:
a Navigate to:
Copy to >

> Manual Feeder >

> select the paper size >

> select the paper type >

b Load the size and type of paper into the multipurpose feeder, and then press

.

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow button
to scroll to Scan the Next Page, and then press

.

6 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Reducing or enlarging copies
Copies can be scaled from 25% to 400% of the original document size.

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Scale > adjust the scale setting > select the number of copies or enter a number on the keypad >

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

4 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Making a copy lighter or darker
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass in the upper
left corner.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.
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• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Darkness > adjust the darkness setting > select the number of copies or enter a number on

the keypad >
Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

4 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Adjusting copy quality
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Content Type > select the content type of the original document

4 Press the left or right arrow button to scroll to one of the following:
• Text—The content of the original document is mostly text or line art.
• Text/Photo—The original document is a mixture of text and graphics or photos.
• Photo—The original document is mostly a photo or an image.
• Graphics—The original document is mostly business‑type graphics, such as pie charts, bar charts, and
animations.

5 Press the up or down arrow button until Content Source appears, and then press the left or right arrow button
to scroll to one of the following:

•
•
•
•
•
•
•
•

Color Laser—The original document was printed using a color laser printer.
Inkjet—The original document was printed using an inkjet printer.
Magazine—The original document is from a magazine.
Press—The original document is from an offset press.
Black/White Laser—The original document was printed using a mono laser printer.
Photo/Film—The original document is a photo from a film.
Newspaper—The original document is from a newspaper.
Other—The original document was printed using an alternate or unknown printer.
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6 Select the number of copies or enter a number on the keypad, and then press

.

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

7 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Collating copies
If you print multiple copies of a document, then you can choose to print each copy as a set (collated) or to print the
copies as groups of pages (not collated).
Collated

Not collated

To select a Collate setting:

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Collate > select the collate setting you want > select the number of copies or enter a number

on the keypad >
Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

4 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Placing separator sheets between copies
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
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3 From the printer control panel, navigate to:
> Copy >

> Separator Sheets

4 Select Between Copies, Between Jobs, Between Pages, or Off.
5 Select the number of copies or enter a number on the keypad, and then press

.

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

6 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Copying multiple pages onto a single sheet
To save paper, you can copy either two or four consecutive pages of a multiple‑page document onto a single sheet of
paper.
Notes:

• Make sure the paper size is set to letter, legal, A4, or JIS B5.
• The copy size must be set to 100%.
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Paper Saver > select the setting that you want

4 Select Off, 2‑up Portrait, 2‑up Landscape, 4‑up Portrait, or 4‑up Landscape.
5 Select the number of copies or enter a number on the keypad, and then press

.

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

6 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Placing information on copies
Placing an overlay message on each page
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
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Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Copy >

> Overlay > select an overlay message you want

4 Select Off, Confidential, Copy, Draft, Urgent, or Custom.
5 Select the number of copies or enter a number on the keypad, and then press

.

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

6 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Canceling a copy job
Canceling a copy job from the printer control panel
1 From the printer control panel, press

.

2 When a list of copy jobs appears, select the job to cancel, and then press
3 Press

.

to go back to the home screen.

Understanding the copy options
Copies
This option lets you set the number of copies to be printed.

Copy from
This option opens a screen where you can select the paper size of the original document.

• To scroll to the paper size that matches the original document, press the left or right arrow button, and then press
.

• To copy an original document that contains mixed paper sizes with the same width, press the left or right arrow
button to scroll to Mixed Sizes, and then press

.
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• To set the printer to automatically detect the size of the original document, press the left or right arrow button to
scroll to Auto Size Sense, and then press

.

Copy to
This option lets you select the paper size and type on which your copies will be printed.

• To scroll to the paper size and type that matches the paper loaded in the tray or feeder, press the left or right arrow
button, and then press

.

• If the settings for “Copy from” and “Copy to” are different, then the printer automatically adjusts the Scale setting
to accommodate the difference.

• If the paper type or size you want to use is not loaded in one of the trays, then press the left or right arrow button
to scroll to Manual Feeder, press
feeder.

, and then manually load the paper in the manual feeder or multipurpose

• To match each copy to the paper size of the original document, set “Copy to” to Auto Size Match. If a matching
paper size is not in one of the trays, then Paper size not found appears and prompts to load a paper in a
tray, manual feeder, or multipurpose feeder.

Scale
This option lets you scale the document from 25% to 400% of the original document size. You can also set automatic
scaling.

• When copying to a different paper size, such as from legal‑size to letter‑size paper, set the “Copy from” and “Copy
to” paper sizes automatically to scale the scan image to fit the size of the paper onto which you are copying.

• To decrease or increase the value by 1%, press the left or right arrow button on the printer control panel. To make
a continuous decrease or increase in value, press and hold the button for two or more seconds.

Darkness
This option lets you adjust how light or dark the copies are in relation to the original document.

Collate
This option keeps the pages of a print job stacked in sequence when printing multiple copies of the document.

Content Type
This option lets you set the original document type.
Select from the following content types:

•
•
•
•

Graphics—The original document is mostly business‑type graphics, such as pie charts, bar charts, and animations.
Photo—The original document is mostly a photo or an image.
Text—The content of the original document is mostly text or line art.
Text/Photo—The original document is a mixture of text, graphics, and photos.
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Content Source
This option lets you set the original document source.
Select from the following content sources:

•
•
•
•
•
•
•
•

Color Laser—The original document was printed using a color laser printer.
Black/White Laser—The original document was printed using a mono laser printer.
Inkjet—The original document was printed using an inkjet printer.
Photo/Film—The original document is a photo from a film.
Magazine—The original document is from a magazine.
Newspaper—The original document is from a newspaper.
Press—The original document was printed using a printing press.
Other—The original document was printed using an alternate or unknown printer.

Overlay
This option lets you create a watermark (or message) that overlays the content of your copy. You can choose from
Confidential, Copy, Draft, Urgent, and Custom. You can type a custom message in the ”Enter the Custom Text Overlay
and press OK” field. The message will appear, faintly, in large print across each page.

Separator Sheets
This option lets you place a blank sheet of paper between copies, prints, pages, print jobs or copy jobs. The separator
sheets can be drawn from a tray that contains a type or color of paper that is different from the paper your copies are
printed on.

Paper Saver
This option lets you print two or more pages of an original document on the same page. Paper Saver is also called Nup printing where N stands for the number of pages. For example, 2-up would print two pages of your document on a
single page, and 4-up would print four pages of your document on a single page.
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E-mailing
Automatic document feeder (ADF)

Scanner glass

Use the ADF for multiple‑page documents.
Note: The ADF scans only one side of the sheet.
Use the scanner glass for single-page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

Setting up the printer to e-mail
Setting up the e-mail function
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > E-mail/FTP Settings > E-mail Settings.
3 Enter the appropriate information, and then click Submit.

Configuring e‑mail settings
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > E-mail/FTP Settings > E-mail Settings.
3 Enter the appropriate information, and then click Submit.
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Creating an e-mail shortcut
Creating an e-mail shortcut using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Manage Shortcuts > E-mail Shortcut Setup.
3 Type a name for the shortcut, and then enter the e-mail address.
Note: If you are entering multiple addresses, then separate each address with a comma (,).

4 Adjust the scan settings, if necessary.
5 Enter a shortcut number, and then click Add.
If you enter a number that is already in use, then you are prompted to select another number.

E-mailing a document
Sending an e‑mail using a shortcut number
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 Press #, then enter the shortcut number using the keypad, and then press
4 Press

.

Canceling an e-mail
From the printer control panel, press

.

.
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Faxing
Automatic document feeder (ADF)

Scanner glass

Use the ADF for multiple‑page documents.
Note: The ADF scans only one side of the sheet.
Use the scanner glass for single-page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

Setting up the printer to fax
CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning
storm.
Notes:

• The following connection methods are applicable only in some countries or regions.
• During the initial printer setup, clear the fax function check box and any other function you plan to set up later,
and then select Continue.

• The indicator light may blink red if the fax function is enabled and not fully set up.
Warning—Potential Damage: Do not touch the cables or the printer in the area shown while actively sending or
receiving a fax.
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Initial fax setup
Many countries and regions require outgoing faxes to contain the following information in a margin at the top or bottom
of each transmitted page, or on the first page of the transmission: fax name (identification of the business, other entity,
or individual sending the message) and fax number (telephone number of the sending fax machine, business, other
entity, or individual).
To enter your fax setup information, use the printer control panel, or use your browser to access the Embedded Web
Server, and then open the Settings menu.
Note: If you do not have a TCP/IP environment, then you must use the printer control panel to enter your fax setup
information.

Using the printer control panel for fax setup
When the printer is turned on for the first time, a series of start‑up screens appear. If the printer has fax capabilities,
then the Fax Name or Station Name and Fax Number or Station Number screens appear:

1 When Fax Name or Station Name appears, type the name to be printed on all outgoing faxes, and then press
.

2 When Fax Number or Station Number appears, enter the printer fax number, and then press

.

Using the Embedded Web Server for fax setup
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Fax Settings > Analog Fax Setup.
3 In the Fax Settings menu, type the name to be printed on all outgoing faxes in the Fax Name or Station Name field.
4 In the Fax Number or Station Number field, enter the printer fax number.
5 Click Submit.
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Choosing a fax connection
Scenario 1: Standard telephone line
Setup 1: Printer is connected to a dedicated fax line

To connect:

1 Connect one end of the telephone cable that came with the printer to the

port of the printer.

2 Connect the other end of the telephone cable to an active analog wall jack.
Tips for this setup:

• You can set the printer to receive faxes automatically (Auto Answer On) or manually (Auto Answer Off).
• If you want to receive faxes automatically (Auto Answer On), then set the printer to pick up on any number of rings
that you want.
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Setup 2: Printer is sharing the line with an answering machine
Connected to the same telephone wall jack

PHONE

LINE

To connect:

1 Connect one end of the telephone cable that came with the printer to the
2 Connect the other end of the telephone cable to an active analog wall jack.
3 Connect the answering machine to the

port of the printer.

port of the printer.
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Connected to different wall jacks

PHONE

LINE

To connect:

1 Connect one end of the telephone cable that came with the printer to the

port of the printer.

2 Connect the other end of the telephone cable to an active analog wall jack.
Tips for this setup:

• If you have only one telephone number on your line, then you need to set the printer to receive faxes automatically
(Auto Answer On).

• Set the printer to pick up calls two rings after the answering machine. For example, if the answering machine picks
up calls after four rings, then set the printer to pick up after six rings. This way, the answering machine picks up
calls first and your voice calls are received. If the call is a fax, then the printer detects the fax signal on the line and
takes over the call.

• If you subscribe to a distinctive ring service provided by your telephone company, then make sure that you set the
correct ring pattern for the printer. Otherwise, the printer does not receive faxes even if you have set it to receive
faxes automatically.
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Setup 3: Printer is sharing the line with a telephone subscribed to voice mail service

02

To connect:

1 Connect one end of the telephone cable that came with the printer to the

port of the printer.

2 Connect the other end of the telephone cable to an active analog wall jack.
3 Connect the telephone to the

port of the printer.

Tips for this setup:

• This setup works best if you subscribe to a distinctive ring service. If you have distinctive ring service, then make
sure that you set the correct ring pattern for the printer. Otherwise, the printer does not receive faxes even if you
have set it to receive faxes automatically.

• If you have only one telephone number on your line, then you need to set the printer to receive faxes manually
(Auto Answer Off).
When you answer the telephone and you hear fax tones, press *9* or the manual answer code on the telephone
to receive the fax.

• You can also set the printer to receive faxes automatically (Auto Answer On), but you need to turn off the voice
mail service when you are expecting a fax. This setting works best if you are using voice mail more often than fax.
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Scenario 2: Digital Subscriber Line (DSL)

A Digital Subscriber Line splits your regular telephone line into two channels: voice and Internet. Telephone and fax
signals travel through the voice channel, and Internet signals pass through the other channel. This way, you can use
the same line for analog voice calls (including faxes) and digital Internet access.
To minimize interference between the two channels and ensure a quality connection, you need to install a DSL filter
for the analog devices (fax machine, telephone, answering machine) in your network. Interference causes noise and
static on the telephone, failed and poor quality faxes for the printer, and slow Internet connection on your computer.
Note: Contact your DSL provider to obtain a DSL filter.
To install a filter for the printer:

1 Connect the line port of the DSL filter to the wall jack.
2 Connect one end of the telephone cable that came with your printer to the

port of the printer. Connect the other

end to the phone port on the DSL filter.

3 To connect a telephone to the printer, remove any installed adapter plug from the
connect the telephone to the port.

port of the printer, and then
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Scenario 3: VoIP telephone service

To connect:

1 Connect one end of the telephone cable that came with the printer to the

port of the printer.

2 Connect the other end of the cable to the port labeled Phone Line 1 or Phone Port on the VoIP adapter.
Note: The port labeled Phone Line 2 or Fax Port is not always active. VoIP providers may charge additional cost
for activation of the second phone port.

3 Connect the telephone to the

port of the printer.

Tips for this setup:

• To make sure that the phone port on the VoIP adapter is active, plug an analog telephone into the phone port, and
then listen for a dial tone. If you hear a dial tone, then the port is active.

• If you need two phone ports for your devices, but do not want to pay additional cost, then do not plug the printer
into the second phone port. You can use a phone splitter. Plug the phone splitter into the port labeled Phone Line
1 or Phone Port, and then plug the printer and telephone into the splitter.
Note: Make sure you use a phone splitter, not a line splitter. To make sure that you are using the correct
splitter, plug an analog telephone into the splitter and then listen for a dial tone.
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Scenario 4: Digital telephone service through a cable provider
Setup 1: Printer is connected directly to a cable modem

1 Connect one end of the telephone cable that came with your printer to the

port of the printer.

2 Connect the other end of the cable to the port labeled Phone Line 1 or Phone Port on the cable modem.
Note: The port labeled Phone Line 2 or Fax Port is not always active. VoIP providers may charge additional cost
for activation of the second phone port.

3 Connect your analog telephone phone to the

port of the printer.

Notes:

• To make sure that the telephone port on the cable modem is active, plug an analog telephone into the
telephone port, and then listen for a dial tone. If you hear a dial tone, then the port is active.

• If you need two telephone ports for your devices, but do not want to pay additional cost, then do not plug the
printer into the second telephone port. You can use a phone splitter. Plug the phone splitter into the Phone Line
1 or Phone Port, and then plug the printer and telephone into the splitter.

• Make sure you use a phone splitter, not a line splitter. To make sure that you are using the correct splitter, plug
an analog telephone into the splitter and then listen for a dial tone.
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Setup 2: Printer is connected to a wall jack; cable modem is installed elsewhere in the facility

1 Connect one end of the telephone cable that came with your printer to the

port of the printer.

2 Connect the other end of the telephone cable to an active analog telephone wall jack.
3 Connect your analog telephone to the

port of the printer.

Scenario 5: Countries or regions with different telephone wall jacks and plugs
Some countries or regions may have different types of telephone wall jack connectors than those that came with the
printer. The standard wall jack adopted by most countries or regions is RJ-11. Your printer comes with the RJ-11 jack
and a telephone cable with the RJ-11 plug.
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If the wall jack or equipment in your facility is not compatible with this type of connection, then you need to use a
telephone adapter. An adapter for your country or region may not come with your printer, and you may need to
purchase it separately.

There may be an adapter plug installed in the
port of the printer. If you are using a telephone adapter or a facility
port of the printer.
that has a cascaded or serial wiring scheme, then do not remove the adapter plug from the

Part name

Part number

Lexmark adapter plug

40X8519
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Connecting the printer to a non‑RJ‑11 wall jack

LINE

EXT

1 Connect one end of the telephone cable that came with printer to the

port of the printer.

2 Connect the other end of the cable to the RJ‑11 adapter, and then connect the adapter to the wall jack.
3 If you want to connect another device (telephone or answering machine) to the same wall jack, and if the device
has a non‑RJ‑11 connector, then connect it directly to the telephone adapter.
Notes:

• The
the

port of the printer may have an adapter plug for use with the adapter. Do not remove the plug from
port of the printer.

• In some countries or regions, the printer may not come with a telephone adapter or an adapter plug.
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Connecting the printer to a wall jack in Germany
The German wall jack has two kinds of ports. The N ports are for fax machines, modems, and answering machines. The
F port is for telephones.

N F N

Connect the printer to any of the N ports.

N F N

PHONE

LINE
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1 Connect one end of the telephone cable that came the printer to the

port of the printer.

2 Connect the other end of the telephone cable to the RJ‑11 adapter, and then connect the adapter to an N port.
3 If you want to connect a telephone and answering machine to the same wall jack, then connect the devices as
shown.
Note: Do not remove the adapter plug from the
telephone system.

port of the printer if you are connecting to a serial or cascaded

Connecting to a distinctive ring service
A distinctive ring service may be available from your telephone company. This service lets you have multiple telephone
numbers on one telephone line, with each telephone number having a different ring pattern. This may be useful for
distinguishing between fax and voice calls. If you subscribe to a distinctive ring service, then follow these steps to
connect the equipment:

1 Connect one end of the telephone cable that came with the printer to the printer LINE port .
2 Connect the other end of the telephone cable to an active analog telephone wall jack.

3 Change the Distinctive Rings setting to match the setting you want the printer to answer.
From the printer control panel, navigate to:
> Settings >

> Fax Settings >

> Distinctive Rings > select the ring tone you want >

Setting the outgoing fax or station name and number
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Fax Settings > Analog Fax Setup.
3 From the Fax Settings menu, type the name to be printed on all outgoing faxes in the Fax Name or Station Name
field.

4 In the Fax Number or Station Number field, enter the printer fax number.
5 Click Submit.
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Setting the date and time
You can set the date and time so that they are printed on every fax you send. If there is a power failure, then you may
have to reset the date and time.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Other Settings area > Security > Set Date and Time.
3 In the Set Date & Time field, enter the current date and time.
4 Click Submit.
Note: We recommend using the network time.

Configuring the printer to observe daylight saving time
Set the printer to automatically adjust for daylight saving time.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Security > Set Date and Time.
3 Select the Automatically Observe DST check box, and then enter the DST start and end dates in the Custom Time
Zone Setup section.

4 Click Submit.

Sending a fax
Sending a fax using the printer control panel
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
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3 From the printer control panel, navigate to:
> Fax >

> enter a fax or shortcut number on the keypad >

> Original Size >

Note: If you want to fax another document, then place it on the scanner glass, press the left or right arrow
button to scroll to Scan the Next Page, and then press

.

4 Press the left or right arrow button to scroll to Finish the Job, and then press

.

Sending a fax using the computer
For Windows users
1 With a document open, click File > Print.
2 Select the printer, and then click Properties, Preferences, Options, or Setup.
3 Click Fax > Enable fax, and then enter the recipient fax number or numbers.
4 If necessary, configure other fax settings.
5 Apply the changes, and then send the fax job.
Notes:

• The fax option is available only with the PostScript driver or the Universal Fax Driver. For more information, go
to http://support.lexmark.com.

• To use the fax option with the PostScript driver, configure and enable it in the Configuration tab.
For Macintosh users
1 With a document open, choose File > Print.
2 Select the printer.
3 Enter the recipient fax number, and then configure other fax settings, if necessary.
4 Send the fax job.

Sending a fax using a shortcut number
Fax shortcuts are just like the speed dial numbers on a telephone or fax machine. A shortcut number (1–999) can contain
a single recipient or multiple recipients.

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
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3 Press # , and then enter the shortcut number on the keypad.
4 Press

.

Sending a fax at a scheduled time
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly into the ADF tray.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Fax >

> select the time you want the fax to be sent >

sent >

4 Press

> enter the fax number > Delayed Send > Send Later > select the date you want the fax to be

.

Note: The document is scanned, and then faxed at the scheduled time.

Creating a fax destination shortcut using the Embedded Web
Server
Assign a shortcut number to a single fax number or a group of fax numbers.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Manage Shortcuts > Fax Shortcut Setup.
Note: A password may be required. If you do not have an ID and password, then contact your system support
person.

3 Type a name for the shortcut, and then enter the fax number.
Notes:

• To create a multiple‑number shortcut, enter the fax numbers for the group.
• Separate each fax number in the group with a semicolon (;).
4 Assign a shortcut number.
Note: If you enter a number that is already in use, then you are prompted to select another number.

5 Click Add.
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Customizing fax settings
Changing the fax resolution
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
> Fax >

> enter the fax number > Resolution > select the resolution you want

Note: You can choose from Standard (fastest speed) to Ultra Fine (slowest speed and best quality).

4 Press

.

Making a fax lighter or darker
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, navigate to:
Fax >

> enter the fax number >

> Darkness > adjust the darkness of the fax >

Viewing a fax log
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Reports.
3 Click Fax Job Log or Fax Call Log.
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Blocking junk faxes
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Fax Settings > Analog Fax Setup > Block No Name Fax.
Notes:

• This option blocks all incoming faxes that have a private caller ID or no fax name.
• In the Banned Fax List field, enter the phone numbers or fax names of specific fax callers you want to block.

Canceling an outgoing fax
Canceling a fax job while the original documents are still scanning
• If you are using the ADF tray and Scanning page appears, then press
.
• If you are using the scanner glass and Scanning page, Scan the Next Page, or Finish the Job
appears, then press

.

Canceling a fax job after scanning the original documents
1 From the printer control panel, press

.

2 Press the left or right arrow button to scroll to the job you want to cancel.
3 Press

> Delete Selected Jobs.

Holding and forwarding faxes
Holding faxes
This option lets you hold received faxes from printing until they are released. Held faxes can be released manually or
at a scheduled day or time.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Fax Settings > Analog Fax Setup > Holding Faxes.
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3 From the Held Fax Mode menu, select Off, Always On, Manual, or Scheduled.
4 If you selected Scheduled, then continue with the following steps:
a Click Fax Holding Schedule.
b From the Action menu, select Hold faxes.
c From the Time menu, select the time you want the held faxes released.
d From the Day(s) menu, select the day you want the held faxes released.
5 Click Add.

Forwarding a fax
This option lets you print and forward received faxes to a fax number, e‑mail address, FTP site, or LDSS.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Fax Settings.
3 From the Fax Forwarding menu, select Print, Print and Forward, or Forward.
4 From the “Forward to” menu, select Fax, E‑mail, FTP, LDSS, or eSF.
5 In the “Forward to Shortcut” field, enter the shortcut number where you want the fax forwarded.
Note: The shortcut number must be valid for the setting selected in the “Forward to” menu.

6 Click Submit.

Understanding the fax options
Original Size
This option lets you choose the size of the documents you are going to fax.

1 From the Fax area of the printer control panel, press the Options button.
Original Size appears.

2 Press

.

3 Press the arrow buttons until the size of the original document appears, and then press

.

Resolution
This option lets you adjust the quality of the fax output. Increasing the image resolution increases the file size and the
time needed to scan your original document. Decreasing the image resolution reduces the file size.
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Select one of the following:

•
•
•
•

Standard—Use this when faxing most documents.
Fine 200 dpi—Use this when faxing documents with small prints.
Super fine 300 dpi—Use this when faxing documents with fine details.
Ultra fine 600 dpi—Use this when faxing documents with pictures or photos.

Darkness
This option lets you adjust how light or dark the faxes are in relation to the original document.

Content Type
This option lets you set the original document type.
Select from the following content types:

•
•
•
•

Graphics—The original document is mostly business‑type graphics, such as pie charts, bar charts, and animations.
Photo—The original document is mostly a photo or an image.
Text—The content of the original document is mostly text or line art.
Text/Photo—The original document is a mixture of text, graphics, and photos.

Content Source
This option lets you set the original document source.
Select from the following content sources:

•
•
•
•
•
•
•
•

Color Laser—The original document was printed using a color laser printer.
Black/White Laser—The original document was printed using a mono laser printer.
Inkjet—The original document was printed using an inkjet printer.
Photo/Film—The original document is a photo from a film.
Magazine—The original document is from a magazine.
Newspaper—The original document is from a newspaper.
Press—The original document was printed using a printing press.
Other—The original document was printed using an alternate or unknown printer.

Orientation
This option lets you specify the orientation of the original document, and then change the Sides and Binding settings
to match the orientation.

Binding
This option lets you specify if the original document is bound on the long‑edge or short‑edge side.
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Scanning
Scanning to an FTP address
Automatic document feeder (ADF)

Scanner glass

Use the ADF for multiple‑page documents.
Note: The ADF scans only one side of the sheet.
Use the scanner glass for single-page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

The scanner lets you scan documents directly to a File Transfer Protocol (FTP) server. Only one FTP address may be
sent to the server at a time.
When an FTP destination has been configured by your system support person, the name of the destination becomes
available as a shortcut number, or it is listed as a profile under the Held Jobs icon. An FTP destination could also be
another PostScript printer.

Creating shortcuts
Creating an FTP shortcut using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Navigate to:
Settings > Other Settings area > Manage Shortcuts > FTP Shortcut Setup

3 Enter the appropriate information.
Note: A password may be required. If you do not have an ID and password, then contact your system support
person.
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4 Enter a shortcut number.
If you enter a number that is already in use, then you are prompted to select another number.

5 Click Add.

Scanning to an FTP address
Scanning to an FTP address using a shortcut number
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.
2 If you are loading a document into the ADF tray, then adjust the paper guides.
3 From the printer control panel, press #, and then enter the FTP shortcut number.
4 Press

.

Scanning to a computer
Scanning to a computer
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Scan Profile > Create Scan Profile.
3 Select your scan settings, and then click Next.
4 Select a location on your computer where you want to save the scanned output file.
5 Type a scan name.
The scan name is the name that appears in the Scan Profile list on the display.

6 Click Submit.
7 Review the instructions on the Scan Profile screen.
A shortcut number is automatically assigned when you click Submit. You can use this shortcut number when you
are ready to scan your documents.

a Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
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Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as
magazine clippings) into the ADF tray. Place these items on the scanner glass.
• The ADF indicator light turns on when the paper is loaded properly.

b If you are loading a document into the ADF tray, then adjust the paper guides.
c From the printer control panel, press #, and then type the shortcut number using the keypad, or press the up
or down arrow button to scroll to Held Jobs, and then press the up or down arrow button to scroll to Profiles.
After entering the shortcut number, the scanner scans and sends the document to the directory or program
you specified. If you selected Profiles on the printer control panel, then locate your shortcut on the list.

8 View the file from the computer.
The output file is saved in the location or launched in the program you specified.

Understanding the printer menus
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Understanding the printer menus
Menus list
Paper Menu

Reports

Network/Ports

Security

Settings

Default Source
Paper Size/Type

Menu Settings Page
Device Statistics

Active NIC

Confidential Print
Security Audit Log

General Settings
Copy Settings

Set Date and Time

Fax Settings

Page1

Standard

Network2

Configure MP

Network Setup

Substitute Size

E‑mail Settings

Paper Texture

Shortcut List
Fax Job Log

Paper Weight

Fax Call Log

Print Settings

Paper Loading

Copy Shortcuts

Custom Types

E-mail Shortcuts

Custom Scan Sizes
Universal Setup

Fax Shortcuts

SMTP Setup

FTP Settings

FTP Shortcuts
Profiles List
Print Fonts
Asset Report

Help

Manage Shortcuts

Print All Guides
Copy Guide

Fax Shortcuts
E-mail Shortcuts

E-mail Guide

FTP Shortcuts

Fax Guide

Copy Shortcuts

FTP Guide

Profile Shortcuts

Print Defects Guide
Information Guide
Supplies Guide
1

Depending on the printer setup, this menu item appears as Network Setup Page or Network [x] Setup Page.

2

Depending on the printer setup, this menu item appears as Standard Network or Network [x].
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Paper menu
Default Source menu
Use

To

Default Source
Tray [x]
MP Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.
Notes:

• Tray 1 (standard tray) is the factory default setting.
• From the Paper menu, set Configure MP to "Cassette" for MP Feeder to
appear as a menu setting.

• If two trays contain paper of the same size and type, and the trays have
the same settings, then the trays are automatically linked. When one tray
is empty, the print job continues using the linked tray.

Paper Size/Type menu
Use

To

Tray [x] Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the size of the paper loaded in each tray.

Tray [x] Type
Plain Paper
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of the paper loaded in each tray.

Notes:

• Letter is the U.S. factory default setting. A4 is the international factory
default setting.

• If the same size and type of paper are loaded in two trays and the tray
settings for paper size and type match, then the trays are automatically
linked. The multipurpose feeder may also be linked. When one tray is
empty, the job prints using paper from the linked tray.

• A6 is supported only in Tray 1 and in the multipurpose feeder.

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type [x] is
the factory default setting for all other trays.

• If available, a user‑defined name will appear instead of Custom Type [x].
• Use this menu to configure automatic tray linking.

Note: Only installed trays and feeders are listed in this menu.
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Use

To

MP Feeder Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the size of the paper loaded in the multipurpose feeder.

MP Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Envelope
Rough Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of the paper loaded in the multipurpose feeder.

Notes:

• Letter is the U.S. factory default setting. A4 is the international factory
default setting.

• From the Paper menu, set Configure MP to “Cassette” for MP Feeder
Size to appear as a menu item.

• The multipurpose feeder does not automatically detect paper size. The
paper size value must be set.

Notes:

• Plain Paper is the factory default setting.
• From the Paper menu, set Configure MP to “Cassette” in order for MP
Feeder Type to appear as a menu item.

Note: Only installed trays and feeders are listed in this menu.
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Use

To

Manual Paper Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the size of the paper being manually loaded.

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of the paper being manually loaded.

Manual Envelope Size
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the size of the envelope being manually loaded.

Manual Envelope Type
Envelope
Rough Envelope
Custom Type [x]

Specify the type of the envelope being manually loaded.

Note: Letter is the U.S. factory default setting. A4 is the international factory
default setting.

Notes:

• Plain Paper is the factory default setting.
• From the Paper menu, set Configure MP to “Manual” in order for
Manual Paper Type to appear as a menu item.

Note: 10 Envelope is the U.S. factory default setting. DL Envelope is the
international factory default setting.

Note: Envelope is the factory default setting.

Note: Only installed trays and feeders are listed in this menu.
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Configure MP menu
Use

To

Configure MP
Cassette
Manual
First

Determine when the printer selects paper from the multipurpose feeder.
Notes:

• Cassette is the factory default setting. Cassette configures the
multipurpose feeder as the automatic paper source.

• Manual sets the multipurpose feeder only for manual‑feed print jobs.
• First configures the multipurpose feeder as the primary paper source.

Substitute Size menu
Use

To

Substitute Size
Off
Statement/A5
Letter/A4
All Listed

Substitute a specified paper size if the requested paper size is not available.
Notes:

• All Listed is the factory default setting. All available substitutions are
allowed.

• Off indicates that no size substitutions are allowed.
• Setting a size substitution lets the print job continue without Change
Paper appearing.

Paper Texture menu
Use

To

Plain Texture
Smooth
Normal
Rough

Specify the relative texture of the plain paper loaded.

Card Stock Texture
Smooth
Normal
Rough

Specify the relative texture of the card stock loaded.

Transparency Texture
Smooth
Normal
Rough

Specify the relative texture of the transparencies loaded.

Recycled Texture
Smooth
Normal
Rough

Specify the relative texture of the recycled paper loaded.

Note: Normal is the factory default setting.

Notes:

• Normal is the factory default setting.
• The options appear only if card stock is supported.
Note: Normal is the factory default setting.

Note: Normal is the factory default setting.
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Use

To

Labels Texture
Smooth
Normal
Rough

Specify the relative texture of the labels loaded.

Bond Texture
Smooth
Normal
Rough

Specify the relative texture of the bond paper loaded.

Envelope Texture
Smooth
Normal
Rough

Specify the relative texture of the envelopes loaded.

Rough Envelope Texture
Rough

Specify the relative texture of the rough envelopes loaded.

Letterhead Texture
Smooth
Normal
Rough

Specify the relative texture of the letterhead loaded.

Preprinted Texture
Smooth
Normal
Rough

Specify the relative texture of the preprinted paper loaded.

Colored Texture
Smooth
Normal
Rough

Specify the relative texture of the colored paper loaded.

Light Texture
Smooth
Normal
Rough

Specify the relative texture of the paper loaded.

Heavy Texture
Smooth
Normal
Rough

Specify the relative texture of the paper loaded.

Rough/Cotton Texture
Rough

Specify the relative texture of the cotton paper loaded.

Custom [x] Texture
Smooth
Normal
Rough

Specify the relative texture of the custom paper loaded.

Note: Normal is the factory default setting.

Note: Rough is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Notes:

• Normal is the factory default setting.
• The options appear only if the custom type is supported.
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Paper Weight menu
Use

To

Plain Weight
Light
Normal
Heavy

Specify the relative weight of the plain paper loaded.

Card Stock Weight
Light
Normal
Heavy

Specify the relative weight of the card stock loaded.

Transparency Weight
Light
Normal
Heavy

Specify the relative weight of the transparencies loaded.

Recycled Weight
Light
Normal
Heavy

Specify the relative weight of the recycled paper loaded.

Labels Weight
Light
Normal
Heavy

Specify the relative weight of the labels loaded.

Bond Weight
Light
Normal
Heavy

Specify the relative weight of the bond paper loaded.

Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the envelope loaded.

Rough Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the rough envelope loaded.

Letterhead Weight
Light
Normal
Heavy

Specify the relative weight of the letterhead loaded.

Preprinted Weight
Light
Normal
Heavy

Specify the relative weight of the preprinted paper loaded.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.
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Use

To

Colored Weight
Light
Normal
Heavy

Specify the relative weight of the colored paper loaded.

Light Weight
Light

Specify that the relative weight of the paper loaded is light.

Heavy Weight
Heavy

Specify the relative weight of the paper loaded is heavy.

Rough/Cotton Weight
Light
Normal
Heavy

Specify the relative weight of the cotton or rough paper loaded.

Custom [x] Weight
Light
Normal
Heavy

Specify the relative weight of the custom paper loaded.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Notes:

• Normal is the factory default setting.
• The options appear only when the custom type is supported.

Paper Loading menu
Use

To

Recycled Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Recycled as the paper type.

Bond Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Bond as the paper type.

Letterhead Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Letterhead as the paper type.

Preprinted Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Preprinted as the paper type.

Colored Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Colored as the paper type.

Notes:

• Duplex sets two‑sided printing as the default for all print jobs unless one‑sided printing is set from Printing
Preferences or Print dialog.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including one‑sided jobs.
• Off is the factory default setting for all the menus.
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Use

To

Light Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Light as the paper type.

Heavy Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Heavy as the paper type.

Custom [x] Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Custom [x] as the paper type.
Note: Custom [x] Loading is available only if the custom type is
supported.

Notes:

• Duplex sets two‑sided printing as the default for all print jobs unless one‑sided printing is set from Printing
Preferences or Print dialog.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including one‑sided jobs.
• Off is the factory default setting for all the menus.

Custom Types menu
Use

To

Custom Type [x]
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Vinyl Labels
Envelope

Associate a paper or specialty media type with a factory default custom type
name or a user‑defined custom name created from the Embedded Web Server
or from MarkVisionTM Professional.

Recycled
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Vinyl Labels
Envelope

Specify a paper type when Recycled is selected in other menus.

Notes:

• Paper is the factory default setting.
• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.

Notes:

• Paper is the factory default setting.
• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.
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Custom Scan Sizes menu
Use

To

Custom Scan Size [x]
Scan Size Name
Width
Height
Orientation
2 scans per side
Off
On

Specify a custom scan size name, size, and page orientation.
Notes:

• 8.5 inches is the U.S. factory default setting for Width. 216 mm is the
international factory default setting for Width.

• 14 inches is the U.S. factory default setting for Height. 356 mm is the
international factory default setting for Height.

• Portrait is the factory default setting for Orientation.
• Off is the factory default setting for 2 scans per side.

Universal Setup menu
Use

To

Units of Measure
Inches
Millimeters

Identify the units of measure.

Portrait Width
3–14.17 inches
76–360 mm

Set the portrait width.

Notes:

• Inches is the U.S. factory default setting.
• Millimeters is the international factory default setting.
Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the U.S. factory default setting. You can increase the
width in 0.01‑inch increments.

• 216 mm is the international factory default setting. You can increase
the width in 1‑mm increments.
Portrait Height
3–14.17 inches
76–360 mm

Set the portrait height.
Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the U.S. factory default setting. You can increase the
height in 0.01‑inch increments.

• 356 mm is the international factory default setting. You can increase
the height in 1‑mm increments.
Feed Direction
Short Edge
Long Edge

Specify the feed direction if the paper can be loaded in either direction.
Notes:

• Short Edge is the factory default setting.
• Long Edge appears only when the longest edge is shorter than the
maximum width supported in the tray.
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Reports menu
Reports menu
Use

To

Menu Settings Page

Print a report containing information about the paper loaded into trays, installed
memory, total page count, alarms, timeouts, printer control panel language,
TCP/IP address, status of supplies, status of the network connection, and other
information.

Device Statistics

Print a report containing printer statistics such as supply information and details
about printed pages.

Network Setup Page

Print a report containing information about the network printer settings, such as
the TCP/IP address information.
Note: This menu item appears only in network printers or printers connected
to print servers.

Shortcut List

Print a report containing information about configured shortcuts.

Fax Job Log

Print a report containing information about the last 200 completed faxes.
Note: This menu item is available only when Enable Job Log is set to On in the
Fax Settings menu.

Fax Call Log

Print a report containing information about the last 100 attempted, received, and
blocked calls.
Note: This menu item is available only when Enable Job Log is set to On in the
Fax Settings menu.

Copy Shortcuts

Print a report containing information about copy shortcuts.

E‑mail Shortcuts

Print a report containing information about e‑mail shortcuts.

Fax Shortcuts

Print a report containing information about fax shortcuts.

FTP Shortcuts

Print a report containing information about FTP shortcuts.

Profiles List

Print a list of profiles stored in the printer.

Print Fonts

Print a report of all the fonts available for the printer language currently set in
the printer.

Asset Report

Print a report containing asset information including the printer serial number
and model name. The report contains text and UPC bar codes that can be scanned
into an asset database.

Understanding the printer menus

103

Network/Ports menu
Active NIC menu
Use

To

Active NIC
Auto
[list of available network cards]

Notes:

• Auto is the factory default setting.
• This menu item appears only when an optional network card is installed.

Standard Network or Network [x] menu
Note: Only active ports appear in this menu.
Use

To

Energy Efficient Ethernet
Enable
Disable

Reduce power consumption when the printer receives no data from the Ethernet
network.

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language.

Note: Enable is the factory default setting.

Notes:

• On is the factory default setting.
• If PCL SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.
PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job requires it,
regardless of the default printer language.
Notes:

• On is the factory default setting.
• If PS SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.
NPA Mode
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.
Notes:

• Auto is the factory default setting.
• The printer automatically restarts when the setting is changed from the
control panel.
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Use

To

Network Buffer
Auto
3KB to [maximum size allowed]

Set the size of the network input buffer.
Notes:

• Auto is the factory default setting.
• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

• The printer automatically restarts when the setting is changed from the
control panel.
Job Buffering
Off
On
Auto

Temporarily store print jobs in the printer hard disk before printing. This menu only
appears when a formatted disk is installed.
Notes:

• Off is the factory default setting.
• The printer automatically restarts when the setting is changed from the
control panel. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Standard Network Setup OR
Network [x] Setup
Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk

Show and set the printer network settings.

Note: Auto is the factory default setting.

Note: The Wireless menu appears only when the printer is connected to a wireless
network.

Reports menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Reports
• Network/Ports > Network [x] > Network [x] Setup > Reports
Use

To

Print Setup Page Print a report containing information about the network printer settings, such as the TCP/IP address.
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Network Card menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Network Card
• Network/Ports > Network [x] > Network [x] Setup > Network Card
Use

To

View Card Status
Connected
Disconnected

View the connection status of the wireless network adapter.

View Card Speed

View the speed of an active wireless network adapter.

Network Address
UAA
LAA

View the network addresses.

Job Timeout
0, 10–225 seconds

Set the amount of time it takes for a network print job to be canceled.
Notes:

• “90 seconds” is the factory default setting.
• A setting value of 0 disables the timeout.
• If a value between 1 and 9 is selected, then Invalid appears on the
display, and the value is not saved.
Banner Page
Off
On

Allow the printer to print a banner page.
Note: Off is the factory default setting.

TCP/IP menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > TCP/IP
• Network/Ports > Network [x] > Network [x] Setup > TCP/IP
Note: This menu is available only in network printers or printers attached to print servers.
Use

To

Set Hostname

Set the current TCP/IP host name.
Note: This can be changed only from the Embedded Web Server.

IP Address

View or change the current TCP/IP address.
Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems that
support BOOTP and RARP.

Netmask

View or change the current TCP/IP netmask.

Gateway

View or change the current TCP/IP gateway.

Enable DHCP
On
Off

Specify the DHCP address and parameter assignment.
Note: On is the factory default setting.
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Use

To

Enable RARP
On
Off

Specify the RARP address assignment setting.

Enable BOOTP
On
Off

Specify the BOOTP address assignment setting.

Enable AutoIP
Yes
No

Specify the Zero Configuration Networking setting.

Enable FTP/TFTP
Yes
No

Enable the built-in FTP server, which lets you send files to the printer using File Transfer
Protocol.

Enable HTTP Server
Yes
No

Enable the built-in Web server (Embedded Web Server). When enabled, the printer
can be monitored and managed remotely using a Web browser.

WINS Server Address

View or change the current WINS server address.

Enable DDNS
Yes
No

View or change the current DDNS setting.

Enable mDNS
Yes
No

View or change the current mDNS setting.

DNS Server Address

View or change the current DNS server address.

Backup DNS Server Address

View or change the backup DNS server addresses.

Note: Off is the factory default setting.

Note: On is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.

Backup DNS Server Address 2
Backup DNS Server Address 3
Enable HTTPS
Yes
No

View or change the current HTTPS setting.
Note: Yes is the factory default setting.

IPv6 menu
To access the menu, navigate to any of the following:

• Network/Ports menu > Standard Network > Standard Network Setup >IPv6
• Network/Ports menu > Network [x] > Network [x] Setup > IPv6
Note: This menu is available only in network printers or printers that are attached to print servers.
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Use

To

Enable IPv6
On
Off

Enable IPv6 in the printer.

Auto Configuration
On
Off

Specify whether or not the network adapter accepts the automatic IPv6
address configuration entries provided by a router.

Set Hostname

Set the host name.

View Address

Note: These settings can be changed only from the Embedded Web
Server.

View Router Address
Enable DHCPv6
On
Off

Note: On is the factory default setting.

Note: On is the factory default setting.

Enable DHCPv6 in the printer.
Note: On is the factory default setting.

Wireless menu
Note: This menu is available only in printers connected to an Ethernet network and printers with a wireless network
adapter attached.
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Wireless
• Network/Ports > Network [x] > Network [x] Setup > Wireless
Use

To

Wi‑Fi Protected Setup (WPS)
Start Push Button Method
Start PIN Method

Establish a wireless network connection and enable network security.
Notes:

• Start Push Button Method connects the printer to a wireless
network when buttons on both the printer and the access point
(wireless router) are pressed within a given period of time.

• Start PIN Method connects the printer to a wireless network when
a PIN on the printer is entered into the wireless settings of the
access point.
Enable/Disable WPS Auto‑detection
Enable
Disable

Automatically detect the connection method that an access point with
WPS uses—Start Push Button Method or Start PIN Method.

Network Mode
BSS Type
Infrastructure
Ad hoc

Specify the network mode.

Note: Disable is the factory default setting.

Notes:

• Infrastructure is the factory default setting. This lets the printer
access a network using an access point.

• Ad hoc configures a wireless connection directly between the
printer and a computer.
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Use

To

Compatibility
802.11b/g
802.11b/g/n

Specify the wireless standard for the wireless network.

Choose Network

Select an available network for the printer to use.

View Signal Quality

View the quality of the wireless connection.

View Security Mode

View the encryption method for the wireless network.

Note: The 802.11b/g/n is the factory default setting.

AppleTalk menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > AppleTalk
• Network/Ports > Network [x] > Network [x] Setup > AppleTalk
Use

To

Activate
Yes
No

Enable or disable AppleTalk support.

View Name

Show the assigned AppleTalk name.

Note: No is the factory default setting.

Note: The AppleTalk name can be changed only from the Embedded Web
Server.
View Address

Show the assigned AppleTalk address.
Note: The AppleTalk address can be changed only from the Embedded Web
Server.

Set Zone
Provide a list of AppleTalk zones available on the network.
[list of zones available on the network] Note: The default zone for the network is the factory default setting.

SMTP Setup menu
Use

To

Primary SMTP Gateway

Specify SMTP server gateway and port information.

Primary SMTP Gateway Port

Note: 25 is the default SMTP gateway port.

Secondary SMTP Gateway
Secondary SMTP Gateway Port
SMTP Timeout
5–30

Specify the amount of time in seconds before the server stops trying to
send an e‑mail.
Note: 30 seconds is the factory default setting.

Reply Address

Specify a reply address of up to 128 characters in the e-mail sent by the
printer.
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Use

To

Use SSL
Disabled
Negotiate
Required

Set the printer to use SSL for increased security when connecting to the
SMTP server.
Notes:

• Disabled is the factory default setting.
• When the Negotiate setting is used, the SMTP server determines if
SSL will be used.

SMTP Server Authentication
No authentication required
Login/Plain
CRAM‑MD5
Digest‑MD5
NTLM
Kerberos 5

Specify the type of user authentication required for scan to e‑mail
privileges.

Device‑Initiated E‑mail
None
Use Device SMTP Credentials

Specify what credentials will be used when communicating to the SMTP
server.

Note: “No authentication required” is the factory default setting.

Notes:

Device Userid

• None is the factory default setting for Device‑Initiated E‑mail.
• Device Userid and Device Password are used to log in to the SMTP

Device Password

server when Use Device SMTP Credentials is selected.

Security menu
Security Audit Log menu
Use

To

Export Log

Let an authorized user export the audit log.
Notes:

• To export the audit log from the printer control panel, a flash drive must be
attached to the printer.

• The audit log can be downloaded from the Embedded Web Server and saved
on a computer.
Delete Log
Yes
No

Specify whether or not audit logs are deleted.
Note: Yes is the factory default setting.
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Use

To

Configure Log
Enable Audit
Yes
No
Enable Remote Syslog
No
Yes
Remote Syslog Facility
0–23
Severity of events to log
0–7

Specify how and whether or not audit logs are created.
Notes:

• Enable Audit determines if events are recorded in the secure audit log and
remote syslog. No is the factory default setting.

• Enable Remote Syslog determines if logs are sent to a remote server. No is the
factory default setting.

• Remote Syslog Facility determines the value used to send logs to the remote
syslog server. 4 is the factory default setting.

• If the security audit log is activated, then the severity value of each event is
recorded. 4 is the factory default setting.

Set Date and Time menu
Use

To

Current Date and Time

View the current date and time settings for the printer.

Manually Set Date and Time
[input date/time]

Enter the date and time.
Notes:

• Manually setting the date and time sets Enable NTP to No.
• The wizard lets you set the date and time in YYYY‑MM‑DD‑HH:MM format.
Time Zone
[list of time zones]

Select the time zone.

Automatically observe DST
On
Off

Set the printer to use the applicable daylight saving time (DST) start and end times
associated with the printer Time Zone setting.

Enable NTP
On
Off

Enable Network Time Protocol, which synchronizes the clocks of devices on a
network.

Note: GMT is the factory default settings.

Note: On is the factory default setting.

Notes:

• On is the factory default setting.
• This setting is turned off if you manually set the date and time.
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Settings menu
General Settings menu
Use

To

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Greek
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Set the language of the text appearing on the display.

Show Supply Estimates
Show estimates
Do not show estimates

View the estimates of the supplies on the control panel, Embedded
Web Server, menu settings, and device statistics reports.

Eco-Mode
Off
Energy
Energy/Paper
Paper

Minimize the use of energy, paper, or specialty media.

Note: Not all languages are available for all models. You may
need to install special hardware for some languages.

Note: Show estimates is the factory default setting.

Notes:

• Off is the factory default setting. This resets the printer to its
factory default settings.

• Energy minimizes the power used by the printer.
Performance may be affected, but print quality is not.

• Energy/Paper minimizes the use of power, paper, and
specialty media.

• Paper minimizes the amount of paper and specialty media
needed for a print job. Performance may be affected, but
print quality is not.
ADF Loaded Beep
Enabled
Disabled

Specify whether the ADF sounds a beep when paper is loaded.
Note: Enabled is the factory default setting.
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Quiet Mode
Off
On

Minimize the printer noise.

Run Initial setup
Yes
No

Run the setup wizard.

Paper Sizes
US
Metric

Specify the unit of measurement for paper sizes.

Note: Off is the factory default setting.

Notes:

• US is the factory default setting.
• The initial setting is determined by your country or region
selection in the initial setup wizard.

Scan to PC Port Range
[port range]

Specify a valid port range for printers behind a port blocking
firewall.
Note: 9751:12000 is the factory default setting.

Home screen customization
Change Language
Copy
Fax
Fax Shortcuts
E‑mail Shortcuts
FTP Shortcuts
Search Held Jobs
Held Jobs
Bookmarks
Jobs by User

Change the icons that appear on the home screen.

One Page Copy
Off
On

Set copies from the scanner glass to only one page at a time.

Allow Background Removal
On
Off

Specify whether image background removal is allowed.

Allow Custom Job Scans
On
Off

Scan multiple jobs to one file.

Scanner Jam Recovery
Job Level
Page Level

Specify how a scanned job should be reloaded if a paper jam occurs
in the ADF.

For each icon, select from the following options:
Display
Do not display

Note: Off is the factory default setting.

Note: On is the factory default setting.

Note: On is the factory default setting. If On is selected, then
Allow Custom Job Scans settings can be enabled for specific jobs.

Note: Job Level is the factory default setting.
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Alarms
Alarm Control
Cartridge Alarm

Set an alarm to sound when operator intervention is required.
For each alarm type, select from the following options:
Off
Single
Continuous
Notes:

• Single is the factory default setting for Alarm Control. This
sounds several short beeps.

• Off is the factory default setting for Cartridge Alarm.
• Continuous repeats several short beeps at a regular interval.
Timeouts
Sleep Mode
Disabled
1–120

Set the amount of time the printer waits after a job is printed before
it goes into a reduced power state.
Notes:

• 20 minutes is the factory default setting.
• Disabled appears only when Energy Conserve is set to Off.
• Lower settings conserve more energy, but may require
longer warm‑up times.

• Select a high setting if the printer is in constant use. Under
most circumstances, this keeps the printer ready to print.
Timeouts
Print with Display Off
Allow printing with display off
Display on when printing

Print a job while the display is off.

Timeouts
Hibernate Timeout
Disabled
20 minutes
1–3 hours
6 hours
1–3 days
1–2 weeks
1 month

Set the amount of time the printer waits before it enters Hibernate
mode.

Timeouts
Hibernate Timeout on Connection
Hibernate
Do Not Hibernate

Set the printer to hibernate mode when there is an active Ethernet
connection.

Timeouts
Screen Timeout
15–300

Set the amount of time before the display returns to a Ready state.

Note: Display on when printing is the factory default setting.

Note: 3 days is the factory default setting.

Note: Hibernate is the factory default setting.

Note: 30 seconds is the factory default setting.
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Timeouts
Print Timeout
Disabled
1–255

Set the amount of time the printer waits to receive an end‑of‑job
message before canceling the rest of the print job.
Notes:

• 90 seconds is the factory default setting.
• When the timer expires, any partially printed page is printed,
and then the printer checks to see if any new print jobs are
waiting.

• Print Timeout is available only when using PCL emulation.
Timeouts
Wait Timeout
Disabled
15–65535

Set the amount of time the printer waits for additional data before
canceling a print job.
Notes:

• 40 seconds is the factory default setting.
• Wait Timeout is available only when the printer is using
PostScript emulation.

Error Recovery
Auto Reboot
Reboot when idle
Reboot always
Reboot never

Automatically reboot the printer.

Error Recovery
Max Auto Reboots
1‑20

Determine the number of automatic reboots the printer can
perform.

Note: Reboot always is the factory default setting.

Notes:

• 2 is the factory default setting.
• If the printer reaches the maximum number of reboots
within a certain amount of time, the printer does not
continue to reboot, and the error message appears on the
display.
Print Recovery
Auto Continue
Disabled
5–255

Let the printer automatically continue printing from certain offline
situations when these are not resolved within the specified time
period.

Print Recovery
Jam Recovery
On
Off
Auto

Specify whether the printer reprints jammed pages.

Note: Disabled is the factory default setting.

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.
• Off sets the printer to never reprint jammed pages.
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Print Recovery
Jam Assist
On
Off

Set the printer to automatically check for jammed paper.

Print Recovery
Page Protect
Off
On

Successfully print a page that may not have printed otherwise.

Note: On is the factory default setting.

Notes:

• Off is the factory default setting. This prints a partial page
when there is not enough memory to print the whole page.

• On sets the printer to print the entire page.
Press Sleep Button
Do Nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a short
press of the Sleep button.

Press and Hold Sleep Button
Do Nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a long press
of the Sleep button.

Factory Defaults
Do Not Restore
Restore Now

Restore the printer factory default settings.

Note: Sleep is the factory default setting.

Note: Do Nothing is the factory default setting.

Notes:

• Do Not Restore is the factory default setting.
• Restore Now sets all printer settings to the factory default
settings except for the Network/Ports menu settings. All
downloads stored in the RAM are deleted.

Custom Home Message
Off
IP Address
Hostname
Contact Name
Location
Zero Configuration Name
Custom Text [x]

Create a custom home message that appears during warnings,
printer errors, and Home Prime/Status state.

Copy Settings menu
Use

To

Content Type
Text
Graphics
Text/Photo
Photo

Specify the content of the original document.
Note: Text/Photo is the factory default setting.
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Content Source
Black/White Laser
Color Laser
Inkjet
Photo/Film
Magazine
Newspaper
Press
Other

Specify how the original document was produced.

Sides (Duplex)
1 sided to 1 sided
1 sided to 2 sided
2 sided to 1 sided
2 sided to 2 sided

Specify whether an original document is two‑sided or one‑sided, and then specify
whether the copy should be two‑sided or one‑sided.

Note: Black/White Laser is the factory default setting.

Notes:

• The ADF scans only one side of the sheet.
• 1 sided to 1 sided is the factory default setting. This setting is selected when
using a one‑sided original document for a one‑sided copy job.

Paper Saver
Off
2‑up Portrait
2‑up Landscape
4‑up Portrait
4‑up Landscape

Copy two or four sheets of a document on one page.

Print Page Borders
On
Off

Specify whether a border is printed.

Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Stack the pages of a print job in sequence when printing multiple copies.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: (1,2,3) (1,2,3) is the factory default setting.
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Original Size
Letter
Legal
Executive
Folio
Statement
Oficio (Mexico)
Universal
Auto Size Sense
A4
A5
A6
JIS B5
Custom Scan Size [x]
Book Original
Business Card
3 x 5 in.
4 x 6 in.
ID Card

Specify the size of the original document.

Copy To Source
Tray [x]
Auto Size Match
MP Feeder

Specify the paper source for copy jobs.

Transparency Separators
On
Off

Place a sheet of paper between transparencies.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Place a sheet of paper between pages, copies, or jobs.

Separator Sheet Source
Tray [x]
MP Feeder

Specify the paper source for the separator sheet.

Darkness
1–9

Lighten or darken the output.

Number of Copies
1–999

Specify the number of copies for the copy job.

Note: Letter is the U.S. factory default setting. A4 is the international factory default
setting.

Note: Tray 1 is the factory default setting.

Note: On is the factory default setting.

Note: Off is the factory default setting.

Note: Tray 1 is the factory default setting.

Note: 5 is the factory default setting.
Note: 1 is the factory default setting.
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Overlay
Confidential
Copy
Draft
Urgent
Custom
Off

Specify the overlay text printed on each page of the copy job.

Custom Overlay

Specify the custom overlay text.

Allow priority copies
On
Off

Allow interruption of a print job to copy a page or document.

Background Removal
‑4 to 4

Adjust the amount of background visible on a copy.

Auto Center
Off
On

Automatically align the content at the center of the page.

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specify which color to drop and to adjust the dropout setting for each color threshold.

Contrast
0–5
Best for content

Specify the contrast of the output.

Mirror Image
Off
On

Create a mirror image of the original document.

Negative Image
Off
On

Create a negative image of the original document.

Shadow Detail
‑4 to 4

Adjust the amount of shadow detail visible on a copy.

Scan edge to edge
Off
On

Specify if the original document is scanned edge‑to‑edge.

Note: Off is the factory default setting.

Note: On is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.

Note: Best for content is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.
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Sharpness
1–5

Adjust the amount of sharpness of a copy.
Note: 3 is the factory default setting.

Fax Settings menu
Fax Mode (Analog Fax Setup) menu
Analog Fax Setup mode sends the fax job through a telephone line.

General Fax Settings
Use

To

Fax Name

Specify the name of the fax in the printer.

Fax Number

Specify the number assigned to the fax.

Fax ID
Fax Name
Fax Number

Specify how the fax is identified.

Enable Manual Fax
On
Off

Set the printer to fax manually, which requires a line splitter and a telephone handset.

Note: Fax Number is the factory default setting.

Notes:

• Off is the factory default setting.
• Use a regular telephone to answer an incoming fax job and to dial a fax
number.

• Press # 0 on the numeric keypad to go directly to the Manual Fax function.
Memory Use
All receive
Mostly receive
Equal
Mostly send
All send

Define the allocation of non-volatile memory between sending and receiving fax jobs.

Cancel Faxes
Allow
Don't Allow

Specify whether canceling of fax jobs is allowed.

Caller ID
Off
Primary
Alternate

Specify the type of caller ID being used.

Fax Number Masking
Off
From left
From right

Specify the direction from where digits are masked in an outgoing fax number.

Note: Equal is the factory default setting.

Note: Allow is the factory default setting.

Notes:

• Off is the factory default setting.
• The number of characters masked is determined by the Digits to Mask setting.
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Digits to Mask
0–58

Specify the number of digits to mask in an outgoing fax number.

Fax Cover Page
Fax Cover Page
Off by default
On by default
Never use
Always use
Include to Field
On
Off
Include from Field
On
Off
Include Message Field
On
Off
Include Logo
On
Off
Include Footer [x]
On
Off

Configure the fax cover page.

Note: 0 is the factory default setting.

Notes:

• Off by default is the factory default setting for Fax Cover Page.
• Off is the factory default setting for all other menu items.

Fax Send Settings
Use

To

Resolution
Standard
Fine 200 dpi
Super Fine 300 dpi
Ultra Fine 600 dpi

Specify quality in dots per inch (dpi). A higher resolution gives better print quality, but
increases the fax transmission time for outgoing faxes.
Note: Standard is the factory default setting.
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Original Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Folio
Statement
Oficio (Mexico)
Universal
Auto Size Sense
Mixed Sizes
Custom Scan Size [x]
Book Original
Business Card
3 x 5 in.
4 x 6 in.

Specify the size of the original document.

Content Type
Text
Text/Photo
Photo
Graphics

Specify the content of the original document.

Content Source
Black/White Laser
Color Laser
Inkjet
Photo/Film
Magazine
Newspaper
Press
Other

Specify how the original document was produced.

Darkness
1–9

Lighten or darken the output.

Dial Prefix

Enter a dialing prefix, such as 99. A numeric entry field is provided.

Automatic Redial
0–9

Specify the number of times the printer tries to send the fax to a specified number.

Redial Frequency
1–200

Specify the number of minutes between redials.

Note: Mixed Sizes is the U.S. factory default setting. A4 is the international factory
default setting.

Note: Text is the factory default setting.

Note: Black/White Laser is the factory default setting.

Note: 5 is the factory default setting.

Note: 5 is the factory default setting.
Note: 3 is the factory default setting.

Understanding the printer menus

122

Use

To

Behind a PABX
Yes
No

Enable or disable switchboard blind dialing without a dial tone.

Enable ECM
Yes
No

Enable or disable Error Correction Mode for fax jobs.

Enable Fax Scans
On
Off

Fax files that are scanned at the printer.

Driver to Fax
Yes
No

Allow the print driver to send fax jobs.

Allow Save as Shortcut
On
Off

Save fax numbers as shortcuts in the printer.

Dial Mode
Tone
Pulse

Specify the dialing sound.

Max Speed
2400
4800
9600
14400
33600

Specify the maximum speed in baud at which faxes are sent.

Background Removal
‑4 to 4

Adjust the amount of background visible on a scanned image.

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specify which color to drop and to adjust the dropout setting for each color threshold.

Contrast
0–5
Best for content

Specify the contrast in the scanned image.

Note: No is the factory default setting.

Note: Yes is the factory default setting.

Note: On is the factory default setting.

Note: Yes is the factory default setting.

Note: On is the factory default setting.

Note: Tone is the factory default setting.

Note: 33600 is the factory default setting.

Note: 0 is the factory default setting.

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.

Note: Best for content is the factory default setting.
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Mirror Image
Off
On

Create a mirror image of the original document.

Negative Image
Off
On

Create a negative image of the original document.

Shadow Detail
‑4 to 4

Adjust the amount of shadow detail visible.

Scan Edge to Edge
Off
On

Specify whether the original document is scanned edge‑to‑edge.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Sharpness
1–5

Adjust the sharpness of a fax.

Enable Color Fax Scans
Off by default
On by default
Never Use
Always Use

Enable color faxing.

Note: 3 is the factory default setting.
Note: Off by default is the factory default setting.

Auto Convert Color Faxes to Mono Convert all outgoing faxes to black and white.
Faxes
Note: On is the factory default setting.
On
Off

Fax Receive Settings
Use

To

Enable Fax Receive
On
Off

Allow the printer to receive fax jobs.

Enable Caller ID
On
Off

Allow the printer to show caller ID.

Rings to Answer
1–25

Specify the number of rings before answering an incoming fax job.

Auto Answer
Yes
No

Set the printer to receive faxes automatically.

Manual Answer Code
0–9

Enter a code on the telephone number pad to begin receiving a fax.

Note: On is the factory default setting.

Note: On is the factory default setting.

Note: 3 is the factory default setting.
Note: Yes is the factory default setting.

Notes:

• *9* is the factory default setting.
• This menu item is used when the printer shares a line with a telephone.
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Auto Reduction
On
Off

Scale an incoming fax job so that it fits the size of the paper loaded in the designated
fax source.

Paper Source
Auto
Tray [x]
MP Feeder

Specify the paper source for printing incoming fax jobs.

Separator Sheets
Off
Before Job
After Job

Enable the printer to include separator sheets for incoming fax jobs.

Separator Sheet Source
Tray [x]
MP Feeder

Specify the paper source for the separator sheet.

Fax Footer
On
Off

Print the transmission information at the bottom of each page from a received fax.

Max Speed
2400
4800
9600
14400
33600

Specify the maximum speed in baud at which faxes are received.

Fax Forwarding
Print
Print and Forward
Forward

Enable forwarding of received faxes to another recipient.

Forward to
Fax
E‑mail
FTP
LDSS

Specify the type of recipient to which faxes are forwarded.

Forward to Shortcut

Enter the shortcut number that matches the recipient type (Fax, E-mail, FTP, or LDSS).

Block No Name Fax
Off
On

Enable blocking of incoming faxes sent from devices with no fax ID specified.

Enable Color Fax Receive
On
Off

Enable the printer to receive fax in color and print it in grayscale.

Note: On is the factory default setting.
Note: Auto is the factory default setting.

Note: Off is the factory default setting.

Note: Tray 1 is the factory default setting.

Note: Off is the factory default setting.

Note: 33600 is the factory default setting.

Note: Print is the factory default setting.

Notes:

• Fax is the factory default setting.
• This menu is available only from the printer Embedded Web Server.

Note: Off is the factory default setting.

Note: On is the factory default setting.
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Transmission Log
Print log
Do not print log
Print only for error

Enable printing of a transmission log after each fax job.

Receive Error Log
Print Never
Print on Error

Enable printing of a received error log following a receive error.

Auto Print Logs
On
Off

Enable automatic printing of fax logs.

Log Paper Source
Tray [x]
MP Feeder

Specify the source of the paper used for printing logs.

Logs Display
Remote Station Name
Dialed Number

Specify whether printed logs display the dialed number or fax name returned.

Enable Job Log
On
Off

Enable access to the Fax Job log.

Enable Call Log
On
Off

Enable access to the Fax Call log.

Note: Print log is the factory default setting.

Note: Print Never is the factory default setting.

Notes:

• On is the factory default setting.
• Logs print after every 200 fax jobs.
Note: Tray 1 is the factory default setting.

Note: Remote Station Name is the factory default setting.

Note: On is the factory default setting.

Note: On is the factory default setting.

Speaker Settings
Use

To

Speaker Mode
Always Off
On until Connected
Always On

Specify the mode of the speaker.

Speaker Volume
High
Low

Set the speaker volume to high or low.

Ringer Volume
Off
On

Enable or disable the ringer volume.

Note: On until Connected is the factory default setting. A sound is issued until the
fax connection is made.

Note: High is the factory default setting.

Note: On is the factory default setting.
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Answer On
Use
All Rings
Single Ring Only
Double Ring Only
Triple Ring Only
Single or Double Rings Only
Single or Triple Rings Only
Double or Triple Rings Only

To
Specify ring patterns when the printer is answering calls.
Note: All Rings is the factory default setting.

E‑mail Settings menu
Use

To

E‑mail Server Setup
Send me a copy
Never appears
On by default
Off by default
Always On

Send a copy of the e-mail to the sender.

E‑mail Server Setup
Max E‑mail size
0–65535 KB

Specify the maximum e-mail size.

Format
PDF (.pdf)
TIFF (.tif)
JPEG (.jpg)
XPS (.xps)
RTF (.rtf)
TXT (.txt)

Specify the format of the scanned file.

PDF Settings
PDF Version
1.2–1.7
A–1a
Secure PDF
Off
On
Searchable PDF
Off
On

Configure the PDF settings.

Content Type
Text
Graphics
Text/Photo
Photo

Specify the content of the original document.

Note: Never appears is the factory default setting.

Note: E-mails larger than the specified size are not sent.

Note: PDF (.pdf) is the factory default setting.

Notes:

• 1.5 is the factory default setting for PDF Version.
• Off is the factory default setting for Secure PDF and Searchable PDF. Secure
PDF requires you to enter your password twice.

Note: Text/Photo is the factory default setting.
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Content Source
Black/White Laser
Color Laser
Inkjet
Photo/Film
Magazine
Newspaper
Press
Other

Specify how the original document was produced.

Color
Off
On

Specify whether the printer captures and transmits content in color.

Resolution
75 dpi
150 dpi
200 dpi
300 dpi
400 dpi
600 dpi

Specify the resolution of the scan in dots per inch.

Darkness
1–9

Lighten or darken the output.

Orientation
Portrait
Landscape

Specify the orientation of the scanned image.

Original Size
Letter
Legal
Executive
Folio
Statement
Oficio (Mexico)
Universal
Auto Size Sense
Mixed Sizes
A4
A5
A6
JIS B5
Custom Scan Size [x]
Book Original
Business Card
3 x 5 in.
4 x 6 in.

Specify the size of the document being scanned.

Note: Black/White Laser is the factory default setting.

Note: On is the factory default setting.

Note: 150 dpi is the factory default setting.

Note: 5 is the factory default setting.
Note: Portrait is the factory default setting.

Note: Letter is the U.S. factory default setting. A4 is the international factory
default setting.
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JPEG Quality
Best for content
5–90

Set the quality of a JPEG photo image in relation to file size and quality of the image.

Text Default
5–90

Set the quality of a text image in relation to file size and quality of the image.

Text/Photo Default
5–90

Set the quality of a text or photo image in relation to file size and the quality of the
image.

Notes:

• Best for content is the factory default setting.
• 5 reduces the file size and quality of the image.
• 90 provides the best image quality, but the file size is very large.
Note: 75 is the factory default setting.

Note: 75 is the factory default setting.
Photo Default
5–90

Set the quality of a photo image in relation to file size and the quality of the image.

E‑mail images sent as
Attachment
Web Link

Specify how the images are sent.

Use Multi‑page Tiff
On
Off

Provide a choice between single-page TIFF files and multiple‑page TIFF files. For a
multiple-page scan‑to‑e-mail job, either one TIFF file is created containing all the
pages, or multiple TIFF files are created with one file for each page of the job.

Note: 50 is the factory default setting.
Note: Attachment is the factory default setting.

Note: On is the factory default setting.
Transmission Log
Print log
Do not print log
Print only for error

Enable printing of a transmission log after each e‑mail job.
Note: Print log is the factory default setting.

Log Paper Source
Tray [x]
MP Feeder

Specify the paper source for printing e-mail logs.

E‑mail Bit Depth
1 bit
8 bit

Enable the Text/Photo mode to produce smaller file sizes by using 1-bit images when
Color is set to Off.

Allow Save as Shortcut
On
Off

Save e-mail addresses as shortcuts.

Note: Tray 1 is the factory default setting.

Note: 8 bit is the factory default setting.

Notes:

• On is the factory default setting.
• When set to Off, the Save as Shortcut button does not appear on the e-mail
destination screen.

Background Removal
‑4 to 4

Adjust the amount of background visible on a scanned image.
Note: 0 is the factory default setting.

Understanding the printer menus

129

Use

To

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specify which color to drop and to adjust the dropout setting for each color threshold.

Contrast
0–5
Best for content

Specify the contrast of the output.

Mirror Image
Off
On

Create a mirror image of the original document.

Negative Image
Off
On

Create a negative image of the original document.

Shadow Detail
‑4 to 4

Adjust the amount of shadow detail visible on a scanned image.

Scan edge to edge
Off
On

Specify whether the original document is scanned edge-to-edge.

Sharpness
1–5

Adjust the amount of sharpness on a scanned image.

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.

Note: Best for content is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Note: 3 is the factory default setting.

FTP Settings menu
Use

To

Format
PDF (.pdf)
TIFF (.tif)
JPEG (.jpg)
XPS (.xps)
RTF (.rtf)
TXT (.txt)

Specify the file format.
Note: PDF (.pdf) is the factory default setting.
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PDF Settings
PDF Version
1.2–1.7
A–1a
Secure PDF
Off
On
Searchable PDF
Off
On

Configure the PDF settings.

Content Type
Text
Graphics
Text/Photo
Photo

Specify the content of the original document.

Content Source
Black/White Laser
Color Laser
Inkjet
Photo/Film
Magazine
Newspaper
Press
Other

Specify how the original document was produced.

Color
Off
On

Specify whether the printer captures and transmits content in color.

Resolution
75 dpi
150 dpi
200 dpi
300 dpi
400 dpi
600 dpi

Specify the quality of the scan in dots per inch (dpi).

Darkness
1–9

Lighten or darken the output.

Orientation
Portrait
Landscape

Specify the orientation of the scanned image.

Notes:

• 1.5 is the factory default setting for PDF Version.
• Off is the factory default setting for Secure PDF and Searchable PDF. Secure
PDF requires you to enter your password twice.

Note: Text/Photo is the factory default setting.

Note: Black/White Laser is the factory default setting.

Note: On is the factory default setting.

Note: 150 dpi is the factory default setting.

Note: 5 is the factory default setting.
Note: Portrait is the factory default setting.
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Original Size
Letter
Legal
Executive
Folio
Statement
Oficio (Mexico)
Universal
Auto Size Sense
Mixed Sizes
A4
A5
A6
JIS B5
Custom Scan Size [x]
Book Original
Business Card
3 x 5 in.
4 x 6 in.

Specify the size of the original document.

JPEG Quality
Best for content
5–90

Set the quality of a JPEG photo image in relation to the file size and quality of the
image.

Note: Letter is the U.S. factory default setting. A4 is the international factory
default setting.

Notes:

• Best for content is the factory default setting.
• 5 reduces the image quality and the file size.
• 90 produces the best image quality, but the file size is very large.
Text Default
5–90

Set the quality of the text in relation to the file size and quality of the image.

Text/Photo Default
5–90

Set the quality of a text or photo image in relation to the file size and quality of the
image.

Note: 75 is the factory default setting.

Note: 75 is the factory default setting.
Photo Default
5–90

Set the quality of a photo image in relation to the file size and quality of the image.

Use Multi‑Page TIFF
On
Off

Provide a choice between single-page TIFF files and multiple‑page TIFF files. For a
multiple-page scan‑to‑FTP job, either one TIFF file is created containing all the pages,
or multiple TIFF files are created with one file for each page of the job.

Note: 50 is the factory default setting.

Note: On is the factory default setting.
Transmission Log
Print log
Do not print log
Print only for error

Specify whether to print the transmission log.
Note: Print log is the factory default setting.
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Log Paper Source
Tray [x]
MP Feeder

Specify a paper source when printing FTP logs.

FTP Bit Depth
1 bit
8 bit

Enable the Text/Photo mode to have smaller file sizes by using 1‑bit images.

Allow Save as Shortcut
On
Off

Enable shortcut creation for FTP addresses.

Background Removal
‑4 to 4

Adjust the amount of background visible on a copy.

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specify which color to drop and to adjust the dropout setting for each color threshold.

Contrast
0–5
Best for content

Specify the contrast of the output.

Mirror Image
Off
On

Create a mirror image of the original document.

Negative Image
Off
On

Create a negative image of the original document.

Shadow Detail
‑4 to 4

Adjust the amount of shadow detail visible on a scanned image.

Scan edge to edge
Off
On

Specify whether the original document is scanned edge-to-edge.

Sharpness
1–5

Adjust the amount of sharpness of the scanned image.

Note: Tray 1 is the factory default setting.

Note: 8 bit is the factory default setting.

Note: On is the factory default setting.

Note: 0 is the factory default setting.

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.

Note: Best for content is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Note: 3 is the factory default setting.
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Print Settings
Setup menu
Use

To

Printer Language
PCL Emulation
PS Emulation
PPDS Emulation

Set the default printer language.
Notes:

• PCL Emulation is the factory default setting.
• This does not prevent a software program from sending print
jobs that use another printer language.

Print Area
Normal
Whole Page

Set the logical and physical printable area.

Resource Save
On
Off

Specify how the printer handles temporary downloads, such as
fonts and macros stored in the RAM, when the printer receives a
job that requires more memory than what is available.

Note: Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the Normal
setting, the printer clips the image at the boundary.

Notes:

• Off is the factory default setting. This sets the printer to
retain the downloads only until memory is needed.
Downloads are deleted in order to process print jobs.

• On retains the downloads during language changes and
printer resets. If the printer runs out of memory, then
Memory Full [38] appears and downloads are not
deleted.
Print All Order
Alphabetical
Oldest First
Newest First

Specify the order in which confidential and held jobs are printed
when Print All is selected.
Note: Alphabetical is the factory default setting.

Finishing menu
Use

To

Sides (Duplex)
1 sided
2 sided

Specify whether two‑sided (duplex) printing is set as the user default setting for all
print jobs.
Notes:

• “1 sided” is the factory default setting.
• You can set two‑sided printing from the software program.
For Windows users:
Click File > Print, and then click Properties, Preferences, Options, or Setup.
For Macintosh users:
Choose File > Print, and then adjust the settings from the print dialog and
pop‑up menus.
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Duplex Binding
Long Edge
Short Edge

Define the way two‑sided pages are bound and printed.
Notes:

• Long Edge is the factory default setting. This assumes binding along the long
edge of the page (left edge for portrait and top edge for landscape).

• Short Edge assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).
Copies
1–999

Specify the default number of copies for each print job.

Blank Pages
Do Not Print
Print

Specify whether or not blank pages are inserted in a print job.

Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Stack the pages of a print job in sequence when printing multiple copies.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether or not blank separator sheets are inserted.

Note: 1 is the factory default setting.
Note: Do Not Print is the factory default setting.

Note: “(1,2,3) (1,2,3)” is the factory default setting.

Notes:

• Off is the factory default setting.
• Between Copies inserts a blank sheet between each copy of a print job if
Collate is set to “(1,2,3) (1,2,3).” If Collate is set to “(1,1,1) (2,2,2),” then a
blank page is inserted between each set of printed pages, such as after all
page 1's and after all page 2's.

• Between Jobs inserts a blank sheet between print jobs.
• Between Pages inserts a blank sheet between each page of a print job. This
setting is useful when printing transparencies or when inserting blank pages in
a document.
Separator Source
Tray [x]
MP Feeder

Specify the paper source for separator sheet.
Notes:

• Tray 1 (standard tray) is the factory default setting.
• From the Paper menu, set Configure MP to “Cassette” for MP Feeder to
appear as a menu setting.

Paper Saver
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Print multiple pages on one sheet of paper.
Notes:

• Off is the factory default setting.
• When the number of pages per sheet is selected, each page is scaled so that
the number of pages you want can be displayed on the sheet.
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Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the order in which pages are printed on a single sheet when using Paper Saver.

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation in which pages are printed on a single sheet.

Paper Saver Border
None
Solid

Print a border when using Paper Saver.

Notes:

• Horizontal is the factory default setting.
• Positioning depends on the number of pages and whether they are in portrait
or landscape orientation.
Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.

Note: None is the factory default setting.

Quality menu
Use

To

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 Image Q
2400 Image Q

Specify the printed output resolution in dots per inch.

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both directions
Isolated

Enable more pixels to print in clusters for clarity, in order to enhance images horizontally
or vertically, or to enhance fonts.

Toner Darkness
1–10

Lighten or darken the printed output.

Note: 600 dpi is the factory default setting.

Note: Off is the factory default setting.

Notes:

• 8 is the factory default setting.
• Selecting a smaller number can help conserve toner.
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Enhance Fine Lines
On
Off

Enable a print mode preferable for files such as architectural drawings, maps, electrical
circuit diagrams, and flow charts.
Notes:

• Off is the factory default setting.
• You can set this option from the printer software. For Windows users, click File >
Print, and then click Properties, Preferences, Options, or Setup. For Macintosh
users, choose File > Print, and then adjust the settings from the Print dialog and
pop‑up menus.

• To set this option using the Embedded Web Server, type the network printer IP
address in the Web browser address field.
Gray Correction
Auto
Off

Automatically adjust the contrast enhancement applied to images.

Brightness
‑6 to 6

Adjust the printed output either by lightening or darkening it. You can conserve toner
by lightening the output.

Note: Auto is the factory default setting.

Note: 0 is the factory default setting.
Contrast
0–5

Adjust the contrast of printed objects.
Note: 0 is the factory default setting.

Utilities menu
Use

To

Format Flash
Yes
No

Format the flash memory.
Warning—Potential Damage: Do not turn off the printer while the flash memory is
being formatted.
Notes:

• Yes deletes all data stored in flash memory.
• No cancels the format request.
• Flash memory refers to the memory added by installing a flash memory card in
the printer.

• The flash memory option card must not be read/write‑ or write‑protected.
• This menu item appears only when a non‑defective flash memory card is
installed.
Activate Hex Trace

Assist in isolating the source of a print job problem.
Notes:

• When activated, all data sent to the printer is printed in hexadecimal and
character representation, and control codes are not executed.

• To exit or deactivate Hex Trace, turn off or reset the printer.
Coverage Estimator
Off
On

Provide an estimate of the percentage coverage of toner on a page. The estimate is
printed on a separate page at the end of each print job.
Note: Off is the factory default setting.
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XPS menu
Use

To

Print Error Pages
Off
On

Print a page containing information on errors, including XML markup errors.
Note: Off is the factory default setting.

PDF menu
Use

To

Scale to Fit
Yes
No

Scale page content to fit the selected paper size.

Annotations
Do Not Print
Print

Print annotations in a PDF.

Note: No is the factory default setting.

Note: Do Not Print is the factory default setting.

PostScript menu
Use

To

Print PS Error
On
Off

Print a page containing the PostScript error.

Lock PS Startup Mode
On
Off

Enable the SysStart file.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

PCL Emul menu
Use

To

Font Source
Resident
Download
All

Specify the set of fonts used in the Font Name menu.
Notes:

• “Resident” is the factory default setting. It shows the factory default set
of fonts downloaded in the RAM.

• “Download” shows all the fonts downloaded in the RAM.
• “All” shows all fonts available to any option.
Font Name
Courier 10

Identify a specific font and where it is stored.
Note: Courier 10 is the factory default setting.
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Symbol Set
10U PC‑8
12U PC‑850

Specify the symbol set for each font name.
Notes:

• 10U PC‑8 is the U.S. factory default setting. 12U PC‑850 is the
international factory default setting.

• A symbol set is a set of alphabetical and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages or
specific programs, such as math symbols for scientific text. Only the
supported symbol sets are shown.
PCL Emulation Settings
Point Size
1.00–1008.00

Change the point size for scalable typographic fonts.
Notes:

• 12 is the factory default setting.
• Point size refers to the height of the characters in the font. One point
equals approximately 0.014 of an inch. This can be increased or decreased
in 0.25‑point increments.

PCL Emulation Settings
Pitch
0.08–100.00

Specify the font pitch for scalable monospaced fonts.
Notes:

• 10 is the factory default setting.
• Pitch refers to the number of fixed‑space characters per inch (cpi). This
can be increased or decreased in 0.01‑cpi increments.

• For non‑scalable monospaced fonts, the pitch appears on the display but
cannot be changed.
PCL Emulation Settings
Orientation
Portrait
Landscape

Specify the orientation of text and graphics on a page.
Notes:

• Portrait is the factory default setting. It prints text and graphics parallel to
the short edge of the page.

• Landscape prints text and graphics parallel to the long edge of the page.
PCL Emulation Settings
Lines per Page
1–255

Specify the number of lines that print on each page.
Notes:

• 60 is the U.S. factory default setting. 64 is the international default
setting.

• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the paper size
and orientation before setting Lines per Page.
PCL Emulation Settings
A4 Width
198 mm
203 mm

Set the printer to print on A4‑size paper.
Notes:

• 198 mm is the factory default setting.
• The 203‑mm setting sets the width of the page to allow the printing of
eighty 10‑pitch characters.
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PCL Emulation Settings
Auto CR after LF
On
Off

Specify whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command.

PCL Emulation Settings
Auto LF after CR
On
Off

Specify whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command.

Tray Renumber
Assign Multipurpose Feeder
Off
None
0–199
Assign Tray [x]
Off
None
0–199
Assign Manual Paper
Off
None
0–199
Assign Manual Envelope
Off
None
0–199

Configure the printer to work with printer software or programs that use
different source assignments for trays and feeders.

Tray Renumber
View Factory Defaults
MPF Default = 8
T1 Default = 1
T2 Default = 4
T3 Default = 5
T4 Default = 20
T5 Default = 21
Env Default = 6
MPaper Default = 2
MEnv Default = 3

Show the factory default setting assigned to each tray or feeder.

Tray Renumber
Restore Defaults
Yes
No

Restore all tray and feeder assignments to the factory default settings.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Notes:

• “Off” is the factory default setting.
• “None” ignores the Select Paper Feed command. This option appears only
when it is selected by the PCL 5e interpreter.

• “0–199” allows a custom setting to be assigned.
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PPDS menu
Menu item

Description

Orientation
Portrait
Landscape

Sets the orientation of the text and graphics on the page

Lines per Page
1–255

Sets the number of lines that print on each page

Notes:

• Portrait is the factory default setting.
• Settings are duplicated in the PCL Emulation menu.
Notes:

• 64 is the factory default setting.
• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the desired
Paper Size and Orientation before setting Lines per Page.
Lines per Inch
0.25–30.00

Sets the number of lines that print per inch
Notes:

• 6 is the factory default setting.
• Lines per Inch can be increased or decreased in 0.25‑inch increments
Page Format
Print
Whole

Sets the logical and physical printable area of the page
Notes:

• Print is the factory default setting. Print data maintains its position with
respect to edge of the paper.

• When Whole is selected, document margins are calculated from the top
left corner of the physical edge of the page.

• Printing does not occur outside the printable area.
Character Set
1
2

Specifies a default character set for PPDS print jobs
Notes:

• 2 is the factory default setting. Character Set 2 is composed of printable
characters and symbols used in non‑US English languages.

• When Characters Set 1 is selected, values given to the printer are
interpreted as printer commands.
Best Fit
On
Off

Replaces a missing font with a similar font

Tray 1 Renumber
Off
Tray 2

Configures the printer to work with printer software or programs that use
different source assignments for trays, drawers, and feeders

Note: On is the factory default setting. If the requested font is not found, the
printer will use a similar font.

Notes:

• Off is the factory default setting.
• Tray 2 is displayed only when it is installed.
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Menu item

Description

Auto CR after LF
On
Off

Specifies whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command
Notes:

• Off is the factory default setting.
• Settings are duplicated in the PCL Emulation menu.
Auto LF after CR
On
Off

Specifies whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command
Notes:

• Off is the factory default setting.
• Settings are duplicated in the PCL Emulation menu.

HTML menu
Use
Font Name
Albertus MT
Antique Olive
Apple Chancery
Arial MT
Avant Garde
Bodoni
Bookman
Chicago
Clarendon
Cooper Black
Copperplate
Coronet
Courier
Eurostile
Garamond
Geneva
Gill Sans
Goudy
Helvetica
Hoefler Text
Intl CG Times
Intl Courier
Intl Univers

To
Joanna MT
Letter Gothic
Lubalin Graph
Marigold
MonaLisa Recut
Monaco
New CenturySbk
New York
Optima
Oxford
Palatino
StempelGaramond
Taffy
Times
TimesNewRoman
Univers
Zapf Chancery
NewSansMTCS
NewSansMTCT
New SansMTJA
NewSansMTKO

Set the default font for HTML documents.
Note: The Times font is used in HTML documents that do not
specify a font.
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Font Size
1–255 pt

Set the default font size for HTML documents.
Notes:

• 12 pt is the factory default setting.
• Font size can be increased in 1‑point increments.
Scale
1–400%

Scale the default font for HTML documents.
Notes:

• 100% is the factory default setting.
• Scaling can be increased in 1% increments.
Orientation
Portrait
Landscape

Set the page orientation for HTML documents.

Margin Size
8–255 mm

Set the page margin for HTML documents.

Note: Portrait is the factory default setting.

Notes:

• 19 mm is the factory default setting.
• Margin size can be increased in 1‑mm increments.
Backgrounds
Do Not Print
Print

Specify whether to print backgrounds on HTML documents.
Note: Print is the factory default setting.

Image menu
Use

To

Auto Fit
On
Off

Select the optimal paper size, scaling, and orientation.

Invert
On
Off

Invert bitonal monochrome images.

Scaling
Anchor Top Left
Best Fit
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scale the image to fit the selected paper size.

Note: On is the factory default setting. It overrides scaling and orientation settings
for some images.

Notes:

• Off is the factory default setting.
• This setting does not apply to GIF or JPEG images.
Notes:

• Best Fit is the factory default setting.
• When Auto Fit is set to On, Scaling is automatically set to Best Fit.
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Orientation
Portrait
Landscape
Reverse Portrait
Reverse Landscape

Set the image orientation.
Note: Portrait is the factory default setting.

Help menu
Menu item

Description

Print All Guides

Prints all the guides

Copy Guide

Provides information about making copies and configuring the settings

E‑mail Guide

Provides information about sending e‑mails and configuring the settings

Fax Guide

Provides information about sending faxes and configuring the settings

FTP Guide

Provides information about scanning documents and configuring the settings

Print Defects Guide

Provides a template for determining the cause of repeating print quality defects,
and lists settings that can be used to adjust print quality

Information Guide

Provides help in locating additional information

Supplies Guide

Provides information about ordering supplies
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Saving money and the environment
Lexmark is committed to environmental sustainability and is continually improving its printers to reduce their impact
on the environment. We design with the environment in mind, engineer our packaging to reduce materials, and provide
collection and recycling programs. For more information, see:

• The Notices chapter
• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
• The Lexmark recycling program at www.lexmark.com/recycle
By selecting certain printer settings or tasks, you may be able to reduce your printer's impact even further. This chapter
outlines the settings and tasks that may yield a greater environmental benefit.

Saving paper and toner
Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can significantly
reduce your carbon footprint by using recycled paper and the following printing suggestions, such as printing on both
sides of the paper and printing multiple pages on one side of a single sheet of paper.
For information on how you can quickly save paper and energy using one printer setting, see “Using Eco‑Mode” on
page 145.

Using recycled paper
As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser printers. For more information on recycled papers that work well with your printer, see “Using recycled
paper and other office papers” on page 45.

Conserving supplies
Use both sides of the paper
If your printer model supports two‑sided printing, then you can control whether print appears on one or two sides of
the paper.
Notes:

• Two-sided printing is the default setting in the print driver.
• For a complete list of supported products and countries, go to http://support.lexmark.com.

Place multiple pages on one sheet of paper
You can print up to 16 consecutive pages of a multiple‑page document onto one side of a single sheet of paper by
setting multiple page printing (N‑Up) for the print job.
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Check your first draft for accuracy
Before printing or making multiple copies of a document:

• Use the preview feature to see how the document looks like before you print it.
• Print one copy of the document to check its content and format for accuracy.

Avoid paper jams
Correctly set the paper type and size to avoid paper jams. For more information, see “Avoiding jams” on page 165.

Saving energy
Using Eco‑Mode
Use Eco‑Mode to quickly select one or more ways to reduce your printer's environmental impact.

1 From the printer control panel, navigate to:
> Settings >

> Settings >

> General Settings >

> Eco‑Mode >

> select the setting you want

Use

To

Off

Use the factory default settings for all settings associated with Eco‑Mode. This setting supports the
performance specifications for your printer.

Energy

Reduce energy use, especially when the printer is idle.
Notes:

• Printer engine motors do not start until a job is ready to print. You may notice a short delay
before the first page is printed.

• The printer enters Sleep mode after one minute of inactivity.
Energy/Paper Use all the settings associated with Energy and Paper modes.
Plain Paper

2 Press

• Enable automatic two‑sided (duplex) printing.
• Turn off print log features.

.

Reducing printer noise
Enable Quiet mode to reduce the printer noise.

1 From the printer control panel, navigate to:
> Settings >

2 Select a setting.

> Settings >

> General Settings >

> Quiet Mode >
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On

Reduce printer noise.
Notes:

• Print jobs process at a reduced speed.
• Printer engine motors do not start until a document
is ready to print. There is a short delay before the
first page is printed.

• The alarm control and cartridge alarm sounds are
turned off.

• The printer ignores the Advance Start command.
Off

Use factory default settings.
Note: This setting supports the performance
specifications of the printer.

3 Press

.

Adjusting Sleep mode
1 From the control panel, navigate to:
> Settings >

> Settings >

> General Settings >

> Timeouts >

> Sleep Mode >

2 In the Sleep Mode field, select the number of minutes the printer is idle before it enters Sleep mode.
3 Apply the changes.

Using Hibernate mode
Hibernate is an ultra‑low‑power saving mode.
Notes:

• Three days is the default amount of time before the printer enters Hibernate mode.
• Make sure to wake the printer from Hibernate mode before sending a print job. A hard reset or a long press of
the Sleep button wakes the printer from Hibernate mode.

• If the printer is in Hibernate mode, then the Embedded Web Server is disabled.
1 From the control panel, navigate to:
> Settings >

> Settings >

> General Settings >

2 Select Press Sleep Button or Press and Hold Sleep Button, and then press
3 Press Hibernate >

.

.
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Adjusting the brightness of the printer display
To save energy, or if you have trouble reading the display, adjust its brightness settings.

Using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > General Settings.
3 In the Screen Brightness field, enter the brightness percentage you want for the display.
4 Click Submit.

Using Schedule Power Modes
Schedule Power Modes lets the user schedule when the printer goes into a reduced power state or into the Ready
state.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > General Settings > Schedule Power Modes.
3 From the Action menu, select the power mode.
4 From the Time menu, select the time.
5 From the Day(s) menu, select the day or days.
6 Click Add.

Recycling
Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information,
see:

• The Notices chapter
• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
• The Lexmark recycling program at www.lexmark.com/recycle
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Recycling Lexmark products
To return Lexmark products for recycling:

1 Go to www.lexmark.com/recycle.
2 Find the product type you want to recycle, and then select your country or region from the list.
3 Follow the instructions on the computer screen.
Note: Printer supplies and hardware not listed in the Lexmark collection program may be recycled through your local
recycling center. Contact your local recycling center to determine the items they accept.

Recycling Lexmark packaging
Lexmark continually strives to minimize packaging. Less packaging helps to ensure that Lexmark printers are transported
in the most efficient and environmentally sensitive manner and that there is less packaging to dispose of. These
efficiencies result in fewer greenhouse emissions, energy savings, and natural resource savings.
Lexmark cartons are 100% recyclable where corrugated recycling facilities exist. Facilities may not exist in your area.
The foam used in Lexmark packaging is recyclable where foam recycling facilities exist. Facilities may not exist in your
area.
When you return a cartridge to Lexmark, you can reuse the box that the cartridge came in. Lexmark will recycle the
box.

Returning Lexmark cartridges for reuse or recycling
Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it both
easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred percent
of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used to return
the cartridges are also recycled.
To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and
use the prepaid shipping label. You can also do the following:

1 Go to www.lexmark.com/recycle.
2 From the Toner Cartridges section, select your country or region.
3 Follow the instructions on the computer screen.
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Securing the printer
Statement of Volatility
Your printer contains various types of memory that can store device and network settings, and user data.
Type of memory

Description

Volatile memory

Your printer uses standard random access memory (RAM) to
temporarily buffer user data during simple print jobs.

Non-volatile memory

Your printer may use two forms of non-volatile memory:
EEPROM and NAND (flash memory). Both types are used to
store operating system, device settings, and network
information.

Erase the content of any installed printer memory in the following circumstances:

•
•
•
•
•

The printer is being decommissioned.
The printer is being moved to a different department or location.
The printer is being serviced by someone from outside your organization.
The printer is being removed from your premises for service.
The printer is being sold to another organization.

Erasing volatile memory
The volatile memory (RAM) installed in your printer requires a power source to retain information. To erase the buffered
data, simply turn off the printer.

Erasing non‑volatile memory
• Individual settings, device and network settings, security settings, and embedded solutions—Erase information
and settings by selecting Wipe All Settings in the Configuration menu.

• Fax data—Erase fax settings and data by selecting Wipe All Settings in the Configuration menu.
1 Turn off the printer.
2 Hold down 2 and 6 while turning the printer on. Release the buttons only when the screen with the progress bar
appears.
The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is fully
powered up, the printer displays a list of functions.

3 Press the up or down arrow button until Wipe All Settings appears.
The printer will restart several times during this process.
Note: Wipe All Settings securely removes device settings, solutions, jobs, faxes, and passwords from the printer
memory.

4 Navigate to:
Back > Exit Config Menu
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The printer will perform a power‑on reset, and then return to normal operating mode.

Finding printer security information
In high-security environments, it may be necessary to take additional steps to make sure that confidential data stored
in the printer cannot be accessed by unauthorized persons. For more information, visit the
Lexmark security Web page.
You can also see the Embedded Web Server — Security: Administrator’s Guide for additional information:

1 Go to www.lexmark.com, and then navigate to Support & Downloads > select your printer.
2 Click the Manuals tab, and then select Embedded Web Server — Security: Administrator’s Guide.
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Cleaning printer parts
Cleaning the printer
Note: You may need to perform this task after every few months.
Warning—Potential Damage: Damage to the printer caused by improper handling is not covered by the printer
warranty.

1 Make sure that the printer is turned off and unplugged from the electrical outlet.
CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before
proceeding.

2 Remove paper from the standard bin and multipurpose feeder.
3 Remove any dust, lint, and pieces of paper around the printer using a soft brush or vacuum.
4 Dampen a clean, lint-free cloth with water, and use it to wipe the outside of the printer.
Warning—Potential Damage: Do not use household cleaners or detergents to prevent damage to the exterior
of the printer.

5 Make sure all areas of the printer are dry before sending a new print job.
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Cleaning the scanner glass
Clean the scanner glass if you encounter print quality problems, such as streaks on copied or scanned images.

1 Slightly dampen a soft, lint-free cloth or paper towel with water.
2 Open the scanner cover.

3 Clean all the areas shown, and then let them dry.

1 White underside of the scanner cover
2 Scanner glass
3 ADF glass
4 White underside of the ADF cover

4 Close the scanner cover.

152

Maintaining the printer

153

Checking the status of parts and supplies
A message appears on the display when a replacement supply item is needed or when maintenance is required.

Checking the status of parts and supplies on the printer control panel
From the printer control panel, navigate to:
> Status/Supplies >

> View Supplies >

Checking the status of parts and supplies from the Embedded Web Server
Note: Make sure the computer and printer are connected to the same network.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Device Status > More Details.

Estimated number of remaining pages
The estimated number of remaining pages is based on the recent printing history of the printer. Its accuracy may
vary significantly and is dependent on many factors, such as actual document content, print quality settings, and
other printer settings.
The accuracy of the estimated number of remaining pages may decrease when the actual printing consumption is
different from the historical printing consumption. Consider the variable level of accuracy before purchasing or replacing
supplies based on the estimate. Until an adequate print history is obtained on the printer, initial estimates assume
future supplies consumption based on the International Organization for Standardization* test methods and page
content.
* Average continuous black declared cartridge yield in accordance with ISO/IEC 19752.
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Ordering supplies
To order parts and supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized
supplies dealers in your area. In other countries or regions, go to www.lexmark.com or contact the place where you
purchased the printer.
The Lexmark Return Program lets you purchase Lexmark supplies at a discounted price in exchange for your agreement
to use the supplies only once and return them only to Lexmark for remanufacturing or recycling.

Using genuine Lexmark parts and supplies
Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components. Use of third-party
supplies or parts can affect warranty coverage. Damage caused by the use of third-party supplies or parts is not covered
by the warranty. All life indicators are designed to function with Lexmark supplies and parts, and may deliver
unpredictable results if third-party supplies or parts are used. Imaging component usage beyond the intended life may
damage your Lexmark printer or its associated components.

Ordering toner cartridges
Notes:

• The estimated cartridge yield is based on the ISO/IEC 19752 standard.
• Extremely low print coverage for extended periods of time may negatively affect actual yield.
Item

Return Program cartridge

United States and Canada
Toner Cartridge

601

High Yield Toner Cartridge

601H

European Union (EU), European Economic Area (EEA), and Switzerland
Toner Cartridge

602

High Yield Toner Cartridge

602H

Asia Pacific region (includes Australia and New Zealand)
Toner Cartridge

603

High Yield Toner Cartridge

603H

Latin America (includes Puerto Rico and Mexico)
Toner Cartridge

604

High Yield Toner Cartridge

604H

Africa, Middle East, Central Eastern Europe (non‑EU), and Commonwealth of Independent States (CIS)
Toner Cartridge

605

High Yield Toner Cartridge

605H

For more information on countries located in each region, visit www.lexmark.com/regions.
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Item

Regular cartridge

Worldwide
High Yield Toner Cartridge

600HA

Ordering a maintenance kit
Notes:

• Using certain types of paper may require more frequent replacement of the maintenance kit.
• The separator roller, fuser, pick rollers, transfer roller, and redrive assembly are all included in the maintenance
kit and can be individually ordered and replaced if necessary.

• Contact your service representative to replace the maintenance kit.
Maintenance kit

Part number

100‑V maintenance kit*

40X9146

110‑V maintenance kit

40X9135

220‑V maintenance kit

40X9136

* This is available only in Japan.

Ordering an ADF separator pad
Order an ADF separator pad when the ADF fails to pick paper or picks more than one sheet of paper at a time.
For information on replacing the ADF separator pad, see the instruction sheet that came with the part.
Part name

Part number

Separator pad

40X6247

Ordering an imaging unit
Extremely low print coverage for extended periods of time may cause imaging unit parts to fail prior to exhaustion of
toner from toner cartridge.
For more information on replacing the imaging unit, see the instruction sheet that came with the supply.
Part name

Lexmark Return Program

Regular

Imaging unit

500Z

500ZA

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.
Do not expose supplies to:

• Direct sunlight
• Temperatures above 35°C (95°F)
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•
•
•

High humidity above 80%
Salty air
Corrosive gases
Heavy dust

Replacing supplies
Replacing the toner cartridge
1 Press the button on the right side of the printer, and then open the front door.

2 Pull the toner cartridge out using the handle.

3 Unpack the toner cartridge, and then remove all packing materials.
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4 Shake the new cartridge to redistribute the toner.

5 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the side rails
inside the printer.
Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

6 Close the front door.
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Replacing the imaging unit
1 Press the button on the right side of the printer, and then open the front door.

2 Pull the toner cartridge out using the handle.

3 Lift the green handle, and then pull the imaging unit out of the printer.
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4 Unpack the new imaging unit, and then shake it.

5 Remove all packing materials from the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.
Warning—Potential Damage: Do not touch the photoconductor drum. Doing so may affect the print quality of
future print jobs.

6 Insert the imaging unit into the printer by aligning the arrows on the side rails of the imaging unit with the arrows
on the side rails inside the printer.
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7 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the side rails
inside the printer.

8 Close the front door.

Moving the printer
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

Before moving the printer
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.
• Disconnect all cords and cables from the printer before moving it.
• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the latch on the
right side of the tray toward the front of the tray until it clicks into place.
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• Use the handholds located on both sides of the printer to lift it.
• Make sure your fingers are not under the printer when you set it down.
• Before setting up the printer, make sure there is adequate clearance around it.
Use only the power cord provided with this product or the manufacturer's authorized replacement.
Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.

Moving the printer to another location
The printer and its hardware options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer.
• Any cart used to move the hardware options must have a surface able to support the dimensions of the hardware
options.

• Keep the printer in an upright position.
• Avoid severe jarring movements.

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Finding advanced networking and administrator information
This chapter covers basic administrative support tasks using the Embedded Web Server. For more advanced system
support tasks, see the Networking Guide on the Software and Documentation CD or the Embedded Web Server —
Security: Administrator's Guide on the Lexmark support Web site at http://support.lexmark.com.

Accessing the remote control panel
The remote control panel on your computer screen lets you interact with the printer control panel, even when you are
not physically near the network printer. From your computer screen, you can view the printer status and do printrelated tasks you might normally do while standing at the network printer.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• Print a network setup page or menu settings page, and then locate the IP address in the TCP/IP section. The
IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Press Enter to open the Web page of your printer.
3 Click Applications.
Note: The remote control panel requires a Java plug‑in to launch.

Setting up e‑mail alerts
Configure the printer to send you e‑mail alerts when the supplies are getting low, when the paper needs to be changed
or added, or when there is a paper jam.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings.
3 From the Other Settings menu, click E‑mail Alert Setup.
4 Select the items you want to be notified on, and then type the e‑mail addresses.
5 Click Submit.
Note: For information on setting up the e‑mail server, contact your system support person.
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Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status of the
printer, network, and supplies.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Reports, and then click the type of report you want to view.

Configuring supply notifications from the Embedded Web
Server
You can determine how you would like to be notified when supplies run nearly low, low, very low, or reach their
end‑of‑life by setting the selectable alerts.
Notes:

• Selectable alerts can be set on the toner cartridge, imaging unit, and maintenance kit.
• All selectable alerts can be set for nearly low, low, and very low supply conditions. Not all selectable alerts can
be set for the end‑of‑life supply condition. E‑mail selectable alert is available for all supply conditions.

• The percentage of estimated remaining supply that prompts the alert can be set on some supplies for some
supply conditions.

1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Click Settings > Print Settings > Supply Notifications.
3 From the drop‑down menu for each supply, select one of the following notification options:
Notification

Description

Off

The normal printer behavior for all supplies occurs.

E‑mail Only

The printer generates an e‑mail when the supply condition is reached. The status of the
supply appears on the menus page and status page.

Warning

The printer displays the warning message and generates an e‑mail about the status of the
supply. The printer does not stop when the supply condition is reached.

Continuable Stop1

The printer stops processing jobs when the supply condition is reached, and the user needs
to press a button to continue printing.

1

The printer generates an e-mail about the status of the supply when supply notification is enabled.

2

The printer stops when some supplies become empty to prevent damage.
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Notification

Description

Non Continuable Stop1,2

The printer stops processing jobs when the supply condition is reached. The supply must be
replaced to continue printing.

1

The printer generates an e-mail about the status of the supply when supply notification is enabled.

2

The printer stops when some supplies become empty to prevent damage.

4 Click Submit.

Restoring factory default settings
If you want to keep a list of the current menu settings for reference, then print a menu settings page before restoring
the factory default settings. For more information, see “Printing a menu settings page” on page 27.
If you want a more comprehensive method of restoring the printer factory default settings, then perform the Wipe All
Settings option. For more information, see “Erasing non‑volatile memory” on page 149.
Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory default
settings. Exceptions include the display language, custom sizes and messages, and network/port menu settings. All
downloads stored in the RAM are deleted. Downloads stored in the flash memory or in the printer hard disk are not
affected.
From the printer control panel, navigate to:
> Settings >

> Settings >

> General Settings >

> Factory Defaults >

> Restore Now >
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Clearing jams
Carefully select paper and specialty media and load them properly to avoid most jams. If jams occur, then follow the
steps outlined in this chapter.
Warning—Potential Damage: Never use any tool to remove a jam. Doing so could permanently damage the fuser.

Avoiding jams
Load paper properly
• Make sure paper lies flat in the tray.
Correct loading of paper

•
•
•
•

Incorrect loading of paper

Do not remove a tray while the printer is printing.
Do not load a tray while the printer is printing. Load it before printing, or wait for a prompt to load it.
Do not load too much paper. Make sure the stack height is below the maximum paper fill indicator.
Do not slide the paper into the tray. Load paper as shown in the illustration.
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• Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing tightly
against the paper or envelopes.

• Push the tray firmly into the printer after loading paper.

Use recommended paper
• Use only recommended paper or specialty media.
• Do not load wrinkled, creased, damp, bent, or curled paper.
• Flex, fan, and straighten paper before loading it.

•
•
•
•

Do not use paper that has been cut or trimmed by hand.
Do not mix paper sizes, weights, or types in the same tray.
Make sure the paper size and type are set correctly on the computer or printer control panel.
Store paper according to manufacturer recommendations.

Understanding jam messages and locations
When a jam occurs, a message indicating the jam location and information to clear the jam appears on the printer
display. Open the doors, covers, and trays indicated on the display to remove the jam.
Notes:

• When Jam Assist is set to On, the printer automatically flushes blank pages or pages with partial prints to the
standard bin after a jammed page has been cleared. Check your printed output stack for discarded pages.

• When Jam Recovery is set to On or Auto, the printer reprints jammed pages. However, the Auto setting does not
guarantee that the page will reprint.
1

2
3
4
5
7

6
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Printer control panel message

What to do

1

Automatic document [x]‑page jam, open automatic
feeder (ADF)
feeder top cover. [28y.xx]

Remove all paper from the ADF tray, and then remove
the jammed paper.

2

Standard bin

[x]‑page jam, clear standard
bin. [20y.xx]

Remove the jammed paper.

3

Front door

[x]‑page jam, open front
door. [20y.xx]

Open the front door, then remove the toner cartridge
and imaging unit, and then the jammed paper.

4

Multipurpose feeder [x]‑page jam, clear manual
feeder. [250.xx]

Remove all paper from the multipurpose feeder, and
then remove the jammed paper.

5

Tray 1

Pull out tray 1 completely, then push the front duplex
flap down, and then remove the jammed paper.

[x]‑page jam, remove tray 1 to
clear duplex. [23y.xx]

Note: You may need to open the rear door to clear
some 23y.xx paper jams.
6

Tray [x]

[x]‑page jam, remove tray
[x]. [24y.xx]

Pull out the indicated tray, and then remove the jammed
paper.

7

Rear door

[x]‑page jam, open rear
door. [20y.xx]

Open the rear door, and then remove the jammed paper.

[x]‑page jam, open front door. [20y.xx]
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

1 Press the button on the right side of the printer, and then open the front door.
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2 Pull the toner cartridge out using the handle.

3 Lift the green handle, and then pull the imaging unit out of the printer.

Warning—Potential Damage: Do not touch the shiny blue photoconductor drum under the imaging unit. Doing
so may affect the quality of future print jobs.

4 Place the imaging unit aside on a flat, smooth surface.
Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.
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5 Lift the green flap in front of the printer.

6 Firmly grasp the jammed paper on each side, and then gently pull it out.
Note: Make sure all paper fragments are removed.

7 Insert the imaging unit by aligning the arrows on the side rails of the unit with the arrows on the side rails inside
the printer, and then insert the imaging unit into the printer.
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8 Insert the toner cartridge by aligning the side rails of the cartridge with the arrows on the side rails inside the printer,
and then insert the cartridge into the printer.

9 Close the front door.
10 From the printer control panel, touch
models, select Next >

to clear the message and continue printing. For non‑touch‑screen printer

> Clear the jam, press OK >

.

[x]‑page jam, open rear door. [20y.xx]
1 Open the front door to loosen the jammed paper in the rear door.

2 Gently pull down the rear door.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.
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3 Firmly grasp the jammed paper on each side, and then gently pull it out.
Note: Make sure all paper fragments are removed.

4 Close the rear door, and then the front door.
5 From the printer control panel, touch
models, select Next >

to clear the message and continue printing. For non‑touch‑screen printer

> Clear the jam, press OK >

.

[x]‑page jam, clear standard bin. [20y.xx]
1 Firmly grasp the jammed paper on each side, and then gently pull it out.
Note: Make sure all paper fragments are removed.
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2 From the printer control panel, touch
models, select Next >

to clear the message and continue printing. For non‑touch‑screen printer

> Clear the jam, press OK >

.

[x]‑page jam, remove tray 1 to clear duplex. [23y.xx]
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

1 Pull the tray completely out of the printer.
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2 Locate the blue lever, and then pull it down to release the jam.

3 Firmly grasp the jammed paper on each side, and then gently pull it out.
Note: Make sure all paper fragments are removed.

4 Insert the tray.
5 From the printer control panel, touch
models, select Next >

to clear the message and continue printing. For non‑touch‑screen printer

> Clear the jam, press OK >

.

[x]‑page jam, open tray [x]. [24y.xx]
1 Pull the tray completely out of the printer.
Note: The message on the printer display indicates the tray where the jammed paper is located.
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2 Firmly grasp the jammed paper on each side, and then gently pull it out.
Note: Make sure all paper fragments are removed.

3 Insert the tray.
4 From the printer control panel, touch
models, select Next >

to clear the message and continue printing. For non‑touch‑screen printer

> Clear the jam, press OK >

.

[x]‑page jam, clear manual feeder. [25y.xx]
1 From the multipurpose feeder, firmly grasp the jammed paper on each side, and then gently pull it out.
Note: Make sure all paper fragments are removed.
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2 Flex the sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

3 Reload paper into the multipurpose feeder.

Note: Make sure the paper guide lightly rests against the edge of the paper.

4 From the printer control panel, touch
models, select Next >

to clear the message and continue printing. For non‑touch‑screen printer

> Clear the jam, press OK >

.
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[x]‑page jam, open automatic feeder top cover. [28y.xx]
1 Remove all original documents from the ADF tray.
Note: The message is cleared when the pages are removed from the ADF tray.

2 Open the ADF cover.

3 Firmly grasp the jammed paper on each side, and then gently pull it out.
Note: Make sure all paper fragments are removed.

4 Close the ADF cover.
5 Straighten the edges of the original documents, then load the original documents into the ADF, and then adjust the
paper guide.

6 From the printer control panel, touch
models, select Next >

to clear the message and continue printing. For non‑touch‑screen printer

> Clear the jam, press OK >

.
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Troubleshooting
Understanding the printer messages
Cartridge low [88.xy]
You may need to order a toner cartridge. If necessary, select Continue on the printer control panel to clear the message
and continue printing. For non‑touch‑screen printer models, press

to confirm.

Cartridge nearly low [88.xy]
If necessary, select Continue on the printer control panel to clear the message and continue printing. For
non‑touch‑screen printer models, press

to confirm.

Cartridge very low, [x] estimated pages remain [88.xy]
You may need to replace the toner cartridge very soon. For more information, see the “Replacing supplies” section of
the User’s Guide.
If necessary, select Continue on the printer control panel to clear the message and continue printing. For
non‑touch‑screen printer models, press

to confirm.

Change [paper source] to [custom string] load [paper orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, then verify that the paper size and type settings are specified in
the Paper menu on the printer control panel, and then select Finished changing paper. For non‑touch‑screen printer
models, press

to confirm.

• Cancel the print job.

Change [paper source] to [custom type name] load [orientation]
Try one or more of the following

• Load the correct paper size and type in the tray, verify the paper size and type settings are specified in the Paper
menu on the printer control panel, and then select Finished changing paper. For non‑touch‑screen printer models,
press

to confirm.

• Cancel the print job.
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Change [paper source] to [paper size] load [orientation]
Try one or more of the following:

• Load the correct paper size and type in the tray, verify the paper size and type settings are specified in the Paper
menu on the printer control panel, and then select Finished changing paper. For non‑touch‑screen printer models,
press

to confirm.

• Cancel the print job.

Change [paper source] to [paper type] [paper size] load [orientation]
Try one or more of the following:

• Load the correct paper size and type in the tray, verify the paper size and type settings are specified in the Paper
menu on the printer control panel, and then select Finished changing paper. For non‑touch‑screen printer models,
press

to confirm.

• Cancel the print job.

Close flatbed cover and load originals if restarting job [2yy.xx]
From the printer control panel, try one or more of the following:

• Select Scan from automatic feeder to continue scanning from the ADF immediately after the last successful scan
job.

• Select Scan from flatbed to continue scanning from the scanner glass immediately after the last successful scan
job.

• Select Finish job without further scanning to end the last successful scan job.
Note: This does not cancel the scan job. All successfully scanned pages will be processed further for copying,
faxing, or e-mailing.

• Select Cancel job to clear the message and cancel the scan job.
• For non‑touch‑screen printer models, press

to confirm.

Close front door
Close the front door of the printer.

Complex page, some data may not have printed [39]
Try one or more of the following:

• From the printer control panel, select Continue to ignore the message and continue printing. For non‑touch‑screen
printer models, press

to confirm.

• Cancel the current print job. For non‑touch‑screen printer models, press
• Install additional printer memory.

to confirm.
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Defective flash detected [51]
Try one or more of the following:

• Replace the defective flash memory card.
• From the printer control panel, select Continue to ignore the message and continue printing. For non‑touch‑screen
printer models, press

to confirm.

• Cancel the current print job.

Error reading USB drive. Remove USB.
An unsupported USB device is inserted. Remove the USB device, and then insert a supported one.

Error reading USB hub. Remove hub.
An unsupported USB hub has been inserted. Remove the USB hub, and then install a supported one.

Fax memory full
From the printer control panel, touch Continue to clear the message.

Fax partition inoperative. Contact system administrator.
Try either of the following:

• From the printer control panel, select Continue to clear the message. For non‑touch‑screen printer models, press
to confirm.

• Turn the printer off, and then turn it back on. If the message appears again, then contact your system support
person or see the “Setting up the printer to fax” section of the User’s Guide.

Fax server 'To Format' not set up. Contact system administrator.
Try either of the following:

• From the printer control panel, select Continue to clear the message. For non‑touch‑screen printer models, press
to confirm.

• Complete the Fax Server setup. If the message appears again, then contact your system support person.

Fax Station Name not set up. Contact system administrator.
Try either of the following:

• From the printer control panel, select Continue to clear the message. For non‑touch‑screen printer models, press
to confirm.

• Complete the Analog Fax Setup. If the message appears again after completing the setup, then contact your system
support person.
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Fax Station Number not set up. Contact system administrator.
Try either of the following:

• From the printer control panel, select Continue to clear the message. For non‑touch‑screen printer models, press
to confirm.

• Complete the Analog Fax Setup. If the message appears again after completing the setup, then contact your system
support person.

Imaging unit low [84.xy]
You may need to order an imaging unit. If necessary, select Continue on the printer control panel to clear the message
and continue printing. For non‑touch‑screen printer models, press

to confirm.

Imaging unit nearly low [84.xy]
If necessary, select Continue on the printer control panel to clear the message and continue printing. For
non‑touch‑screen printer models, press

to confirm.

Imaging unit very low, [x] estimated pages remain [84.xy]
You may need to replace the imaging unit very soon. For more information, see the "Replacing supplies" section of the
User’s Guide.
If necessary, select Continue on the printer control panel to clear the message and continue printing. For
non‑touch‑screen printer models, press

to confirm.

Incorrect paper size, open [paper source] [34]
Note: The paper source can be a tray or a feeder.
Try one or more of the following:

• Load the correct size of paper in the paper source.
• From the printer control panel, select Continue to clear the message and print using a different paper source. For
non‑touch‑screen printer models, press

•
•
•
•

to confirm.

Check the length and width guides of the paper source and make sure the paper is loaded properly.
Make sure the correct paper size and type are specified in the Printing Preferences or in the Print dialog.
Make sure the paper size and type are specified in the Paper menu on the printer control panel.
Make sure that the paper size is correctly set. For example, if Multipurpose Feeder Size is set to Universal, then
make sure the paper is large enough for the data being printed.

• Cancel the print job.
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Insufficient memory for Flash Memory Defragment operation [37]
Try one or more of the following:

• From the printer control panel, select Continue to stop the defragmentation and continue printing. For
non‑touch‑screen printer models, press

to confirm.

• Delete fonts, macros, and other data from the printer memory.
• Install additional printer memory.

Insufficient memory, some Held Jobs were deleted [37]
The printer deleted some held jobs in order to process current jobs.
to confirm.

Select Continue to clear the message. For non-touch-screen printer models, press

Insufficient memory, some held jobs will not be restored [37]
Try one or more of the following:

• From the printer control panel, select Continue to clear the message. For non-touch-screen printer models, press
to confirm.

• Delete other held jobs to free up additional printer memory.

Insufficient memory to collate job [37]
Try one or more of the following:

• From the printer control panel, select Continue to print the part of the job already stored and begin collating the
rest of the print job. For non‑touch‑screen printer models, press

to confirm.

• Cancel the current print job.

Insufficient memory to support Resource Save feature [35]
Install additional printer memory or select Continue on the printer control panel to disable Resource Save, clear the
message, and continue printing. For non‑touch‑screen printer models, press

to confirm.

Load manual feeder with [custom string] [paper orientation]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.
• Depending on your printer model, touch Continue or press

to clear the message and continue printing.

Note: If no paper is loaded in the feeder when Continue or
is selected, then the printer automatically
overrides the request, and then prints from an automatically selected tray.

• Cancel the current job.
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Load manual feeder with [custom type name] [paper orientation]
Try one or more of the following:

• Load the multipurpose feeder with the correct size and type of paper.
• Depending on your printer model, touch Continue or press

to clear the message and continue printing.

Note: If no paper is loaded in the feeder when Continue or
is selected, then the printer manually overrides
the request, and then prints from an automatically selected tray.

• Cancel the current job.

Load manual feeder with [paper size] [paper orientation]
Try one or more of the following:

• Load the multipurpose feeder with the correct size of paper.
• Depending on your printer model, touch Continue or press

to clear the message and continue printing.

Note: If no paper is loaded in the feeder when Continue or
is selected, then the printer manually overrides
the request, and then prints from an automatically selected tray.

• Cancel the current job.

Load manual feeder with [paper type] [paper size] [paper orientation]
Try one or more of the following:

• Load the multipurpose feeder with the correct size and type of paper.
• Depending on your printer model, touch Continue or press

to clear the message and continue printing.

is selected, then the printer manually overrides
Note: If no paper is loaded in the feeder when Continue or
the request, and then prints from an automatically selected tray.

• Cancel the current job.

Load [paper source] with [custom string] [paper orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.
• To use the tray that has the correct size or type of paper, select Finished loading paper on the printer control panel.
For non‑touch‑screen printer models, press

to confirm.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.
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Load [paper source] with [custom type name] [paper orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.
• To use the tray that has the correct size or type of paper, select Finished loading paper on the printer control panel.
For non‑touch‑screen printer models, press

to confirm.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Load [paper source] with [paper size] [paper orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size of paper.
• To use the tray or feeder that has the correct size of paper, select Finished loading paper on the printer control
panel. For non‑touch‑screen printer models, press

to confirm.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Load [paper source] with [paper type] [paper size] [paper orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.
• To use the tray or feeder that has the correct size and type of paper, select Finished loading paper on the printer
control panel. For non‑touch‑screen printer models, press

to confirm.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Maintenance kit low [80.xy]
You may need to order a maintenance kit. For more information, visit the Lexmark support Web site at
http://support.lexmark.com or contact customer support, and then report the message.
If necessary, select Continue to clear the message and continue printing. For non‑touch‑screen printer models,
press

to confirm.
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Maintenance kit nearly low [80.xy]
For more information, visit the Lexmark support Web site at http://support.lexmark.com or contact customer support,
and then report the message.
If necessary, select Continue to clear the message and continue printing. For non‑touch‑screen printer models,
press

to confirm.

Maintenance kit very low, [x] estimated pages remain [80.xy]
You may need to replace the maintenance kit very soon. For more information, visit the Lexmark support Web site at
http://support.lexmark.com or contact customer support, and then report the message.
If necessary, select Continue on the printer control panel to clear the message and continue printing. For
non‑touch‑screen printer models, press

to confirm.

Memory full, cannot print faxes
From the printer control panel, select Continue to clear the message without printing. For non‑touch‑screen printer
models, press

to confirm.

Note: Held faxes will attempt to print after the printer restarts.

Memory full, cannot send faxes
1 From the printer control panel, select Continue to clear the message and cancel the fax job. For non‑touch‑screen
printer models, press

to confirm.

2 Do either of the following:
• Reduce the fax resolution, and then resend the fax job.
• Reduce the number of pages in the fax, and then resend fax job.

Memory full [38]
Try one or more of the following:

• From the printer control panel, select Cancel job to clear the message. For non‑touch‑screen printer models, press
to confirm.

• Install additional printer memory.

Network [x] software error [54]
Try one or more of the following:

• From the printer control panel, select Continue to continue printing. For non‑touch‑screen printer models, press
to confirm.

• Turn off the printer, wait for about 10 seconds, and then turn the printer back on.
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• Update the network firmware in the printer or print server. For more information, visit the Lexmark support Web
site at http://support.lexmark.com.

No analog phone line connected to modem, fax is disabled.
Connect the printer to an analog phone line.

Non‑Lexmark [supply type], see User’s Guide [33.xy]
Note: The supply type can be toner cartridge or imaging unit.
The printer has detected a non‑Lexmark supply or part installed in the printer.
Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components.
All life indicators are designed to function with Lexmark supplies and parts and may deliver unpredictable results if
third-party supplies or parts are used. Imaging component usage beyond the intended life may damage your Lexmark
printer or associated components.
Warning—Potential Damage: Use of third-party supplies or parts can affect warranty coverage. Damage caused by
the use of third-party supplies or parts may not be covered by the warranty.
To accept any and all of these risks and to proceed with the use of non-genuine supplies or parts in your printer, press
and hold

and the # button on the printer control panel simultaneously for 15 seconds.

For non‑touch‑screen printer models, press
to clear the message and continue printing.

and

on the printer control panel simultaneously for 15 seconds

If you do not wish to accept these risks, then remove the third-party supply or part from your printer, and then install
a genuine Lexmark supply or part.
Note: For a list of supported supplies, see the “Ordering supplies” section of the User's Guide or visit
www.lexmark.com.

Not enough free space in flash memory for resources [52]
Try one or more of the following:

• From the printer control panel, select Continue to clear the message and continue printing. For non‑touch‑screen
printer models, press

to confirm.

• Delete fonts, macros, and other data stored in the flash memory.
• Upgrade to a larger capacity flash memory card.
Note: Downloaded fonts and macros that are not previously stored in the flash memory are deleted.

Printer had to restart. Last job may be incomplete.
From the printer control panel, touch
models, press

to confirm.

to clear the message and continue printing. For non‑touch‑screen printer
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For more information, visit http://support.lexmark.com or contact customer support.

Reinstall missing or unresponsive cartridge [31.xy]
Try one or more of the following:

• Check if the toner cartridge is missing. If missing, install the toner cartridge.
For information on installing the cartridge, see the “Replacing supplies” section of the User’s Guide.

• If the toner cartridge is installed, then remove the unresponsive toner cartridge, and then reinstall it.
Note: If the message appears after reinstalling the supply, then the cartridge is defective. Replace the toner
cartridge.

Reinstall missing or unresponsive imaging unit [31.xy]
Try one or more of the following:

• Check if the imaging unit is missing. If missing, install the imaging unit.
For information on installing the imaging unit, see the “Replacing supplies” section of the User’s Guide.

• If the imaging unit is installed, then remove the unresponsive imaging unit, and then reinstall it.
Note: If the message appears after reinstalling the supply, then the imaging unit is defective. Replace the
imaging unit.

Remove paper from standard output bin
Remove the paper stack from the standard bin. The printer automatically detects paper removal and resumes printing.
If removing the paper does not clear the message, then select Continue on the printer control panel. For non-touchscreen printer models, press

to confirm.

Replace all originals if restarting job.
From the printer control panel, try one or more of the following:

• Select Cancel job to clear the message and cancel the scan job.
• Select Scan from automatic feeder to continue scanning from the ADF immediately after the last successful scan
job.

• Select Scan from flatbed to continue scanning from the scanner immediately after the last successful scan job.
• Select Finish job without further scanning to end the last successful scan job.
• Select Restart job to restart the scan job with the same settings from the previous scan job.
• For non‑touch‑screen printer models, press

to confirm.

Replace cartridge, 0 estimated pages remain [88.xy]
Replace the toner cartridge to clear the message and continue printing. For more information, see the instruction sheet
that came with the supply or see the “Replacing supplies” section of the User’s Guide.
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Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace cartridge, printer region mismatch [42.xy]
Install a toner cartridge that matches the region number of the printer. x indicates the value of the printer region. y
indicates the value of the cartridge region. x and y can have the following values:

Printer and toner cartridge regions
Region number

Region

0

Global

1

United States, Canada

2

European Economic Area (EEA), Switzerland

3

Asia Pacific, Australia, New Zealand

4

Latin America

5

Africa, Middle East, rest of Europe

9

Invalid

Notes:

• The x and y values represent .xy in the code that appears on the printer control panel.
• The x and y values must match for printing to continue.

Replace defective imaging unit [31.xy]
Replace the defective imaging unit to clear the message. For more information, see the instruction sheet that came
with the supply or see the “Replacing supplies” section of the User’s Guide.
Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace imaging unit, 0 estimated pages remain [84.xy]
Replace the imaging unit to clear the message and continue printing. For more information, see the instruction sheet
that came with the supply or see the “Replacing supplies” section of the User’s Guide.
Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.
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Replace jammed originals if restarting job.
From the printer control panel, try one or more of the following:

• Select Cancel job to clear the message and cancel the scan job. For non‑touch‑screen printer models, press
to confirm.

• Select Scan from automatic feeder to continue scanning from the ADF immediately after the last successful scan
job. For non‑touch‑screen printer models, press

to confirm.

• Select Scan from flatbed to continue scanning from the scanner immediately after the last successful scan job. For
non‑touch‑screen printer models, press

to confirm.

• Select Finish job without further scanning to end the last successful scan job. For non‑touch‑screen printer models,
press

to confirm.

• Select Restart job to restart the scan job with the same settings from the previous scan job. For non‑touch‑screen
printer models, press

to confirm.

Replace maintenance kit, 0 estimated pages remain [80.xy]
The printer is scheduled for maintenance. For more information, visit the Lexmark support Web site at
http://support.lexmark.com or contact your service representative, and then report the message.

Replace unsupported cartridge [32.xy]
Remove the toner cartridge, and then install a supported one to clear the message and continue printing. For more
information, see the instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s
Guide.
Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace unsupported imaging unit [32.xy]
Remove the imaging unit, and then install a supported one to clear the message and continue printing. For more
information, see the instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s
Guide.
Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Scanner automatic feeder cover open
Close the ADF cover.

Scanner disabled by admin [840.01]
Print without the scanner, or contact your system support person.
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Scanner disabled. Contact system administrator if problem persists. [840.02]
From the printer control panel, try one or more of the following:

• Select Continue with scanner disabled to return to the home screen, and then contact your system support person.
• Select Reboot and automatically enable scanner to cancel the job.
Note: This attempts to enable the scanner.

• For non‑touch‑screen printer models, press

to confirm.

Scanner jam, remove all originals from the scanner [2yy.xx]
Remove the jammed paper from the scanner.

Scanner jam, remove jammed originals from the scanner [2yy.xx]
Remove the jammed paper from the scanner.

Serial option [x] error [54]
Try one or more of the following:

• Make sure that the serial cable is properly connected and is the correct one for the serial port.
• Make sure that the serial interface parameters (protocol, baud, parity, and data bits) are set correctly on the printer
and computer.

• From the printer control panel, select Continue to continue printing. For non‑touch‑screen printer models, press
to confirm.

• Turn off the printer, and then turn it back on.

SMTP server not set up. Contact system administrator.
From the printer control panel, select Continue to clear the message. For non‑touch‑screen printer models, press
to confirm.
Note: If the message appears again, then contact your system support person.

Standard network software error [54]
Try one or more of the following:

• From the printer control panel, select Continue to continue printing. For non‑touch‑screen printer models, press
to confirm.

• Turn off the printer and then turn it back on.
• Update the network firmware in the printer or print server. For more information, visit the Lexmark support Web
site at http://support.lexmark.com.
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Standard USB port disabled [56]
From the printer control panel, select Continue to clear the message. For non‑touch‑screen printer models, press
to confirm.
Notes:

• The printer discards any data received through the USB port.
• Make sure the USB Buffer menu is not set to Disabled.

Supply needed to complete job
Do either of the following:

• Install the missing supply to complete the job.
• Cancel the current job.

Too many flash options installed [58]
1 Turn off the printer.
2 Unplug the power cord from the electrical outlet.
3 Remove the extra flash memory.
4 Connect the power cord to a properly grounded electrical outlet.
5 Turn the printer back on.

Too many trays attached [58]
1 Turn off the printer.
2 Unplug the power cord from the electrical outlet.
3 Remove the extra trays.
4 Connect the power cord to a properly grounded electrical outlet.
5 Turn the printer back on.

Unformatted flash detected [53]
Try one or more of the following:

• From the printer control, select Continue to stop the defragmentation and continue printing. For non‑touch‑screen
printer models, press

to confirm.

• Format the flash memory.
Note: If the error message remains, then the flash memory may be defective and need to be replaced.
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Weblink server not set up. Contact system administrator.
Select Continue to clear the message. For non‑touch‑screen printer models, press

to confirm.

Note: If the message appears again, then contact your system support person.

Solving printer problems
• “Basic printer problems” on page 191
• “Hardware and internal option problems” on page 193
• “Paper feed problems” on page 195

Basic printer problems
The printer is not responding
Action

Yes

No

Step 1

Go to step 2.

Turn on the printer.

Make sure the printer is turned on.
Is the printer turned on?
Step 2
Check if the printer is in Sleep mode or Hibernate mode.
Is the printer in Sleep mode or Hibernate mode?
Step 3

Press the Sleep button Go to step 3.
to wake the printer
from Sleep mode or
Hibernate mode.
Go to step 4.

Plug one end of the
power cord into the
printer and the other to
a properly grounded
electrical outlet.

Unplug the other
electrical equipment,
and then turn on the
printer. If the printer
does not work, then
reconnect the other
electrical equipment.

Go to step 5.

Check if one end of the power cord is plugged into the printer and the
other to a properly grounded electrical outlet.
Is the power cord plugged into the printer and a properly grounded
electrical outlet?
Step 4
Check other electrical equipment plugged into the electrical outlet.
Does other electrical equipment work?
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Action

Yes

No

Step 5

Go to step 6.

Make sure to match the
following:

Check if the cables connecting the printer and the computer are inserted
in the correct ports.

• The USB symbol on
the cable with the
USB symbol on the
printer

Are the cables inserted in the correct ports?

• The appropriate
Ethernet cable with
the Ethernet port
Step 6
Make sure the electrical outlet is not turned off by a switch or breaker.

Turn on the switch or
reset the breaker.

Go to step 7.

Is the electrical outlet turned off by a switch or breaker?
Step 7

Connect the printer
Go to step 8.
power
cord
directly
to
Check if the printer is plugged into any surge protectors, uninterruptible
a properly grounded
power supplies, or extension cords.
electrical outlet.
Is the printer plugged into any surge protectors, uninterruptible power
supplies, or extension cords?
Step 8
Go to step 9.
Check if one end of the printer cable is plugged into a port on the printer
and the other to the computer, print server, option, or other network
device.
Is the printer cable securely attached to the printer and the computer,
print server, option, or other network device?
Step 9

Go to step 10.

Turn off the printer,
remove all packing
materials, then
reinstall the hardware
options, and then turn
on the printer.

Go to step 11.

Use correct printer
driver settings.

Go to step 12.

Install the correct
printer driver.

Make sure to install all hardware options properly and remove any packing
material.
Are all hardware options properly installed and all packing material
removed?
Step 10

Connect the printer
cable securely to the
printer and the
computer, print server,
option, or other
network device.

Check if you have selected the correct port settings in the printer driver.
Are the port settings correct?
Step 11
Check the installed printer driver.
Is the correct printer driver installed?
Step 12
Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.
Is the printer working?

The problem is solved. Contact customer
support.
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Printer display is blank
Action

Yes

No

Step 1

The problem is solved. Go to step 2.

Press the Sleep button on the printer control panel.
Does Ready appear on the printer display?
Step 2
Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

The problem is solved. Turn off the printer,
and then contact
customer support.

Do Please wait and Ready appear on the printer display?

Hardware and internal option problems
Cannot detect internal option
Action

Yes

No

Step 1

The problem is solved. Go to step 2.

Turn off the printer, then wait for about 10 seconds, and then turn on the
printer.
Does the internal option operate correctly?
Step 2

Go to step 3.

Connect the internal
option to the controller
board.

Go to step 4.

Reinstall the internal
option.

Check if the internal option is properly installed in the controller board.
a Turn off the printer using the power switch, and then unplug the power
cord from the electrical outlet.
b Make sure the internal option is installed in the appropriate connector
in the controller board.
c Connect the power cord to the printer, then to a properly grounded
electrical outlet, and then turn on the printer.
Is the internal option properly installed in the controller board?
Step 3
Print a menu settings page, and then check to see if the internal option is
listed in the Installed Features list.
Is the internal option listed in the menu settings page?
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Action

Yes

No

Step 4
a Check if the internal option is selected.

The problem is solved. Contact customer
support.

It may be necessary to manually add the internal option in the printer
driver to make it available for print jobs. For more information, see
“Adding available options in the print driver” on page 23.
b Resend the print job.
Does the internal option operate correctly?

Tray problems
Action

Yes

No

Step 1
a Pull out the tray, and then do one or more of the following:

The problem is solved. Go to step 2.

• Check for paper jams or misfeeds.
• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• If you are printing on custom‑size paper, then make sure that the
paper guides rest against the edges of the paper.

• Make sure the paper is below the maximum paper fill indicator.
• Make sure paper lies flat in the tray.
b Check if the tray closes properly.
Is the tray working?
Step 2
a Turn off the printer, then wait about 10 seconds, and then turn the
printer back on.
b Resend the print job.

The problem is solved. Go to step 3.

Is the tray working?
Step 3
Check if the tray is installed and recognized by the printer.
Print a menu settings page, and then check if the tray is listed in the
Installed Features list.

Go to step 4.

Reinstall the tray. For
more information, see
the setup
documentation that
came with the tray.

Is the tray listed in the menu settings page?
Step 4
Check if the tray is available in the printer driver.
Note: If necessary, manually add the tray in the printer driver to make it
available for print jobs. For more information, see “Adding available
options in the print driver” on page 23.
Is the tray available in the printer driver?

The problem is solved. Contact customer
support.
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Paper feed problems
Jammed pages are not reprinted
Action

Yes

No

The problem is solved. Contact customer
support.

a Turn on jam recovery.
1 From the printer control panel, navigate to:
Settings > General Settings > Print Recovery > Jam Recovery
2 Select On or Auto.

3 Depending on your printer model, press

or touch Submit.

b Resend the pages that did not print.
Were the jammed pages reprinted?

Paper frequently jams
Action

Yes

No

Step 1
a Pull out the tray, and then do one or more of the following:

Go to step 2.

The problem is solved.

Go to step 3.

The problem is solved.

• Make sure paper lies flat in the tray.
• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• Check if the paper guides are aligned against the edges of the
paper.

• Make sure the paper is below the maximum paper fill indicator.
• Check if you are printing on a recommended paper size and type.
b Insert the tray properly.
If jam recovery is enabled, then the print jobs will reprint
automatically.
Do paper jams still occur frequently?
Step 2
a Load paper from a fresh package.
Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Do paper jams still occur frequently?
Step 3
Contact customer
support.
a Review the tips on avoiding jams. For more information, see “Avoiding
jams” on page 165.
b Follow the recommendations, and then resend the print job.
Do paper jams still occur frequently?

The problem is solved.
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Paper jam message remains after jam is cleared
Action

Yes

No

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1

Deactivate Hex Trace
mode.

Go to step 2.

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1
a Check if you are printing on paper that is supported by the tray.

The problem is solved. Go to step 2.

a Do either of the following:
• For touch‑screen printer models, touch

or Done.

• For non‑touch‑screen printer models, select Next >
the jam, press OK >

> Clear

.

b Follow the instructions on the printer display.
Does the paper jam message remain?

Solving print problems
Printing problems
Incorrect characters print

Make sure the printer is not in Hex Trace mode.
Note: If Ready Hex appears on the printer display, then turn off the
printer, and then turn it back on to deactivate Hex Trace mode.
Is the printer in Hex Trace mode?
Step 2
a From the printer control panel, select Standard Network or
Network [x], and then set SmartSwitch to On.
b Resend the print job.
Do incorrect characters print?

Job prints from the wrong tray or on the wrong paper

b Resend the print job.
Did the job print from the correct tray or on the correct paper?
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Yes

No

The problem is solved. Go to step 3.
Step 2
a From the Paper menu on the printer control panel, set the paper size
and type to match the paper loaded in the tray.
b Resend the print job.
Did the job print from the correct tray or on the correct paper?
Step 3
a Depending on your operating system, open Printing Preferences or
the Print dialog, and then specify the paper type.
b Resend the print job.

The problem is solved. Go to step 4.

Did the job print from the correct tray or on the correct paper?
Step 4
a Check if the trays are not linked.

The problem is solved. Contact customer
support.

b Resend the print job.
Did the job print from the correct tray or on the correct paper?

Large jobs do not collate
Action

Yes

No

Step 1
a From the Finishing menu on the printer control panel, set Collate to
“(1,2,3) (1,2,3).”
b Resend the print job.

The problem is solved. Go to step 2.

Did the job print and collate correctly?
Step 2
a From the printer software, set Collate to “(1,2,3) (1,2,3).”

The problem is solved. Go to step 3.

Note: Setting Collate to “(1,1,1) (2,2,2)” in the software overrides
the setting in the Finishing menu.
b Resend the print job.
Did the job print and collate correctly?
Step 3
The problem is solved. Contact customer
support.
Reduce the complexity of the print job by eliminating the number and size
of fonts, the number and complexity of images, and the number of pages
in the job.
Did the job print and collate correctly?
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Multiple‑language PDF files do not print
Action

Yes

No

The problem is solved. Go to step 2.
Step 1
a Check if the print options for the PDF output are set to embed all fonts.
For more information, see the documentation that came with Adobe
Acrobat.
b Generate a new PDF file, and then resend the print job.
Do the files print?
Step 2
a Open the document you want to print in Adobe Acrobat.

The problem is solved. Contact customer
support.

b Click File > Print > Advanced > Print As Image > OK > OK.
Do the files print?

Print jobs do not print
Action

Yes

No

Step 1
The problem is solved. Go to step 2.
a From the document you are trying to print, open the Print dialog and
check if you have selected the correct printer.
Note: If the printer is not the default printer, then you must select
the printer for each document that you want to print.
b Resend the print job.
Do the jobs print?
The problem is solved. Go to step 3.
Step 2
a Check if the printer is plugged in and turned on, and if Ready appears
on the printer display.
b Resend the print job.
Do the jobs print?
Step 3
If an error message appears on the printer display, then clear the message.
Note: The printer continues to print after clearing the message.
Do the jobs print?

The problem is solved. Go to step 4.
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Action

Yes

No

Step 4
a Check if the ports (USB, serial, or Ethernet) are working and if the
cables are securely connected to the computer and the printer.

The problem is solved. Go to step 5.

Note: For more information, see the setup documentation that
came with the printer.
b Resend the print job.
Do the jobs print?
Step 5
a Turn off the printer, wait for about 10 seconds, and then turn the
printer back on.
b Resend the print job.

The problem is solved. Go to step 6.

Do the jobs print?
Step 6
a Remove, and then reinstall the printer software. For more
information, see “Installing the printer” on page 23.

The problem is solved. Contact customer
support.

Note: The printer software is available at
http://support.lexmark.com.
b Resend the print job.
Do the jobs print?

Print job takes longer than expected
Action

Yes

No

Step 1

The problem is solved. Go to step 2.

Change the environmental settings of the printer.
a From the printer control panel, navigate to:
Settings > General Settings
b Select Eco‑Mode or Quiet Mode, and then select Off.
Note: Disabling Eco-Mode or Quiet Mode may increase the
consumption of energy or supplies, or both.
Did the job print?
Step 2
Reduce the number and size of fonts, the number and complexity of
images, and the number of pages in the print job, and then resend the job
Did the job print?

The problem is solved. Go to step 3.
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Action

Yes

No

Step 3
a Remove held jobs stored in the printer memory.

The problem is solved. Go to step 4.

b Resend the print job.
Did the job print?
Step 4
a Disable the Page Protect feature.

The problem is solved. Go to step 5.

From the printer control panel, navigate to:
Settings > General Settings > Print Recovery > Page Protect > Off
b Resend the print job.
Did the job print?
The problem is solved. Contact customer
Step 5
support.
a Check if the cable connections to the printer and print server are
secure. For more information, see the setup documentation that came
with the printer.
b Resend the print job.
Did the job print?

Printing slows down
Notes:

• When printing using narrow paper, the printer prints at a reduced speed to prevent damage to the fuser.
• The printer speed may be reduced when printing for long periods of time, or printing at elevated temperatures.
Action

Yes

No

Step 1
The problem is solved. Go to step 2.
a Make sure the size of the paper loaded in the tray matches the fuser
type.
Note: Use a 110-volt fuser for printing on letter-size paper and a
220-volt fuser for printing on A4‑size paper.
b Resend the print job.
Does the print speed increase?
Step 2
a Replace the fuser. For more information on installing the fuser, see
the instruction sheet that came with the part.
b Resend the print job.
Does the print speed increase?

The problem is solved. Contact customer
support.
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Tray linking does not work
Notes:

• The trays can detect paper length.
• The multipurpose feeder does not automatically detect the paper size. You must set the size from the Paper
Size/Type menu.
Action

Yes

No

Step 1
The problem is solved. Go to step 2.
a Open the trays, and then check if they contain paper of the same size
and type.

• Check if the paper guides are in the correct positions for the size
of the paper loaded in each tray.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.
b Resend the print job.
Do the trays link correctly?
The problem is solved. Contact customer
Step 2
support.
a From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the trays to be linked.
Note: The paper size and type must match for trays to be linked.
b Resend the print job.
Do the trays link correctly?

Unexpected page breaks occur
Action

Yes

No

Step 1

The problem is solved. Go to step 2.

Adjust the print timeout settings.
a From the printer control panel, navigate to:
Settings > General Settings > Timeouts > Print Timeout
b Select a higher setting and then, depending on your printer model,
select
or Submit.
c Resend the print job.
Did the file print correctly?
Step 2
a Check the original file for manual page breaks.

b Resend the print job.
Did the file print correctly?

The problem is solved. Contact customer
support.
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Print quality problems
Characters have jagged or uneven edges

Action

Yes

Go to step 2.
Step 1
a Print a font sample list to check if the fonts you are using are supported
by the printer.
1 From the printer control panel, navigate to:

No
Select a font that is
supported by the
printer.

Menus > Reports > Print Fonts
2 Select PCL Fonts or PostScript Fonts.

b Resend the print job.
Are you using fonts that are supported by the printer?
The problem is solved. Contact customer
support.
Check if the fonts installed on the computer are supported by the printer.
Step 2

Are the fonts installed on the computer supported by the printer?

Clipped pages or images
Leading edge

ABCDE
ABCDE
ABCDE
Trailing edge

Action

Yes

Step 1
Go to step 2.
a Move the width and length guides in the tray to the correct positions
for the paper loaded.
b Resend the print job.
Is the page or image clipped?

No
The problem is solved.
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Action

Yes

No

Step 2

Go to step 3.

Do one or more of the
following:

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

Do the paper size and type match the paper loaded in the tray?

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.
Step 3
a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.
b Resend the print job.

Go to step 4.

The problem is solved.

Contact customer
support.

The problem is solved.

Is the page or image clipped?
Step 4
a Reinstall the imaging unit.
1 Remove the toner cartridge.

2 Remove the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
3 Install the imaging unit, and then the cartridge.

b Resend the print job.
Is the page or image clipped?

Compressed images appear on prints
Note: Printing on letter-size paper using a 220-volt fuser compresses images.
Action

Yes

No

The problem is solved. Go to step 2.
Step 1
a Make sure the size of the paper loaded in the tray matches the fuser
type.
Note: Use a 110-volt fuser for printing on letter-size paper and a
220-volt fuser for printing on A4‑size paper.
b Resend the print job.
Do compressed images still appear?
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Action

Yes

No

Step 2
a Replace the fuser. For more information on installing the fuser, see
the instruction sheet that came with the part.
b Resend the print job.

The problem is solved. Contact customer
support.

Do compressed images still appear?

Gray background on prints
Leading edge

ABCDE
ABCDE
ABCDE

Trailing edge

Action

Yes

No

Step 1
a From the Quality Menu on the printer control panel, decrease the
toner darkness.

The problem is solved. Go to step 2.

Note: 8 is the factory default setting.

b Resend the print job.
Did the gray background disappear from the prints?
Step 2

The problem is solved. Go to step 3.

Reinstall the imaging unit and the toner cartridge.
a Remove the toner cartridge.

b Remove the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to light
can cause print quality problems.
c Install the imaging unit, and then the cartridge.

d Resend the print job.
Did the gray background disappear from the prints?
Step 3
Replace the imaging unit, and then resend the print job.
Did the gray background disappear from the prints?

The problem is solved. Contact customer
support.
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Horizontal voids appear on prints
Leading edge

Trailing edge

Action

Yes

No

Step 1
a Make sure your software program is using a correct fill pattern.

Go to step 2.

The problem is solved.

Step 2
Go to step 3.
a Load the specified tray or feeder with a recommended type of paper.

The problem is solved.

b Resend the print job.
Do horizontal voids appear on prints?

b Resend the print job.
Do horizontal voids appear on prints?
Step 3
a Redistribute the toner in the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.

Go to step 4.

The problem is solved.

Contact customer
support.

The problem is solved.

2 Firmly shake the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.
Do horizontal voids appear on prints?
Step 4
Replace the imaging unit, and then resend the print job.
Do horizontal voids appear on prints?
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Incorrect margins on prints

ABCD
ABCD
ABCD
Action

Yes

No

The problem is solved. Go to step 2.
Step 1
a Move the width and length guides in the tray to the correct positions
for the paper size loaded.
b Resend the print job.
Are the margins correct?
Step 2
From the printer control panel, set the paper size in the Paper menu to
match the paper loaded in the tray.
Does the paper size match the paper loaded in the tray?

Go to step 3.

Do one or more of the
following:

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.
Step 3
a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.
b Resend the print job.
Are the margins correct?

The problem is solved. Contact customer
support.
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Paper curl
Action

Yes

No

Step 1

Go to step 2.

Adjust the width and
length guides.

Go to step 3.

Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Go to step 4.

The problem is solved.

Go to step 5.

The problem is solved.

Contact customer
support.

The problem is solved.

Move the width and length guides in the tray to the correct positions for
the size of the paper loaded.
Are the width and length guides positioned correctly?
Step 2
From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.
Do the paper type and weight match the type and weight of the paper in
the tray?
Step 3
a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.
b Resend the print job.
Is the paper still curled?
Step 4
a Remove the paper from the tray, and then turn it over.

b Resend the print job.
Is the paper still curled?
Step 5
a Load paper from a fresh package.
Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Is the paper still curled?

Print irregularities
Leading edge

)
)
ABCDE
ABCDE
ABCDE

Trailing edge
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Yes

Step 1
Go to step 2.
a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded in the tray.
b Resend the print job.

No
The problem is solved.

Do print irregularities still appear?
Step 2

Go to step 3.

Specify the paper size
and type from the tray
settings to match the
paper loaded in the
tray.

Go to step 4.

The problem is solved.

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.
Do the printer settings match the type and weight of the paper loaded in
the tray?
Step 3
a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.
b Resend the print job.
Do print irregularities still appear?
Step 4
Check if the paper loaded in the tray has texture or rough finishes.
Are you printing on textured or rough paper?

Step 5
a Load paper from a fresh package.

From the printer
Go to step 5.
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in the
tray.
Go to step 6.

The problem is solved.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Do print irregularities still appear?
Step 6
Replace the imaging unit, and then resend the print job.
Do print irregularities still appear?

Contact customer
The problem is solved.
support at
http://support.lexmar
k.com or your service
representative.
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Print is too dark

Action

Yes

Go to step 2.
Step 1
a From the Quality menu on the printer control panel, reduce the toner
darkness.

No
The problem is solved.

Note: 8 is the factory default setting.

b Resend the print job.
Is the print still too dark?
Step 2
Go to step 3.
a From the printer control panel, set the paper type, texture and weight
in the Paper menu to match the paper loaded in the tray.
b Resend the print job.
Is the tray set to the type, texture, and weight of the paper loaded?

Do one or more of the
following:

• Specify the paper
type, texture, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the paper
loaded in the tray
to match the paper
type, texture and
weight specified in
the tray settings.
Go to step 4.
Step 3
a Depending on your operating system, specify the paper type, texture
and weight from Printing Preferences or from the Print dialog.
b Resend the print job.

The problem is solved.

Is the print still too dark?
Step 4
Check if the paper loaded in the tray has texture or rough finishes.
Are you printing on textured or rough paper?

From the printer
Go to step 5.
control panel, change
the texture settings in
the Paper Texture
menu to match the
paper you are printing
on.
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Action

Yes

No

Step 5
a Load paper from a fresh package.

Go to step 6.

The problem is solved.

Contact customer
support.

The problem is solved.

Yes

No

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Is the print still too dark?
Step 6
Replace the imaging unit, and then resend the print job.
Is the print still too dark?

Print is too light

Action

Go to step 2.
Step 1
a From the Quality menu on the printer control panel, increase the toner
darkness.

The problem is solved.

Note: 8 is the factory default setting.
b Resend the print job.
Is the print still too light?
Step 2

Go to step 3.

Change the paper type,
texture, and weight to
match the paper
loaded in the tray.

Go to step 4.
Step 3
a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.
b Resend the print job.

The problem is solved.

From the printer control panel, set the paper type, texture, and weight in
the Paper menu to match the paper loaded in the tray.
Is the tray set to the type, texture, and weight of the paper loaded?

Is the print still too light?
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Action

Yes

Step 4

From the printer
Go to step 5.
control panel, change
the texture settings in
the Paper Texture
menu to match the
paper you are printing
on.

Make sure that the paper has no texture or rough finishes.
Are you printing on textured or rough paper?

Step 5
a Load paper from a fresh package.

No

Go to step 6.

The problem is solved.

Go to step 7.

The problem is solved.

Contact customer
support.

The problem is solved.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Is the print still too light?
Step 6
a Redistribute the toner in the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
3 Install the imaging unit, and then the cartridge.

b Resend the print job.
Is the print still too light?
Step 7
Replace the imaging unit, and then resend the print job.
Is the print still too light?

Printer is printing blank pages
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Action

Yes

No

Step 1
a Check if there is packing material left on the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.

Go to step 2.

The problem is solved.

Go to step 3.

The problem is solved.

Contact customer
support.

The problem is solved.

2 Check if the packing material is properly removed from the imaging
unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.
Is the printer still printing blank pages?
Step 2
a Redistribute the toner in the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.
Is the printer still printing blank pages?
Step 3
Replace the imaging unit, and then resend the print job.
Is the printer still printing blank pages?

Printer is printing solid black pages
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Action

Yes

No

Step 1
a Reinstall the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.

Go to step 2.

The problem is solved.

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1

Go to step 2.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
2 Install the imaging unit, and then the cartridge.

b Resend the print job.
Is the printer printing solid black pages?
Step 2
Replace the imaging unit, and then resend the print job.
Is the printer printing solid black pages?

Repeating defects appear on prints

Measure the distance between the defects.
Check for a distance between the defects that equals:

• 97 mm (3.82 in.)
• 47 mm (1.85 in.)
• 38 mm (1.5 in.)
Is the distance between defects equal to one of the listed measurements?

Step 2
Replace the imaging unit, and then resend the print job.
Do the repeating defects still appear?

1 Check if the
distance between
the defects equal
to 80 mm (3.15 in.)
2 Take note of the
distance, and then
contact customer
support at
http://support.le
xmark.com or
your service
representative.

Contact customer
The problem is solved.
support at
http://support.lexma
rk.com or your service
representative.
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Shadow images appear on prints
Leading edge

A
AB
BC
CD
D
A
B
C
D
ABCD
Trailing edge

Action

Yes

No

Step 1

Go to step 2.

Load paper with the
correct paper type and
weight in the tray.

Go to step 3.

Change the paper
loaded in the tray to
match the paper type
and weight specified in
the tray settings.

Go to step 4.

The problem is solved.

Contact customer
support.

The problem is solved.

Load paper with the correct paper type and weight in the tray.
Is paper with the correct paper type and weight loaded in the tray?
Step 2
From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.
Is the tray set to the type and weight of the paper loaded?
Step 3
a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.
b Resend the print job.
Do shadow images still appear on prints?
Step 4
Replace the imaging unit, and then resend the print job.
Do shadow images still appear on prints?

Skewed print

)E
) D
ABC
E
ABCD E
ABCD
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Yes

Step 1
Go to step 2.
a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded.
b Resend the print job.

No
The problem is solved.

Is the print still skewed?
Step 2
a Check if you are printing on a paper that is supported by the tray.

Contact customer
support.

The problem is solved.

Yes

No

b Resend the print job.
Is the print still skewed?

Streaked horizontal lines appear on prints

ABCDE
ABCDE
ABCDE
Action

Step 1
Go to step 2.
a Depending on your operating system, specify the tray or feeder from
Printing Preferences or the Print dialog.
b Resend the print job.

The problem is solved.

Do streaked horizontal lines appear on prints?
Step 2

Go to step 3.

Change the paper type
and weight to match
the paper loaded in the
tray.

Go to step 4.

The problem is solved.

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.
Do the paper type and weight match the type and weight of the paper in
the tray?
Step 3
a Load paper from a fresh package.
Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Do streaked horizontal lines appear on prints?
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Action

Yes

No

Step 4
a Reinstall the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.

Go to step 5.

The problem is solved.

Contact customer
support.

The problem is solved.

Yes

No

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
2 Install the imaging unit, and then the cartridge.

b Resend the print job.
Do streaked horizontal lines appear on prints?
Step 5
Replace the imaging unit, and then resend the print job.
Do streaked horizontal lines appear on prints?

Streaked vertical lines appear on prints
Leading edge

ABCDE
ABCDE
ABCDE
Trailing edge

Action

Go to step 2.
Step 1
a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.
b Resend the print job.

The problem is solved.

Do streaked vertical lines appear on prints?
Step 2
From the printer control panel, set the paper texture, type, and weight in
the Paper menu to match the paper loaded in the tray.
Do the paper texture, type, and weight match the paper in the tray?

Go to step 3.

Do one or more of the
following:

• Specify the paper
texture, type, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the paper
loaded in the tray
to match the paper
texture, type, and
weight specified in
the tray settings.
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Action

Yes

No

Step 3
a Load paper from a fresh package.

Go to step 4.

The problem is solved.

Go to step 5.

The problem is solved.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.
b Resend the print job.
Do streaked vertical lines appear on prints?
Step 4
a Reinstall the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
2 Install the imaging unit, and then the cartridge.

b Resend the print job.
Do streaked vertical lines appear on prints?
Step 5
Replace the imaging unit, and then resend the print job.
Do streaked vertical lines appear on prints?

The problem is solved.
Contact customer
support at
http://support.lexmar
k.com or your service
representative.

Toner fog or background shading appears on prints

ABCDE
ABCDE
ABCDE
Action

Yes

No

Step 1
Reinstall the imaging unit.
a Remove, and then install the imaging unit.

Go to step 2.

The problem is solved.

b Resend the print job.
Does fog or shading appear on prints?
Step 2
Replace the imaging unit, and then resend the print job.
Does fog or shading appear on prints?

Contact customer
The problem is solved.
support at
http://support.lexmar
k.com or your service
representative.
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Toner rubs off
Leading edge

ABC
DEF
Trailing edge

Action

Yes

No

Step 1

Go to step 2.

Specify the paper type,
texture, and weight
from the tray settings
to match the paper
loaded in the tray.

Contact customer
support.

The problem is solved.

Action

Yes

No

Replace the imaging unit, and then resend the print job.

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1

Go to step 2.

Set the paper type to
Transparency.

Contact customer
support.

The problem is solved.

From the Paper menu on the printer control panel, check the paper type,
texture, and weight.
Do the paper type, texture, and weight match the paper loaded in the
tray?
Step 2
Resend the print job.
Does the toner still rub off?

Toner specks appear on prints

Do toner specks appear on prints?

Transparency print quality is poor

From the printer control panel, set the paper type in the Paper menu to
match the paper loaded in the tray.
Is the paper type for the tray set to Transparency?
Step 2
a Check if you are using a recommended type of transparency.

b Resend the print job.
Is the print quality still poor?
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Uneven print density

Action

Yes

No

Replace the imaging unit, and then resend the print job.

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1
a Make sure your software program is using a correct fill pattern.

Go to step 2.

The problem is solved.

Go to step 3.
Step 2
a From the printer control panel, set the paper type and weight in the
Paper menu to match the paper loaded in the tray.
b Resend the print job.

The problem is solved.

Is the print density uneven?

Vertical voids appear on prints
Leading edge

Trailing edge

b Resend the print job.
Do vertical voids appear on prints?

Do vertical voids appear on prints?
Step 3
Go to step 4.
Check if you are using a recommended type of paper.
a Load the specified tray or feeder with a recommended type of paper.

b Resend the print job.
Do vertical voids appear on prints?

The problem is solved.
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Action

Yes

No

Step 4
a Redistribute the toner in the imaging unit.
1 Remove the toner cartridge, and then the imaging unit.

Go to step 5.

The problem is solved.

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1

Clear the error or status Go to step 2.
message.

2 Firmly shake the imaging unit.
Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.
3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.
Do vertical voids appear on prints?
Step 5
Replace the imaging unit, and then resend the print job.
Do vertical voids appear on prints?

Solving copy problems
•
•
•
•

“Copier does not respond” on page 220
“Scanner unit does not close” on page 221
“Poor copy quality” on page 221
“Partial document or photo copies” on page 222

Copier does not respond

Check if an error or status message appears on the display.
Does an error or status message appear?
Step 2
Check if the power cord is plugged into the printer and a properly
grounded electrical outlet.

Go to step 3.

Connect the power
cord to the printer and
a properly grounded
electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?
The problem is solved. Contact customer
support.
Turn off the printer, then wait for about 10 seconds, and then turn it back
on.
Step 3

Did Performing Self Test and Ready appear?
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Scanner unit does not close
Action

Yes

No

Check if there are no obstructions between the scanner unit and the
printer.
a Lift the scanner unit.

The problem is solved. Contact customer
support.

b Remove any obstruction that keeps the scanner unit open.
c Lower the scanner unit.
Did the scanner unit close properly?

Poor copy quality
Action

Yes

Step 1

Clear the error or status Go to step 2.
message.

Check if an error or status message appears on the display.

No

Does an error or status message appear?
Step 2
Check the quality of the original document.

Go to step 3.

Increase the scan
resolution setting for a
higher‑quality output.

Go to step 4.

See “Cleaning the
scanner glass” on
page 152.

Go to step 5.

See “Print quality
problems” on
page 202.

Go to step 6.

Place the document or
photo facedown on the
scanner glass in the
upper left corner.

Is the quality of the original document satisfactory?
Step 3
If dark marks appear on prints, then clean the scanner glass and the ADF
glass using a clean, lint-free cloth dampened with water.
Is the scanner glass clean?
Step 4
Send a print job, and then check for print quality problems.
a From the General Settings menu, adjust the Eco‑Mode settings.

b From the Copy menu, adjust the Darkness setting.
c If the print remains faded, then replace the toner cartridge.
Is the print quality satisfactory?
Step 5
Check the placement of the document or photo.
Make sure the document or photo is loaded facedown on the scanner
glass in the upper left corner.
Is the document or photo loaded correctly?
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Action

Yes

No

Step 6

Go to step 7.

Change the Content
Type and Content
Source settings to
match the document
being scanned.

Go to step 8.

The problem is solved.

Go to step 9.

The problem is solved.

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1

Go to step 2.

Place the document or
photo facedown on the
scanner glass in the
upper left corner.

Check the copy settings.
From the Copy screen, check if the Content Type and Content Source
settings are correct for the document being scanned.
Are the Content Type and Content Source settings correct for the
document being scanned?
Step 7
Check for patterns on print.
a From the printer control panel, navigate to:
Copy > Sharpness > select a lower setting
Note: Make sure no scaling is being selected.

b Resend the copy job.
Do patterns appear on prints?
Step 8
Check for missing or faded text on prints.
a From the Copy screen, adjust the settings of the following:

• Sharpness—Increase the sharpness setting.
• Contrast—Increase the contrast setting.
b Resend the copy job.
Do prints have missing or faded text?
Step 9
Check for washed‑out or overexposed output.
a From the Copy screen, adjust the settings of the following:

• Background Removal—Reduce the current setting.
• Darkness—Increase the current setting.
b Resend the copy job.
Do pages show washed‑out or overexposed prints?

Partial document or photo copies

Check the placement of the document or photo.
Make sure the document or photo is loaded facedown on the scanner
glass in the upper left corner.
Is the document or photo loaded correctly?
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Action

Yes

No

Step 2

Go to step 3.

Change the paper size
setting to match the
paper loaded in the
tray, or load the tray
with paper that
matches the paper size
setting.

Check if the paper size setting matches the size of the paper loaded in the
tray.
From the Paper menu on the printer control panel, check the Paper
Size setting.
Does the paper size setting match the size of the paper loaded in the tray.

The problem is solved. Contact customer
Step 3
support.
a Specify the paper size. Depending on your operating system, specify
the paper size in Printing Preferences or the Print dialog.
b Resend the print job.
Do copies print properly?

Solving fax problems
•
•
•
•
•
•

“Fax function is not set up” on page 223
“Caller ID is not shown” on page 224
“Cannot send or receive a fax” on page 225
“Can send but not receive faxes” on page 227
“Can receive but not send faxes” on page 228
“Received fax has poor print quality” on page 229

Fax function is not set up
Before completing these instructions for network printers, check if the fax cables are connected.
Note: The indicator light blinks red until you set up fax.
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Action

Yes

The problem is solved. Contact customer
support.

a From the printer control panel, navigate to:
> Settings >

No

> General Settings >

> Run initial setup >

>

b Turn off the printer, and then turn it back on.
The “Select your language” screen appears on the printer display.

c Select a language, and then press

.

d Select a country or region, and then press

.

e Select a time zone, and then press
.
f Press the up or down arrow button to scroll to Fax, and then press
.
Is the fax function set up?

Caller ID is not shown
Action

Yes

Contact your telephone company to check if your telephone line is
subscribed to the caller ID service.

The problem is solved. Contact customer
support.

Notes:

• If your region supports multiple caller ID patterns, then you may
have to change the default setting. There are two settings
available: FSK (pattern 1) and DTMF (pattern 2).

• The availability of these settings in the Fax menu depends on
whether your country or region supports multiple caller ID
patterns.

• Contact your telephone company to determine which pattern or
switch setting to use.
Does the caller ID appear?

No
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Cannot send or receive a fax
Action

Yes

Step 1

Clear the error or status Go to step 2.
message.

Check if an error or status message appears on the display.

No

Is there an error or status message on the display?
Step 2

Go to step 3.

Connect the power
cord to the printer and
a properly grounded
electrical outlet.

Go to step 4.

Turn on the printer,
and then wait until
Ready appears on the
display.

Go to step 5.

Securely connect the
cables.

Check if the power cord is plugged into the printer and a properly
grounded electrical outlet.
Is the power cord plugged into the printer and a properly grounded
electrical outlet?
Step 3
Check the power.
Check if the printer is plugged in and turned on, and if Ready appears
on the display.
Is the printer turned on, and does Ready appear on the display?
Step 4
Check the printer connections.
If applicable, check if the cable connections for the following
equipment are secure:

• Telephone
• Handset
• Answering machine
Are the cable connections secure?
Step 5
a Check the telephone wall jack.
1 Plug the telephone cable into the wall jack.

2 Listen for a dial tone.
3 If you do not hear a dial tone, then plug a different telephone cable
into the wall jack.
4 If you still do not hear a dial tone, then plug the telephone cable
into a different wall jack.
5 If you hear a dial tone, then connect the printer to that wall jack.

b Try sending or receiving a fax.
Can you send or receive a fax?

The problem is solved. Go to step 6.
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Action

Yes

No

Step 6

Go to step 7.

Connect the printer to
an analog phone
service or the correct
digital connector.

Go to step 8.

• Try calling the fax

Check if the printer is connected to an analog phone service or the correct
digital connector.
The fax modem is an analog device. Certain devices can be connected
to the printer so that digital telephone services can be used.

• If you are using an ISDN telephone service, then connect the
printer to an analog telephone port (an R-interface port) on an
ISDN terminal adapter. For more information and to request an Rinterface port, contact your ISDN provider.

• If you are using DSL, then connect to a DSL filter or router that will
support analog use. For more information, contact your DSL
provider.

• If you are using a PBX telephone service, then make sure you are
connecting to an analog connection on the PBX. If none exists, then
consider installing an analog telephone line for the fax machine.
Is the printer connected to an analog phone service or the correct digital
connector?
Step 7
Check for a dial tone.
Did you hear a dial tone?

number to make
sure that it is
working properly.

• If the telephone
line is being used by
another device,
then wait until the
other device is
finished before
sending a fax.

• If you are using the
On Hook Dial
feature, then turn
up the volume to
check if you hear a
dial tone.
Step 8
The problem is solved. Go to step 9.
Temporarily disconnect other equipment (such as answering machines,
computers with modems, or telephone line splitters) between the printer
and the telephone line, and then try sending or receiving a fax.
Can you send or receive a fax?
The problem is solved. Go to step 10.
Step 9
a Temporarily disable call waiting. Contact your telephone company to
obtain the keypad sequence for temporarily disabling call waiting.
b Try sending or receiving a fax.
Can you send or receive a fax?
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Yes

No

The problem is solved. Go to step 11.
Step 10
a Temporarily disable voice mail service. For more information, contact
your telephone company.
Note: If you want to use both voice mail and the printer, then
consider adding a second telephone line for the printer.
b Try sending or receiving a fax.
Can you send or receive a fax?
Step 11
Scan the original document one page at a time.
a Dial the fax number.

The problem is solved. Contact customer
support.

b Scan the document one page at a time.
Can you send or receive a fax?

Can send but not receive faxes
Action

Yes

No

Step 1

The problem is solved. Go to step 2.

Check the tray or feeder.
If empty, then load paper in the tray or feeder.
Can you receive faxes?
Step 2

The problem is solved. Go to step 3.

Check the ring count delay settings.
a Open a Web browser, and then type the printer IP address in the
address field.
Notes:

• View the printer IP address in the TCP/IP section in the
Network/Ports menu. The IP address appears as four sets of
numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to
load the Web page correctly.

b Click Settings > Fax Settings > Analog Fax Setup.
c In the “Rings to Answer” field, enter the number of times you want
the phone to ring before the printer answers.
d Click Submit.
Can you receive faxes?
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Action

Yes

Step 3

The problem is solved. Contact customer
support.

Replace the toner cartridge. For more information, see the instruction
sheet that came with the supply.

No

Can you receive faxes?

Can receive but not send faxes
Action

Yes

No

Step 1

The problem is solved. Go to step 2.

Check if the printer is in Fax mode.
From the printer control panel, press Fax to put the printer in fax
mode, and then resend the fax job.
Can you send faxes?
The problem is solved. Go to step 3.
Step 2
a Load the original document faceup, short edge first into the ADF tray
or facedown on the scanner glass in the upper left corner.
Notes:

• Do not load postcards, photos, small items, transparencies,
photo paper, or thin media (such as magazine clippings) into
the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded
properly.
b Resend the fax job.
Can you send faxes?
Step 3
a Check if the shortcut number is configured for the number that you
want to dial.
Note: As an alternative, you can dial the telephone number
manually.
b Resend the fax job.
Can you send faxes?

The problem is solved. Contact customer
support.
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Received fax has poor print quality
Action

Yes

No

Step 1

The problem is solved. Go to step 2.

Ask the person who sent you the fax to:
a Check if the quality of the original document is satisfactory.

b Increase the fax scan resolution, if possible.
c Resend the fax. There may have been a problem with the quality of
the telephone line connection.
Is the fax print quality satisfactory?
Step 2

The problem is solved. Go to step 3.

Decrease the incoming fax transmission speed.
a Open a Web browser, and then type the printer IP address in the
address field.
Notes:

• View the printer IP address in the TCP/IP section in the
Network/Ports menu. The IP address appears as four sets of
numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to
load the Web page correctly.

b Click Settings > Fax Settings > Analog Fax Setup.
c In the Max Speed menu, click one of the following:
• 2400
• 4800
• 9600
• 14400
• 33600
d Click Submit.
e Resend the fax.
Is the fax print quality satisfactory?
Step 3
Replace the toner cartridge.
When Cartridge low [88.xy] appears, replace the cartridge,
and then resend the fax.
Is the fax print quality satisfactory?

Solving scanner problems
• “The scanner does not respond” on page 230
• “Scan job was not successful” on page 231
• “Scanner unit does not close” on page 231

The problem is solved. Contact customer
support.
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• “Scanning takes too long or freezes the computer” on page 231
• “Poor scanned image quality” on page 232
• “Partial document or photo scans” on page 233

The scanner does not respond
Action

Yes

No

Step 1

Go to step 2.

Turn on the printer.

Go to step 3.

Connect the printer
cable securely to the
printer and the
computer, print server,
option, or other
network device.

Go to step 4.

Connect the power
cord to the printer and
a properly grounded
electrical outlet.

Turn on the switch or
reset the breaker.

Go to step 5.

Check if the printer is turned on.
Is the printer turned on?
Step 2
Check if the printer cable is securely attached to the printer and the
computer, print server, option, or other network device.
Is the printer cable securely attached to the printer and the computer,
print server, option, or other network device?
Step 3
Check if the power cord is plugged into the printer and a properly
grounded electrical outlet.
Is the power cord plugged into the printer and a properly grounded
electrical outlet?
Step 4
Check if the electrical outlet is turned off by a switch or breaker.
Is the electrical outlet turned off by a switch or breaker?
Step 5

Connect the printer
Go to step 6.
power
cord
directly
to
Check if the printer is plugged into any surge protectors, uninterruptible
a properly grounded
power supplies, or extension cords.
electrical outlet.
Is the printer plugged into any surge protectors, uninterruptible power
supplies, or extension cords?
Step 6
Check other electrical equipment plugged into the outlet.
Are the other electrical equipment working?

Step 7
Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.
Are the printer and scanner working?

Unplug the other
Go to step 7.
electrical equipment
and turn on the printer.
If the printer does not
work, then reconnect
the other electrical
equipment and then go
to step 6.
The problem is solved. Contact customer
support.
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Scan job was not successful
Action

Yes

No

Step 1

Go to step 2.

Connect the cables
properly.

Change the file name.

Go to step 3.

Close the file you are
scanning.

Go to step 4.

Check the cable connections.
Make sure the Ethernet or USB cable is securely connected to the
computer and the printer.
Are the cables securely connected?
Step 2
Check if the file name is already in use.
Is the file name already in use?
Step 3
Check if the document or photo you want to scan is open in another
application or being used by another user.
Is the file you want to scan open by another application or user?
Contact customer
Check if either the Append time stamp or the Overwrite existing file check support.
box is selected in the destination configuration settings.
Step 4

Is the Append time stamp or Overwrite existing file check box selected
in the destination configuration settings?

Select the Append time
stamp or Overwrite
existing file check box
in the destination
configuration settings.

Scanner unit does not close
Action

Yes

No

Check if there are obstructions in the scanner unit.
a Lift the scanner unit.

The problem is solved. Contact customer
support.

b Remove any obstruction keeping the scanner unit open.
c Lower the scanner unit.
Did the scanner unit close correctly?

Scanning takes too long or freezes the computer
Action

Yes

No

Step 1

Go to step 2.

The problem is solved.

Check if other applications are interfering with the scan.
Close all applications that are not being used.
Does scanning still take too long or freeze the computer?
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Action

Yes

No

Step 2

Contact customer
support.

The problem is solved.

Action

Yes

No

Step 1

Clear the error
message.

Go to step 2.

Go to step 3.

Increase the scan
resolution settings for a
higher‑quality output.

Go to step 4.

See “Cleaning the
scanner glass” on
page 152.

Go to step 5.

Place the document or
photo facedown on the
scanner glass in the
upper left corner.

Go to step 6.

See “Print quality
problems” on
page 202.

Select a lower scan resolution.
Does scanning still take too long or freeze the computer?

Poor scanned image quality

Check if an error message appears on the display.
Is there an error message on the printer display?
Step 2
Check the quality of the original document.
Is the quality of the original document satisfactory?
Step 3
Clean the scanner glass and the ADF glass using a clean, lint‑free cloth
dampened with water.
Is the scanner glass clean?
Step 4
Check the placement of the document or photo.
Make sure the document or photo is loaded facedown on the scanner
glass in the upper left corner.
Is the document or photo loaded correctly?
Step 5
Send a print job, and then check for print quality problems.

• From the General Settings menu, adjust the Eco‑Mode settings.
• From the Copy menu, adjust the Darkness setting.
• When the print becomes faded, replace the toner cartridge.
Is the print quality satisfactory?
Step 6
Go to step 7.
Check the scan settings.
From the Scan screen, make sure the Content Type and Content Source
settings are correct for the document being scanned.
Are the Content Type and Content Source settings correct for the
document being scanned?

Change the Content
Type and Content
Source settings to
match the document
being scanned.
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Action

Yes

No

Step 7

Problem solved.

Contact customer
support.

Yes

No

Increase the scan resolution settings for a higher‑quality output.
Did the increased resolution produce a higher‑quality output?

Partial document or photo scans
Action

Check the placement of the document or photo.
Contact customer
Make sure the document or photo is loaded facedown on the scanner support.
glass in the upper left corner.

Load the document or
photo facedown on the
scanner glass in the
upper left corner.

Is the document or photo loaded correctly?

Embedded Web Server does not open
Action

Yes

No

Step 1
a Turn on the printer.

The problem is solved. Go to step 2.

b Open a Web browser, and then type the printer IP address.
c Press Enter.
Does the Embedded Web Server open?
Step 2

The problem is solved. Go to step 3.

Make sure the printer IP address is correct.
a View the printer IP address:

• From the TCP/IP section in the Network/Ports menu
• By printing a network setup page or menu settings page, and then
finding the TCP/IP section
Note: An IP address appears as four sets of numbers separated
by periods, such as 123.123.123.123.
b Open a Web browser, and then type the IP address.
Note: Depending on the network settings, you may need to type
“https://” instead of “http://” before the printer IP address
to access the Embedded Web Server.
c Press Enter.
Does the Embedded Web Server open?
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Action

Yes

No

Step 3

The problem is solved. Go to step 4.

Check if the network is working.
a Print a network setup page.

b Check the first section of the network setup page and confirm that the
status is Connected.
Note: If the status is Not Connected, then the connection may be
intermittent, or the network cable may be defective. Contact your
system support person for a solution, and then print another
network setup page.
c Open a Web browser, and then type the printer IP address.

d Press Enter.
Does the Embedded Web Server open?
Step 4

The problem is solved. Go to step 5.

Check if the cable connections to the printer and print server are secure.
a Connect the cables properly. For more information, see the setup
documentation that came with the printer.
b Open a Web browser, and then type the printer IP address.

c Press Enter.
Does the Embedded Web Server open?
Step 5
Temporarily disable the Web proxy servers.
Proxy servers may block or restrict you from accessing certain Web
sites including the Embedded Web Server.

The problem is solved. Contact your system
support person.

Does the Embedded Web Server open?

Contacting customer support
When you contact customer support, you will need to be able to describe the problem you are experiencing, the message
on the printer display, and the troubleshooting steps you have already taken to find a solution.
You need to know your printer model type and serial number. For more information, see the label at the back of the
printer. The serial number is also listed on the menu settings page.
Lexmark has various ways to help you solve your printing problem. Visit the Lexmark Web site at
http://support.lexmark.com, and then select one of the following:
Tech Library You can browse our library of manuals, support documentation, drivers, and other downloads to help you
solve common problems.
E-mail

You can send an e-mail to the Lexmark team, describing your problem. A service representative will respond
and provide you with information to solve your problem.
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You can chat directly with a service representative. They can work with you to solve your printer problem or
provide assistance through Assisted Service where the service representative can remotely connect to your
computer through the Internet to troubleshoot problems, install updates, or complete other tasks to help
you successfully use your Lexmark product.

Telephone support is also available. In the U.S. or Canada, call 1-800-539-6275. For other countries or regions, visit
http://support.lexmark.com.
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Notices
Product information
Product name:
Lexmark MX310dn
Machine type:
7015
Model(s):
270

Edition notice
September 2014
The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.
This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.
References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.
For Lexmark technical support, visit http://support.lexmark.com.
For information on supplies and downloads, visit www.lexmark.com.
© 2014 Lexmark International, Inc.
All rights reserved.

GOVERNMENT END USERS
The Software Program and any related documentation are "Commercial Items," as that term is defined in 48 C.F.R.
2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R.
12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227.7202-1 through 227.7207-4,
as applicable, the Commercial Computer Software and Commercial Software Documentation are licensed to the U.S.
Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users
pursuant to the terms and conditions herein.
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Licensing notices
All licensing notices associated with this product can be viewed from the root directory of the installation software CD.

Trademarks
Lexmark, Lexmark with diamond design, and MarkVision are trademarks of Lexmark International, Inc., registered in
the United States and/or other countries.
PrintCryption is a trademark of Lexmark International, Inc.
Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.
PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s designation of a
set of printer commands (language) and functions included in its printer products. This printer is intended to be
compatible with the PCL language. This means the printer recognizes PCL commands used in various application
programs, and that the printer emulates the functions corresponding to the commands.
The following terms are trademarks or registered trademarks of these companies:
Albertus

The Monotype Corporation plc

Antique Olive

Monsieur Marcel OLIVE

Apple-Chancery

Apple Computer, Inc.

Arial

The Monotype Corporation plc

CG Times

Based on Times New Roman under license from The Monotype Corporation plc, is a product of
Agfa Corporation

Chicago

Apple Computer, Inc.

Clarendon

Linotype-Hell AG and/or its subsidiaries

Eurostile

Nebiolo

Geneva

Apple Computer, Inc.

GillSans

The Monotype Corporation plc

Helvetica

Linotype-Hell AG and/or its subsidiaries

Hoefler

Jonathan Hoefler Type Foundry

ITC Avant Garde Gothic International Typeface Corporation
ITC Bookman

International Typeface Corporation

ITC Mona Lisa

International Typeface Corporation

ITC Zapf Chancery

International Typeface Corporation

Joanna

The Monotype Corporation plc

Marigold

Arthur Baker

Monaco

Apple Computer, Inc.

New York

Apple Computer, Inc.

Oxford

Arthur Baker

Palatino

Linotype-Hell AG and/or its subsidiaries
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Stempel Garamond

Linotype-Hell AG and/or its subsidiaries

Taffy

Agfa Corporation

Times New Roman

The Monotype Corporation plc

Univers

Linotype-Hell AG and/or its subsidiaries

All other trademarks are the property of their respective owners.
AirPrint and the AirPrint logo are trademarks of Apple, Inc.

Federal Communications Commission (FCC) compliance information statement
This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.
The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

•
•
•
•

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.
Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.
Any questions regarding this compliance information statement should be directed to:
Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Noise emission levels
The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.
Note: Some modes may not apply to your product.
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1-meter average sound pressure, dBA
Printing

One-sided: 53; Two-sided: 52

Scanning

55

Copying

54

Ready

N/A

Values are subject to change. See www.lexmark.com for current values.

Temperature information
Ambient operating temperature

15.6 to 32.2°C (60 to 90°F)

Shipping temperature

-40 to 43.3°C (-40 to 110°F)

Storage temperature and relative humidity

1 to 35°C (34 to 95°F)
8 to 80% RH

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products.
If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for your local
sales office phone number.

India E-Waste notice
This product complies with the India E-Waste (Management and Handling) Rules, 2011, which prohibit use of lead,
mercury, hexavalent chromium, polybrominated biphenyls, or polybrominated diphenyl ethers in concentrations
exceeding 0.1％ by weight and 0.01% by weight for cadmium, except for the exemption set in Schedule II of the Rules.

Product disposal
Do not dispose of the printer or supplies in the same manner as normal household waste. Consult your local authorities
for disposal and recycling options.
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Static sensitivity notice

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the
metal frame of the printer.

ENERGY STAR
Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

Laser notice
The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, Chapter I, Subchapter J for Class I
(1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.
Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is
nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system
and printer are designed so there is never any human access to laser radiation above a Class I level during normal
operation, user maintenance, or prescribed service condition.

Laser advisory label
A laser notice label may be affixed to this printer as shown:
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DANGER - Invisible laser radiation when cartridges are removed and interlock defeated. Avoid exposure to laser beam.
PERIGO - Radiação a laser invisível será liberada se os cartuchos forem removidos e o lacre rompido. Evite a exposição aos feixes de laser.
Opasnost - Nevidljivo lasersko zračenje kada su kasete uklonjene i poništena sigurnosna veza. Izbjegavati izlaganje zracima.
NEBEZPEČÍ - Když jsou vyjmuty kazety a je odblokována pojistka, ze zařízení je vysíláno neviditelné laserové záření. Nevystavujte se působení laserového paprsku.
FARE - Usynlig laserstråling, når patroner fjernes, og spærreanordningen er slået fra. Undgå at blive udsat for laserstrålen.
GEVAAR - Onzichtbare laserstraling wanneer cartridges worden verwijderd en een vergrendeling wordt genegeerd. Voorkom blootstelling aan de laser.
DANGER - Rayonnements laser invisibles lors du retrait des cartouches et du déverrouillage des loquets. Eviter toute exposition au rayon laser.
VAARA - Näkymätöntä lasersäteilyä on varottava, kun värikasetit on poistettu ja lukitus on auki. Vältä lasersäteelle altistumista.
GEFAHR - Unsichtbare Laserstrahlung beim Herausnehmen von Druckkassetten und offener Sicherheitssperre. Laserstrahl meiden.
ΚΙΝΔΥΝΟΣ - Έκλυση αόρατης ακτινοβολίας laser κατά την αφαίρεση των κασετών και την απασφάλιση της μανδάλωσης. Αποφεύγετε την έκθεση στην ακτινοβολία laser.
VESZÉLY – Nem látható lézersugárzás fordulhat elő a patronok eltávolításakor és a zárószerkezet felbontásakor. Kerülje a lézersugárnak való kitettséget.
PERICOLO - Emissione di radiazioni laser invisibili durante la rimozione delle cartucce e del blocco. Evitare l´esposizione al raggio laser.
FARE – Usynlig laserstråling når kassettene tas ut og sperren er satt ut av spill. Unngå eksponering for laserstrålen.
NIEBEZPIECZEŃSTWO - niewidzialne promieniowanie laserowe podczas usuwania kaset i blokady. Należy unikać naświetlenia promieniem lasera.
ОПАСНО! Невидимое лазерное излучение при извлеченных картриджах и снятии блокировки. Избегайте воздействия лазерных лучей.
Pozor – Nebezpečenstvo neviditeľného laserového žiarenia pri odobratých kazetách a odblokovanej poistke. Nevystavujte sa lúčom.
PELIGRO: Se producen radiaciones láser invisibles al extraer los cartuchos con el interbloqueo desactivado. Evite la exposición al haz de láser.
FARA – Osynlig laserstrålning när patroner tas ur och spärrmekanismen är upphävd. Undvik exponering för laserstrålen.
危险 - 当移除碳粉盒及互锁失效时会产生看不见的激光辐射，请避免暴露在激光光束下。
危險 - 移除碳粉匣與安全連續開關失效時會產生看不見的雷射輻射。請避免曝露在雷射光束下。
危険 - カートリッジが取り外され、内部ロックが無効になると、見えないレーザー光が放射されます。 このレーザー光に当たらないようにしてください。

Power consumption
Product power consumption
The following table documents the power consumption characteristics of the product.
Note: Some modes may not apply to your product.
Mode

Description

Power consumption
(Watts)

Printing

The product is generating hard‑copy output from electronic inputs.

One-sided: 520; Two-sided:
340

Copy

The product is generating hard‑copy output from hard‑copy original documents. 540

Scan

The product is scanning hard‑copy documents.

20

Ready

The product is waiting for a print job.

11

Sleep Mode The product is in a high‑level energy‑saving mode.

3.2

Hibernate

The product is in a low‑level energy‑saving mode.

0.4

Off

The product is plugged into an electrical outlet, but the power switch is turned 0
off.

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.
Values are subject to change. See www.lexmark.com for current values.
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Sleep Mode
This product is designed with an energy-saving mode called Sleep Mode. The Sleep Mode saves energy by lowering
power consumption during extended periods of inactivity. The Sleep Mode is automatically engaged after this product
is not used for a specified period of time, called the Sleep Mode Timeout.
Factory default Sleep Mode Timeout for this product (in minutes):

20

By using the configuration menus, the Sleep Mode Timeout can be modified between 1 minute and 120 minutes. Setting
the Sleep Mode Timeout to a low value reduces energy consumption, but may increase the response time of the product.
Setting the Sleep Mode Timeout to a high value maintains a fast response, but uses more energy.

Hibernate Mode
This product is designed with an ultra‑low power operating mode called Hibernate mode. When operating in Hibernate
Mode, all other systems and devices are powered down safely.
The Hibernate mode can be entered in any of the following methods:

• Using the Hibernate Timeout
• Using the Schedule Power modes
• Using the Sleep/Hibernate button
Factory default Hibernate Timeout for this product in all countries or regions

3 days

The amount of time the printer waits after a job is printed before it enters Hibernate mode can be modified between
one hour and one month.

Off mode
If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the electrical outlet.

Total energy usage
It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.

Industry Canada compliance statement
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.

Avis de conformité aux normes de l’industrie du Canada
Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.
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日本の VCCI 規定
製品にこのマークが表示されている場合、次の要件を満たしています。

この装置は、クラス B 情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この
装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。
取扱説明書に従って正しい取り扱いをしてください。
VCCI-B

European Community (EC) directives conformity
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC,
2009/125/EC, and 2011/65/EU on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits, the
ecodesign of energy-related products, and on the restrictions of use of certain hazardous substances in electrical and
electronic equipment.
The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY. A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950‑1.

Regulatory notices for telecommunication terminal equipment
This section contains regulatory information pertaining to products that contain telecommunication terminal
equipment such as facsimile.

Notice to users of the US telephone network: FCC requirements
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council
for Terminal Attachments (ACTA). On the back of this equipment is a label that contains, among other information, a
product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to your telephone
company.
This equipment uses the RJ-11C Universal Service Order Code (USOC) jack.
A plug and jack used to connect this equipment to the premises’ wiring and telephone network must comply with the
applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is
provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See your
setup documentation for more information.
The Ringer Equivalence Number (REN) is used to determine the number of devices that may be connected to a telephone
line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most
but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be

Notices

244

connected to a line, as determined by the total RENs, contact your local telephone company. For products approved
after July 23, 2001, the REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX.
The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products,
the REN is shown separately on the label.
If this equipment causes harm to the telephone network, the telephone company will notify you in advance that
temporary discontinuance of service may be required. If advance notice is not practical, the telephone company will
notify the customer as soon as possible. You will also be advised of your right to file a complaint with the FCC.
The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the
operation of this equipment. If this happens, the telephone company will provide advance notice in order for you to
make necessary modifications to maintain uninterrupted service.
If you experience trouble with this equipment, for repair or warranty information, contact Lexmark International, Inc.
at www.lexmark.com or your Lexmark representative. If the equipment is causing harm to the telephone network, the
telephone company may request that you disconnect the equipment until the problem is resolved.
This equipment contains no user serviceable parts. For repair and warranty information, contact Lexmark International,
Inc. See the previous paragraph for contact information.
Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service
commission, or corporation commission for information.
If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this
equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment,
consult your telephone company or a qualified installer.
Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is
recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which this device is
connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified by UL (Underwriter's
Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in
the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical
surges.
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic
device, including fax machines, to send any message unless said message clearly contains in a margin at the top or
bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification
of the business or other entity, or other individual sending the message, and the telephone number of the sending
machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or
any other number for which charges exceed local or long-distance transmission charges.)
See your user documentation in order to program this information into your fax machine.

Notice to users of the Canadian telephone network
This product meets the applicable Industry Canada technical specifications. The Ringer Equivalence Number (REN) is
an indication of the maximum number of terminals allowed to be connected to a telephone interface. The terminus of
an interface may consist of any combination of devices, subject only to the requirement that the sum of the RENs of
all the devices does not exceed five. The modem REN is located on the rear of the equipment on the product labeling.
Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is
recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which this device is
connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified by UL (Underwriter’s
Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in
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the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical
surges.
This equipment uses CA11A telephone jacks.

Avis réservé aux utilisateurs du réseau téléphonique du Canada
Ce produit est conforme aux spécifications techniques d’Industrie Canada. Le numéro REN (ringer equivalence number :
numéro d’équivalence de sonnerie) fournit une indication du nombre maximum de terminaux pouvant être connectés
à l’interface téléphonique. En bout de ligne, le nombre d’appareils qui peuvent être connectés n’est pas directement
limité, mais la somme des REN de ces appareils ne doit pas dépasser cinq. Le numéro REN du modem est indiqué sur
l’étiquette produit située à l’arrière de l’équipement.
Les compagnies de téléphone constatent que les surtensions électriques, en particulier celles dues à la foudre,
entraînent d'importants dégâts sur les terminaux privés connectés à des sources d’alimentation CA. Il s’agit-là d’un
problème majeur d’échelle nationale. En conséquence, il vous est recommandé de brancher un parasurtenseur dans
la prise de courant à laquelle l’équipement est connecté. Utilisez un parasurtenseur répondant à des caractéristiques
nominales satisfaisantes et certifié par le laboratoire d’assureurs UL (Underwriter’s Laboratories), un autre laboratoire
agréé de type NRTL (Nationally Recognized Testing Laboratory) ou un organisme de certification agréé dans votre région
ou pays. Ceci prévient tout endommagement de l’équipement causé par les orages et autres surtensions électriques.
Cet équipement utilise des prises de téléphone CA11A.

Notice to users of the New Zealand telephone network
The following are special conditions for the Facsimile User Instructions. The grant of a telepermit for any item of terminal
equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection
to its network. It indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above
all, it provides no assurance that any item will work correctly in all respects with another item of telepermitted
equipment of a different make or model, nor does it imply that any product is compatible with all of Telecom's network
services.
This equipment shall not be set up to make automatic calls to the Telecom's 111 Emergency Service.
This equipment may not provide for the effective hand-over of a call to another device connected to the same line.
This equipment should not be used under any circumstances that may constitute a nuisance to other Telecom
customers.
Some parameters required for compliance with Telecom's telepermit requirements are dependent on the equipment
associated with this device. The associated equipment shall be set to operate within the following limits for compliance
to Telecom's specifications:

• There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual
call initiation, and

• The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the
beginning of the next call attempt.

• The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is not
less than 5 seconds between the end of one call attempt and the beginning of another.

Japanese telecom notice
The installed optional modem is in compliance with Japanese Telecommunication Law and has been Certified by JATE,
with Certification Number A11-0160001.
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Lexmark International, Inc.
LEX-M03-002
A11-0160001JP

Using this product in Switzerland
This product requires a Swiss billing tone filter (Lexmark part number 80D1877) to be installed on any line which receives
metering pulses in Switzerland. The filter must be used, as metering pulses are present on all analog telephone lines
in Switzerland.

Utilisation de ce produit en Suisse
Cet appareil nécessite l’utilisation d’un filtre de tonalité de facturation suisse (nº de référence Lexmark : 80D1877)
devant être installé sur toute ligne recevant des impulsions de comptage en Suisse. Ce filtre doit être utilisé pour toute
installation car ces impulsions existent sur toutes les lignes téléphoniques suisses.

Verwendung dieses Produkts in der Schweiz
Für dieses Produkt muss ein schweizerischer Billing Tone Filter zur Zählzeichenübertragung (Lexmark Teilenummer
80D1877) für jede Leitung installiert werden, über die in der Schweiz Zeitsteuertakte übertragen werden. Die
Verwendung des Filters ist obligatorisch, da in allen analogen Telefonleitungen in der Schweiz Zeitsteuertakte
vorhanden sind.

Uso del prodotto in Svizzera
Questo prodotto richiede un filtro toni Billing svizzero, (codice Lexmark 80D1877) da installare su tutte le linee che
ricevono impulsi remoti in Svizzera. È necessario utilizzare il filtro poiché gli impulsi remoti sono presenti su tutte le
linee analogiche in Svizzera.

Notice to Users in the European Union
Products bearing the CE mark are in conformity with the protection requirements of EC Council directives 2004/108/EC,
2006/95/EC, 1999/5/EC, and 2009/125/EC on the approximation and harmonization of the laws of the Member States
relating to electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits,
radio equipment and telecommunications terminal equipment and on the ecodesign of energy‑related products.
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Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950‑1.
Refer to the table at the end of the Notices section for further compliance information.

Regulatory notices for wireless products
This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Modular component notice
Wireless‑equipped models contain the following modular component(s):
Lexmark Regulatory Type/Model LEX-M01-005; FCC ID:IYLLEXM01005; IC:2376A-M01005

Exposure to radio frequency radiation
The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Notice to users in Brazil
Este equipamento opera em carater secundario, isto e, nao tem direito a protecao contra interferencia prejudicial,
mesmo de estacoes do mesmo tipo, e nao pode causar interferencia a sistemas operando em carater primario.
(Res.ANATEL 282/2001).

Industry Canada (Canada)
This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.
This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited
per regulations of Industry Canada.
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To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.
The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.
The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)
Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :
(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.
Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.
En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.
Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.
Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.
L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.
Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Taiwan NCC RF notice statement
NCC 型式認證設備注意事項
台灣低功率射頻電機設備之使用注意事項
依據低功率電波輻射性電機管理辦法
第十二條 經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自變更頻率、加大功
率或變更原設計之特性及功能。
第十四條 低功率射頻電機之使用不得影響飛航安全及干擾合法通信；經發現有干擾現象時，應立即停用，並
改善至無干擾時方得繼續使用。前項合法通信，指依電信法規定作業之無線電通信。低功率射頻電機須忍受合
法通信或工業、科學及醫療用電波輻射性電機設備之干擾。
在 5.25 ~ 5.35 秭赫頻帶內操作之無線資訊傳輸設備，限於室內使用。

Notices

249

Notice to users in the European Union
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC,
1999/5/EC, 2009/125/EC, and 2011/65/EU on the approximation and harmonization of the laws of the Member States
relating to electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits,
radio equipment and telecommunications terminal equipment, the ecodesign of energy-related products, and on the
restrictions of use of certain hazardous substances in electrical and electronic equipment.
Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY. A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950‑1.
Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, 1999/5/EC, 2009/125/EC, and 2011/65/EU on the approximation and
harmonization of the laws of the Member States relating to electromagnetic compatibility, safety of electrical
equipment designed for use within certain voltage limits, radio equipment and telecommunications terminal
equipment, the ecodesign of energy-related products, and on the restrictions of use of certain hazardous substances
in electrical and electronic equipment.
Compliance is indicated by the CE marking.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.
The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY. A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product may be used in the countries indicated in the table below.
AT

BE

BG

CH

CY

CZ

DE

DK

EE

EL

ES

FI

FR

HR

HU

IE

IS

IT

LI

LT

LU

LV

MT

NL

NO

PL

PT

RO

SE

SI

SK

TR

UK

Česky

Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními
požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk

Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante
krav i direktiv 1999/5/EF.
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Deutsch

Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit den
grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Ελληνική

ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English

Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español

Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti

Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi

Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français

Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar

Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.

Íslenska

Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.

Italiano

Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski

Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių

Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.

Malti

Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de essentiële
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.
Norsk

Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende krav og
øvrige relevante krav i direktiv 1999/5/EF.

Polski

Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português

A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais e outras
disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.
Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.
Svenska

Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de väsentliga
egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.
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Patent acknowledgment
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Elliptic Curve Cryptography (ECC) Cipher Suites for Transport
Layer Security (TLS) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Elliptic Curve Cipher Suites with SHA-256/382 and AES Galois
Counter Mode (GCM) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Suite B Profile for Transport Layer Security (TLS) implemented
in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Addition of the Camellia Cipher Suites to Transport Layer Security
(TLS) implemented in the product or service.
The use of certain patents in this product or service is subject to the reasonable, non-discriminatory terms in the
Intellectual Property Rights (IPR) Disclosure of Certicom Corp. at the IETF for AES-CCM ECC Cipher Suites for TLS
implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for IKE and IKEv2 Authentication Using the Eliptic Curve Digital
Signature Algorithm (ECDSA) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Suite B Cryptographic Suites for IPSec implemented in the
product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Algorithms for Internet Key Exchange version 1 (IKEv1)
implemented in the product or service.

STATEMENT OF LIMITED WARRANTY FOR LEXMARK LASER PRINTERS,
LEXMARK LED PRINTERS, AND LEXMARK MULTIFUNCTION LASER PRINTERS
Lexmark International, Inc., Lexington, KY
This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the countryspecific warranty information that came with your product.
This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty
Lexmark warrants that this product:
—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts
—Is, during normal use, free from defects in material and workmanship
If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).
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If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.
If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.

Limited warranty service
The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed. Fuser Units, Transfer/Transport
Units, Paper Feed items, if any, and any other items for which a Maintenance Kit is available are substantially consumed
when the printer displays a “Life Warning” or “Scheduled Maintenance” message for such item.
To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.
When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.
The replacement item assumes the remaining warranty period of the original product.
Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.
As part of your warranty service and/or replacement, Lexmark may update the firmware in your printer to the latest
version. Firmware updates may modify printer settings and cause counterfeit and/or unauthorized products, supplies,
parts, materials (such as toners and inks), software, or interfaces to stop working. Authorized use of genuine Lexmark
products will not be impacted.
Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).
For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web.
Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty
Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.
Warranty service does not include repair of failures caused by:
—Modification or unauthorized attachments
—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance
—Unsuitable physical or operating environment
—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer
—Operation of a product beyond the limit of its duty cycle
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—Use of printing media outside of Lexmark specifications
—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts
—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark
TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

Limitation of liability
Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.
Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.
This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights
Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.
This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.
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Index
Numerics
250‑sheet tray
installing 19
550‑sheet tray
installing 19

Symbols
[x]‑page jam, clear manual feeder.
[25y.xx] 174
[x]‑page jam, clear standard bin.
[20y.xx] 171
[x]‑page jam, open automatic
feeder top cover. [28y.xx] 176
[x]‑page jam, open front door.
[20y.xx] 167
[x]‑page jam, open rear door.
[20y.xx] 170
[x]‑page jam, open tray [x].
[24y.xx] 173
[x]‑page jam, remove tray 1 to clear
duplex. [23y.xx] 172

A
accessing the remote control panel
Embedded Web Server 162
Active NIC menu 103
adapter plug 77
adding hardware options
print driver 23
address book button
printer control panel 12
ADF
copying using 55
adjusting printer display
brightness 147
adjusting Sleep mode 146
adjusting toner darkness 50
administrator settings
Embedded Web Server 162
answering machine
setting up 70
AppleTalk menu 108
arrow buttons
printer control panel 12
attaching cables 22
available internal options 15
avoiding jams 46

avoiding paper jams 165

B
back button
printer control panel 12
binding
fax options 88
blocking junk faxes 86

C
cables
Ethernet 22
USB 22
canceling
fax job 86
canceling a copy job from the
printer control panel 63
canceling a print job
from a computer 53
from the printer control panel 53
canceling an e-mail 67
cannot open Embedded Web
Server 233
card stock
loading, multipurpose feeder 34
tips 43
Cartridge low [88.xy] 177
Cartridge nearly low [88.xy] 177
Cartridge very low, [x] estimated
pages remain [88.xy] 177
Change [paper source] to [custom
string] load [paper orientation] 177
Change [paper source] to [custom
type name] load [orientation] 177
Change [paper source] to [paper
size] load [orientation] 178
Change [paper source] to [paper
type] [paper size] load
[orientation] 178
checking an unresponsive
printer 191
checking status of parts and
supplies 153
checking the status of parts and
supplies 153
cleaning
exterior of the printer 151
scanner glass 152

cleaning the printer 151
Close flatbed cover and load
originals if restarting job
[2yy.xx] 178
Close front door 178
collate
copy options 64
collating copies 61
Complex page, some data may not
have printed [39] 178
compressed images appear on
prints 203
confidential data
information on securing 150
confidential jobs
modifying print settings 52
confidential print jobs 51
printing from a Macintosh
computer 52
printing from Windows 52
configuration information
wireless network 24
Configure MP menu 96
configuring
supply notifications, imaging
unit 163
supply notifications, maintenance
kit 163
supply notifications, toner
cartridge 163
configuring e‑mail settings 66
configuring supply notifications
from the Embedded Web
Server 163
connecting to a wireless network
using PBC, Push Button
Configuration method 26
using PIN, Personal Identification
Number method 26
using the Embedded Web
Server 27
using wireless setup wizard 25
conservation settings
brightness, adjusting 147
conserving supplies 144
Eco‑Mode 145
Hibernate mode 146
Quiet mode 145

Index

Schedule Power Modes 147
Sleep mode 146
conserving supplies 144
contacting customer support 234
control panel
indicator light 13
Sleep button light 13
controller board
accessing 15
copies
copy options 63
copy from
copy options 63
copy job
canceling 63
copy options
collate 64
copies 63
copy from 63
copy to 64
darkness 64
overlay 65
paper saver 65
scale 64
separator sheets 65
copy quality
adjusting 60
copy screen
content source 65
content type 64, 88
Copy Settings menu 115
copy to
copy options 64
copy troubleshooting
copier does not respond 220
partial document or photo
copies 222
poor copy quality 221
poor scanned image quality 232
scanner unit does not
close 221, 231
copying
adding an overlay message 62
adjusting quality 60
canceling a copy job from the
printer control panel 63
collating copies 61
enlarging 59
making a copy lighter or darker 59
multiple pages on one sheet 62
on letterhead 57
on transparencies 56
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photos 56
placing separator sheets between
copies 61
quick copy 55
reducing 59
selecting a tray 58
to a different size 58
using the ADF 55
using the scanner glass 56
creating a fax destination shortcut
using the Embedded Web
Server 84
creating an FTP shortcut
using the Embedded Web
Server 89
custom paper type
assigning 39
custom paper type name
creating 39
Custom Scan Sizes menu 101
Custom Type [x]
assigning a paper type 39
Custom Type [x] name
creating 39
Custom Types menu 100
customer support
contacting 234

D
darkness
copy options 64
fax options 88
date and time, fax
setting 82
daylight savings time, faxing 82
Default Source menu 93
Defective flash detected [51] 179
Digital Subscriber Line (DSL)
fax setup 74
digital telephone service
fax setup 76
display troubleshooting
printer display is blank 193
display, printer control panel
adjusting brightness 147
distinctive ring service
connecting to 81
documents, printing
from Macintosh 50
from Windows 50
DSL filter 74

E
Eco‑Mode
using 145
Embedded Web Server
accessing the remote control
panel 162
adjusting brightness 147
administrator settings 162
checking the status of parts 153
checking the status of
supplies 153
creating a fax destination
shortcut 84
creating an FTP shortcut 89
creating e‑mail shortcuts 67
initial fax setup 69
modifying confidential print
settings 52
networking settings 162
problem accessing 233
setting up e‑mail alerts 162
Embedded Web Server — Security:
Administrator's Guide
where to find 162
Embedded Web Server — Security:
Administrator’s Guide
where to find 150
emission
notices 238, 242, 243, 247, 249
enlarging a copy 59
envelopes
loading, multipurpose feeder 34
tips on using 41
environmental settings
conserving supplies 144
Eco‑Mode 145
Hibernate mode 146
printer display brightness,
adjusting 147
Quiet mode 145
Schedule Power Modes 147
Sleep mode 146
erasing non‑volatile memory 149
erasing volatile memory 149
Error reading USB drive. Remove
USB. 179
Error reading USB hub. Remove
hub. 179
Ethernet network
preparing to set up for Ethernet
printing 24

Index

Ethernet port 22
Ethernet setup
preparing for an 24
EXT ports 22
exterior of the printer
cleaning 151
e‑mail
canceling 67
e‑mail alerts
low supply levels 162
paper jam 162
setting up 162
e‑mail function
setting up 66
E‑mail Settings menu 126
e‑mail shortcuts, creating
using the Embedded Web
Server 67
e‑mail, sending
using a shortcut number 67
e‑mailing
configuring e‑mail settings 66
creating shortcuts using the
Embedded Web Server 67
setting up e‑mail function 66
using a shortcut number 67

F
factory defaults, restoring 164
fax
options 87
fax button
printer control panel 12
fax connection
connecting to a distinctive ring
service 81
fax function
setting up 223
fax function is not set up 223
fax log
viewing 85
Fax memory full 179
Fax Mode (Analog Fax Setup)
menu 119
fax options
binding 88
darkness 88
orientation 88
resolution 87
Fax partition inoperative. Contact
system administrator. 179
fax ports 22
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fax screen
content source 88
Fax server 'To Format' not set up.
Contact system administrator. 179
fax setup
country‑ or region‑specific 77
digital telephone service 76
DSL connection 74
standard telephone line
connection 70
VoIP 75
Fax Station Name not set up.
Contact system administrator. 179
Fax Station Number not set up.
Contact system administrator. 180
fax troubleshooting
caller ID is not shown 224
can receive but not send
faxes 228
can send but not receive
faxes 227
cannot send or receive a fax 225
received fax has poor print
quality 229
fax, sending
using shortcuts 83
using the printer control panel 82
faxing
blocking junk faxes 86
canceling a fax job 86
changing resolution 85
configuring the printer to observe
daylight saving time 82
creating shortcuts using the
Embedded Web Server 84
fax setup 69
forwarding faxes 87
holding faxes 86
making a fax lighter or darker 85
sending a fax at a scheduled
time 84
setting the date and time 82
setting the fax number or station
number 81
setting the outgoing fax name or
station name 81
viewing a fax log 85
FCC notices 238, 243, 247
finding more information about the
printer 8
Finishing menu 133

font sample list
printing 53
forwarding faxes 87
FTP address, scanning to
using a shortcut 90
FTP Settings menu 129

G
General Settings menu 111
green settings
Eco‑Mode 145
Hibernate mode 146
Quiet mode 145
Schedule Power Modes 147

H
hardware options, adding
print driver 23
held jobs 51
printing from a Macintosh
computer 52
printing from Windows 52
Help menu 143
Hibernate mode
using 146
holding faxes 86
home button
printer control panel 12
HTML menu 141

I
Image menu 142
imaging unit
ordering 155
replacing 158
Imaging unit low [84.xy] 180
Imaging unit nearly low [84.xy] 180
Imaging unit very low, [x] estimated
pages remain [84.xy] 180
Incorrect paper size, open [paper
source] [34] 180
indicator light
printer control panel 12
initial fax setup 69
using the Embedded Web
Server 69
installing an optional card 17
installing options
order of installation 18
installing printer 23
installing the 250‑sheet tray 19

Index

installing the 550‑sheet tray 19
Insufficient memory for Flash
Memory Defragment operation
[37] 181
Insufficient memory to collate job
[37] 181
Insufficient memory to support
Resource Save feature [35] 181
Insufficient memory, some Held
Jobs were deleted [37] 181
Insufficient memory, some held
jobs will not be restored [37] 181
IPv6 menu 106

J
jams
accessing 166
avoiding 165
understanding messages 166
jams, clearing
in automatic document feeder top
cover 176
in duplex area 172
in front door 167
in manual feeder 174
in rear door 170
in standard bin 171
in tray [x] 173

K
keypad
printer control panel 12

L
labels, paper
tips on using 42
letterhead
copying on 57
loading, multipurpose feeder 34
tips on using 41
line filter 74
LINE ports 22
linking trays 38
Load [paper source] with [custom
string] [paper orientation] 182
Load [paper source] with [custom
type name] [paper orientation] 183
Load [paper source] with [paper
size] [paper orientation] 183
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Load [paper source] with [paper
type] [paper size] [paper
orientation] 183
Load manual feeder with [custom
string] [paper orientation] 181
Load manual feeder with [custom
type name] [paper orientation] 182
Load manual feeder with [paper
size] [paper orientation] 182
Load manual feeder with [paper
type] [paper size] [paper
orientation] 182
loading
multipurpose feeder 34
trays 29
loading the optional tray 29
loading the standard tray 29

M
maintenance kit
ordering 155
Maintenance kit low [80.xy] 183
Maintenance kit nearly low
[80.xy] 184
Maintenance kit very low, [x]
estimated pages remain
[80.xy] 184
memory
types installed on printer 149
Memory full [38] 184
Memory full, cannot print
faxes 184
Memory full, cannot send
faxes 184
menu settings page
printing 27
menus
Active NIC 103
AppleTalk 108
Configure MP 96
Copy Settings 115
Custom Scan Sizes 101
Custom Types 100
Default Source 93
E‑mail Settings 126
Fax Mode (Analog Fax Setup) 119
Finishing 133
FTP Settings 129
General Settings 111
Help 143
HTML 141
Image 142

IPv6 106
list of 92
Network [x] 103
Network Card 105
Network Reports 104
Paper Loading 99
Paper Size/Type 93
Paper Texture 96
Paper Weight 98
PCL Emul 137
PDF 137
PostScript 137
PPDS 140
Quality 135
Reports 102
Security Audit Log 109
Set Date and Time 110
Setup 133
SMTP Setup menu 108
Standard Network 103
Substitute Size 96
TCP/IP 105
Universal Setup 101
Utilities 136
Wireless 107
XPS 137
menus list 92
mobile device
printing from 51
moving the printer 9, 160, 161
multiple pages on one sheet 62
multipurpose feeder
loading 34

N
Network [x] menu 103
Network [x] software error
[54] 184
Network Card menu 105
Network Reports menu 104
network settings
Embedded Web Server 162
network setup page
printing 28
Networking Guide
where to find 162
No analog phone line connected to
modem, fax is disabled. 185
noise emission levels 238
noise, printer
reducing 145

Index

Non‑Lexmark [supply type], see
User’s Guide [33.xy] 185
non‑volatile memory 149
erasing 149
Not enough free space in flash
memory for resources [52] 185
notices 237, 238, 239, 240, 241,
242, 243, 244, 245, 246, 247, 248,
249
number of remaining pages
estimate 153

O
optional card
installing 17
optional tray
loading 29
options
250‑sheet tray, installing 19
550‑sheet tray, installing 19
fax 87
memory cards 15
ordering
imaging unit 155
maintenance kit 155
ordering supplies
toner cartridges 154
orientation
fax options 88
overlay
copy options 65
overlay message, adding
copying 62

P
paper
characteristics 43
letterhead 44
loading, multipurpose feeder 34
preprinted forms 44
recycled 45
selecting 44
setting size 29
setting type 29
storing 46
unacceptable 45
Universal size setting 29
using recycled 144
paper feed troubleshooting
message remains after jam is
cleared 196
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paper jams
avoiding 165
paper jams, clearing
in automatic document feeder top
cover 176
in duplex area 172
in front door 167
in manual feeder 174
in rear door 170
in standard bin 171
in tray [x] 173
paper labels
loading, multipurpose feeder 34
Paper Loading menu 99
paper messages
[x]‑page jam, remove tray 1 to
clear duplex. [23y.xx] 172
paper saver
copy options 65
Paper Size/Type menu 93
paper sizes
supported 47
Paper Texture menu 96
paper types
supported by printer 49
where to load 49
Paper Weight menu 98
paper weights
supported by printer 49
parts
checking status 153
checking, using the Embedded
Web Server 153
using genuine Lexmark 154
parts and supplies, status of
checking, on printer control
panel 153
PCL Emul menu 137
PDF menu 137
Personal Identification Number
method
using 26
phone splitter 75
photos
copying 56
placing separator sheets between
copies 61
PostScript menu 137
PPDS menu 140
preparing to set up the printer on
an Ethernet network 24

print driver
hardware options, adding 23
print irregularities 207
print job
canceling from the printer control
panel 53
canceling, from computer 53
print quality
cleaning the scanner glass 152
print quality troubleshooting
blank pages 211
characters have jagged edges 202
clipped pages or images 202
compressed images appear on
prints 203
gray background on prints 204
horizontal voids appear on
prints 205
print irregularities 207
print is too dark 209
print is too light 210
printer is printing solid black
pages 212
repeating print defects appear on
prints 213
shadow images appear on
prints 214
skewed print 214
streaked horizontal lines appear
on prints 215
streaked vertical lines 216
toner fog or background
shading 217
toner rubs off 218
toner specks appear on prints 218
transparency print quality is
poor 218
uneven print density 219
white streaks 219
print troubleshooting
incorrect characters print 196
incorrect margins on prints 206
jammed pages are not
reprinted 195
job prints from wrong tray 196
job prints on wrong paper 196
jobs do not print 198
Large jobs do not collate 197
multiple‑language PDF files do not
print 198
paper curl 207
paper frequently jams 195

Index

print job takes longer than
expected 199
tray linking does not work 201
unexpected page breaks
occur 201
printer 23
basic model 10
fully configured 10
minimum clearances 9
moving 9, 160, 161
selecting a location 9
shipping 161
printer configurations 10
printer control panel
adjusting brightness 147
factory defaults, restoring 164
using 12
Printer had to restart. Last job may
be incomplete. 185
printer information
where to find 8
printer is printing blank pages 211
printer messages
[x]‑page jam, clear manual feeder.
[25y.xx] 174
[x]‑page jam, clear standard bin.
[20y.xx] 171
[x]‑page jam, open automatic
feeder top cover. [28y.xx] 176
[x]‑page jam, open front door.
[20y.xx] 167
[x]‑page jam, open rear door.
[20y.xx] 170
[x]‑page jam, open tray [x].
[24y.xx] 173
Cartridge low [88.xy] 177
Cartridge nearly low [88.xy] 177
Cartridge very low, [x] estimated
pages remain [88.xy] 177
Change [paper source] to [custom
string] load [paper
orientation] 177
Change [paper source] to [custom
type name] load
[orientation] 177
Change [paper source] to [paper
size] load [orientation] 178
Change [paper source] to [paper
type] [paper size] load
[orientation] 178
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Close flatbed cover and load
originals if restarting job
[2yy.xx] 178
Close front door 178
Complex page, some data may not
have printed [39] 178
Defective flash detected [51] 179
Error reading USB drive. Remove
USB. 179
Error reading USB hub. Remove
hub. 179
Fax memory full 179
Fax partition inoperative. Contact
system administrator. 179
Fax server 'To Format' not set up.
Contact system
administrator. 179
Fax Station Name not set up.
Contact system
administrator. 179
Fax Station Number not set up.
Contact system
administrator. 180
Imaging unit low [84.xy] 180
Imaging unit nearly low
[84.xy] 180
Imaging unit very low, [x]
estimated pages remain
[84.xy] 180
Incorrect paper size, open [paper
source] [34] 180
Insufficient memory for Flash
Memory Defragment operation
[37] 181
Insufficient memory to collate job
[37] 181
Insufficient memory to support
Resource Save feature [35] 181
Insufficient memory, some Held
Jobs were deleted [37] 181
Insufficient memory, some held
jobs will not be restored
[37] 181
Load [paper source] with [custom
string] [paper orientation] 182
Load [paper source] with [custom
type name] [paper
orientation] 183
Load [paper source] with [paper
size] [paper orientation] 183

Load [paper source] with [paper
type] [paper size] [paper
orientation] 183
Load manual feeder with [custom
string] [paper orientation] 181
Load manual feeder with [custom
type name] [paper
orientation] 182
Load manual feeder with [paper
size] [paper orientation] 182
Load manual feeder with [paper
type] [paper size] [paper
orientation] 182
Maintenance kit low [80.xy] 183
Maintenance kit nearly low
[80.xy] 184
Maintenance kit very low, [x]
estimated pages remain
[80.xy] 184
Memory full [38] 184
Memory full, cannot print
faxes 184
Memory full, cannot send
faxes 184
Network [x] software error
[54] 184
No analog phone line connected
to modem, fax is disabled. 185
Non‑Lexmark [supply type], see
User’s Guide [33.xy] 185
Not enough free space in flash
memory for resources [52] 185
Printer had to restart. Last job
may be incomplete. 185
Reinstall missing or unresponsive
cartridge [31.xy] 186
Reinstall missing or unresponsive
imaging unit [31.xy] 186
Remove paper from standard
output bin 186
Replace all originals if restarting
job. 186
Replace cartridge, 0 estimated
pages remain [88.xy] 186
Replace cartridge, printer region
mismatch [42.xy] 187
Replace defective imaging unit
[31.xy] 187
Replace imaging unit, 0 estimated
pages remain [84.xy] 187
Replace jammed originals if
restarting job. 188
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Replace maintenance kit, 0
estimated pages remain
[80.xy] 188
Replace unsupported cartridge
[32.xy] 188
Replace unsupported imaging unit
[32.xy] 188
Scanner automatic feeder cover
open 188
Scanner disabled by admin
[840.01] 188
Scanner disabled. Contact system
administrator if problem persists.
[840.02] 189
Scanner jam, remove all originals
from the scanner [2yy.xx] 189
Scanner jam, remove jammed
originals from the scanner
[2yy.xx] 189
Serial option [x] error [54] 189
SMTP server not set up. Contact
system administrator. 189, 191
Standard network software error
[54] 189
Standard USB port disabled
[56] 190
Supply needed to complete
job 190
Too many flash options installed
[58] 190
Too many trays attached [58] 190
Unformatted flash detected
[53] 190
Unsupported USB hub, please
remove 179
printer options troubleshooting
internal option is not
detected 193
tray problems 194
printer problems, solving basic 191
printer security
information on 150
printing
font sample list 53
from a mobile device 51
from Macintosh 50
from Windows 50
menu settings page 27
network setup page 28
printing a document 50
printing a network setup page 28
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printing confidential and other held
jobs
from a Macintosh computer 52
from Windows 52
printing from a mobile device 51
printing slows down 200
publications
where to find 8
Push Button Configuration method
using 26

Q
Quality menu 135
Quiet mode 145

R
recycled paper
using 45, 144
recycling
Lexmark packaging 148
Lexmark products 148
toner cartridges 148
reducing a copy 59
reducing noise 145
Reinstall missing or unresponsive
cartridge [31.xy] 186
Reinstall missing or unresponsive
imaging unit [31.xy] 186
remote control panel
using Embedded Web Server 162
Remove paper from standard
output bin 186
repeat print jobs 51
printing from a Macintosh
computer 52
printing from Windows 52
repeating print defects appear on
prints 213
Replace all originals if restarting
job. 186
Replace cartridge, 0 estimated
pages remain [88.xy] 186
Replace cartridge, printer region
mismatch [42.xy] 187
Replace defective imaging unit
[31.xy] 187
Replace imaging unit, 0 estimated
pages remain [84.xy] 187
Replace jammed originals if
restarting job. 188

Replace maintenance kit, 0
estimated pages remain
[80.xy] 188
Replace unsupported cartridge
[32.xy] 188
Replace unsupported imaging unit
[32.xy] 188
replacing
imaging unit 158
toner cartridge 156
reports
viewing 163
Reports menu 102
reserve print jobs 51
printing from a Macintosh
computer 52
printing from Windows 52
reset button
printer control panel 12
resolution
fax options 87
resolution, fax
changing 85
RJ‑11 adapter 77

S
safety information 6, 7
scale
copy options 64
scan troubleshooting
partial document or photo
scans 233
scan job was not successful 231
scanner unit does not
close 221, 231
scanning takes too long or freezes
the computer 231
scanner
Automatic document feeder
(ADF) 12
functions 11
scanner glass 12
Scanner automatic feeder cover
open 188
Scanner disabled by admin
[840.01] 188
Scanner disabled. Contact system
administrator if problem persists.
[840.02] 189
scanner glass
cleaning 152
copying using 56
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Scanner jam, remove all originals
from the scanner [2yy.xx] 189
Scanner jam, remove jammed
originals from the scanner
[2yy.xx] 189
scanning
quick copy 55
to a computer 90
scanning to a computer 90
scanning to an FTP address
creating shortcuts using the
computer 89
using a shortcut 90
Schedule Power Modes
using 147
security
modifying confidential print
settings 52
Security Audit Log menu 109
security slot 22
security Web page
where to find 150
select button
printer control panel 12
selecting a location for the
printer 9
selecting paper 44
sending a fax using the
computer 83
sending fax
using shortcuts 83
using the printer control panel 82
sending fax at a scheduled time 84
separator pad
ordering 155
separator sheets
copy options 65
Serial option [x] error [54] 189
Set Date and Time menu 110
setting
paper size 29
paper type 29
TCP/IP address 105
setting the fax number or station
number 81
setting the outgoing fax name or
station name 81
setting the Universal paper size 29
setting up e‑mail alerts 162
setting up fax
country‑ or region‑specific 77
digital telephone service 76
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DSL connection 74
standard telephone line
connection 70
VoIP connection 75
setting up fax function 223
Setup menu 133
shipping the printer 161
shortcuts, creating
e‑mail 67
fax destination 84
FTP destination 89
sleep button
printer control panel 12
Sleep mode
adjusting 146
SMTP server not set up. Contact
system administrator. 189, 191
SMTP Setup menu 108
Standard Network menu 103
Standard network software error
[54] 189
standard tray
loading 29
Standard USB port disabled
[56] 190
start button
printer control panel 12
statement of volatility 149
status of parts and supplies
checking 153
stop or cancel button
printer control panel 12
storing
paper 46
supplies 155
storing print jobs 51
streaked horizontal lines appear on
prints 215
streaked vertical lines appear on
prints 216
streaks appear 219
Substitute Size menu 96
supplies
checking status 153
checking, using the Embedded
Web Server 153
conserving 144
storing 155
using genuine Lexmark 154
using recycled paper 144
supplies, ordering
imaging unit 155

maintenance kit 155
separator pad 155
toner cartridges 154
Supply needed to complete job 190
supply notifications
configuring 163
supported paper sizes 47

T
TCP/IP menu 105
telecommunication
notices 243, 244, 245, 246
the scanner does not respond 230
tips
card stock 43
letterhead 41
on using envelopes 41
on using labels 42
transparencies 41
tips on using envelopes 41
toner cartridge
replacing 156
toner cartridges
ordering 154
recycling 148
toner darkness
adjusting 50
Too many flash options installed
[58] 190
Too many trays attached [58] 190
transparencies
copying on 56
loading, multipurpose feeder 34
tips 41
trays
linking 38
loading 29
unlinking 38
troubleshooting
cannot open Embedded Web
Server 233
checking an unresponsive
printer 191
contacting customer support 234
fax function is not set up 223
solving basic printer
problems 191
the scanner does not respond 230
troubleshooting, copy
copier does not respond 220
partial document or photo
copies 222

Index

poor copy quality 221
poor scanned image quality 232
scanner unit does not
close 221, 231
troubleshooting, display
printer display is blank 193
troubleshooting, fax
caller ID is not shown 224
can receive but not send
faxes 228
can send but not receive
faxes 227
cannot send or receive a fax 225
received fax has poor print
quality 229
troubleshooting, paper feed
message remains after jam is
cleared 196
troubleshooting, print
incorrect characters print 196
incorrect margins on prints 206
jammed pages are not
reprinted 195
job prints from wrong tray 196
job prints on wrong paper 196
jobs do not print 198
Large jobs do not collate 197
multiple‑language PDF files do not
print 198
paper curl 207
paper frequently jams 195
print job takes longer than
expected 199
tray linking does not work 201
unexpected page breaks
occur 201
troubleshooting, print quality
blank pages 211
characters have jagged edges 202
clipped pages or images 202
compressed images appear on
prints 203
gray background on prints 204
horizontal voids appear on
prints 205
print irregularities 207
print is too dark 209
print is too light 210
printer is printing solid black
pages 212
repeating print defects appear on
prints 213
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shadow images appear on
prints 214
skewed print 214
streaked horizontal lines appear
on prints 215
streaked vertical lines 216
toner fog or background
shading 217
toner rubs off 218
toner specks appear on prints 218
transparency print quality is
poor 218
uneven print density 219
white streaks on a page 219
troubleshooting, printer options
internal option is not
detected 193
tray problems 194
troubleshooting, printing
printing slows down 200
troubleshooting, scan
partial document or photo
scans 233
scan job was not successful 231
scanner unit does not
close 221, 231
scanning takes too long or freezes
the computer 231

U
uneven print density 219
Unformatted flash detected
[53] 190
Universal paper size
setting 29
Universal Setup menu 101
unlinking trays 38
Unsupported USB hub, please
remove 179
USB port 22
using Hibernate mode 146
using recycled paper 144
using Schedule Power Modes 147
using shortcuts
sending fax 83
Utilities menu 136

V
verify print jobs 51
printing from a Macintosh
computer 52

printing from Windows 52
vertical voids appear 219
viewing
reports 163
viewing a fax log 85
voice mail
setting up 70
Voice over Internet Protocol (VoIP)
fax setup 75
voids appear 219
VoIP adapter 75
volatile memory 149
erasing 149
volatility
statement of 149

W
Wireless menu 107
wireless network
configuration information 24
wireless network setup
using the Embedded Web
Server 27
wireless setup wizard
using 25

X
XPS menu 137

